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1
Introduction to R2V and A 30Minute Tutorial
R2V basic concepts, data structure and data types, layer definitions, user interface and simple
steps to get started.

1.0 Installation Guide
If the PC has multiple-user set up, please logon as the user who will use R2V on this PC.
R2V license works only with the user profile who has validated the license.
If you have a software installation CD, please insert the CD to start the installation
process.
You can also download the installation file from this link (skip this step if you already
have the trial version installed):
http://www.ablesw.com/r2v/r2vsetup.exe
Run “r2vsetup.exe” and follow the on screen instructions to install.
The first time you run R2V, a License Validation dialog box will appear. Please use the
“Validate License” button to email the “user.key” file (located in the R2V program
folder) to license@ablesw.com to receive a “license.key” file. Save the “license.key” to
your R2V program folder to complete the license validation process. You can also access
the “License Validation” dialog box using the “Help/License/Validate License”
command.
Please note, without a validated license, R2V will run in demo mode and the file
exporting functions will be limited to the demo images or images smaller than 256 by
256 in pixels.

Installation Guide for R2V License Using a Hardware Key
The following steps are required to install the USB hardware key (Label: RQMOQ)
and its device driver to enable the software.
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NOTE: If you are using Windows NT, 2000, or XP, you need to login to the system as a
system administrator or with all the ADMINISTRATOR permissions to install device
drivers before you start the following steps.
The license key driver is normally installed automatically. If not, please install it using
the following steps:
1. You can use Start/Programs/R2V/Install Hardware Key Driver to install the
driver automatically. Or you can run “hdd32.exe” from R2V program folder
directly.
2. Plug the hardware key to the USB port on your PC.

1.1 Minimum System Requirements
 Operating Systems: Windows 2000, XP, Vista or later
 RAM: Minimum 128 MB (512 MB or more is highly recommended if large
size images are processed)

 HARD DISK: 30 MB for the software and extra space to store your scanned
images.

 DISPLAY: 16-bit color SVGA or better.
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1.2 About R2V
R2V for Windows is an advanced raster to vector conversion software system. The
system combines the power of intelligent automatic digitizing technology with an easyto-use, menu-driven graphical user interface in the Microsoft Windows environment. The
software provides fully automatic raster to vector conversion to handle several types of
images, as well as a powerful and flexible vector editor using the scanned image as a
backdrop. Because of its flexibility and high accuracy, the software is well suited for
applications in Geographic Information Systems (GIS), Mapping, Computer Automated
Design (CAD), and scientific computing.
R2V provides an easy and complete solution to digitize vector data from image sources,
such as scanned maps and drawings, aerial photos, and satellite imagery. The entire raster
to vector conversion process is fully automatic and needs no human intervention. You
display the scanned image on the screen and you select the vectorization command. That
is all it takes! All the lines are extracted in seconds and displayed right on top of the
image for you to verify and edit. Powerful editing and processing functions are provided
to edit, geo-reference, and label your data. R2V has all the tools to get a perfect set of
vector data faster and easier than any other method.
With R2V, you can forget about slow and inaccurate hand tracing on a digitizing tablet,
simply scan your map or drawing and let R2V vectorize it automatically, at a high
accuracy level. A typical contour or parcel map scanned at 200 dpi (dots/inch) as a black
and white or grayscale image can be vectorized in seconds or minutes on a Pentium PC.
We know editing for both raster images and vector data is extremely important to you, so
we have made every effort to build easy to use and intelligent editors to handle all data
types in one display window. Data types include lines, points, polygons, text labels,
image pixels, and control points. With R2V, you can automatically vectorize maps or
drawings, perform quick heads-up digitizing, georeference aerial photos or satellite
imagery, and update your existing vector data sets using the latest aerial photos or other
images.
R2V for Windows is very easy to use. The basic conversion and editing functions can be
learned quickly for users of any level of technical background. After the installation,
please follow the steps in Section 1.6 Learn R2V for Windows in 30 Minutes to see how
easy a scanned image can be converted to vectors using R2V for Windows software.
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1.3 Technical Support
Able Software provides unlimited technical support to users of its products within one
year of purchase at no additional charge. For information on extended technical support
and upgrades, please contact Able Software's sales department.
For technical support or to submit comments and suggestions, please contact us by email
(support@ablesw.com), Fax (781-862-2640), Phone (781-862-2804), or by regular mail:
Customer Support Dept.
Able Software Corp.
5 Appletree Lane
Lexington, MA 02420-2406
USA
On Able Software’s Website (http://www.ablesw.com), we have pages dedicated to
technical support and upgrade information. Please visit our site to get the latest
information on new releases and availability of new upgrades.
You can also contact the distributor from whom you purchased the software for both
technical and non-technical information.

1.4 Upgrades
The latest R2V upgrades and new updates are available by download from our website:
http://www.ablesw.com/r2v.
We have set up a technical support mailing list for R2V users. We regularly post news,
release notes, new upgrades, and bug fixes to this mailing list. Join the list in order to get
the latest information about the availability of new upgrades and new features added to
the latest release.
To register for the mailing list, please send an email to r2v@ablesw.com with your
contact information. Please note the information you provided to us is for product support
purposes only and will not be used by any others.

14

I N T R O D U C T I O N

A N D

T U T O R I A L

1.5 User Interface
R2V for Windows software is written in the Microsoft Windows environment. It has a
graphical user interface that includes icons, a menu bar, tool buttons, floating popup
menus, and interactive on-line help. The menu options can be selected with either a
mouse or with keyboard shortcuts. Please refer to Windows documentation about using
Windows tools, dialog boxes, menus, icons, etc.

1.5.1 Image Windows
Scanned images and generated vector data are displayed in IMAGE WINDOWS. During
operation, only the currently active window is under the control of the menus. Several
IMAGE WINDOWS can be open at one
time but only one can be active at one time.
The active window has a darkened title bar.
To make a window active click anywhere on
it with the left mouse button.
When the IMAGE WINDOW is in the
zooming mode (scroll bars will be
displayed), the ARROW KEYS, PAGE UP and
PAGE DOWN, HOME, and END keys can be
used to scroll the image.

1.5.2 Menu Bar
The menu bar contains all the command options supported by R2V for Windows.
Most of the options provided by the Line Editor,
Point Editor, and Control Point Editor can also be
invoked from the floating pop-up menus brought
up by using the right mouse button. See the
following section for details.
You can display menu options by clicking on the
menu heading with the mouse, or by holding
down the ALT key and typing the underlined letter
of the menu heading. You can also select a menu
option with the function keys, called HOT KEYS,
for example, F1 to get on-line help, F2 to zoom in, F3 to zoom out and F6 to go back to
the previous view.
Some menu options initiate commands directly while others include a submenu of
commands. Submenu commands are also available as floating pop-up menus brought up
by clicking the right mouse button. Other menu options open a dialog box to initiate
15
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commands. An ellipsis mark (...) next to a menu heading indicates a dialog box for that
option.

1.5.3 The Floating Pop-up Menu
In the R2V for Windows system, all the editing
tools use a pop-up menu to initiate commands or
to change the editing mode. To select an option
from the pop-up menu, first use the right mouse
button to bring up the pop-up menu and then use
the left mouse button to select an option.

1.5.4 The Mouse
A two-button mouse lets you position the cursor
and select items on the screen. Click the left
mouse button to select menu options and screen
objects.
Click the right mouse button to display a pop-up
menu of available submenu options during an
editing session.
You can also use the mouse to draw a selection
rectangle, which is a rubber-band box that defines an area on the screen.

1.5.5 Draw A Selection Rectangle and Measure Distance
In R2V for Windows, there are many places you need to draw a selection rectangle to
indicate the image region of interest. The rectangle is used by the zoom commands and
some editing functions.
To get a selection rectangle in the selection mode (Arrow Cursor), hold the left mouse
button to drag a selection rectangle in the IMAGE WINDOW.
When the cursor is not an Arrow Cursor, the selection is not directly available because it
is currently in an editing session, such as the Line Editor or the Control Point Editor. To
get a selection rectangle during an editing session, you need to hold the SHIFT key down
and hold the left mouse button at the same time to drag a selection rectangle in the
IMAGE WINDOW. The current editing session will not be interrupted.
To measure length or distance, hold down the CONTROL key and press the left mouse
button and drag to draw a line. The length of the line is displayed in real time in the
Status Bar at the bottom of the IMAGE WINDOW.
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1.5.6 Mouse Pointer Tools
Arrow Cursor
The Arrow Cursor allows you to select items and draw a selection rectangle on
the screen. The Arrow Cursor is the default mouse pointer for R2V for Windows.
Cross Cursor
The editing tools, such as the Line Editor and the Control Point Editor, use the
Cross Cursor. The Cross Cursor normally indicates the session of adding or
modifying.
Move Cursor
The Move Cursor is used by the editing tools, such as the Line Editor and the
Control Point Editor. When the Move Cursor appears, it normally indicates that
you can drag an editing object and move it. To drag an object, hold down the left
mouse button, move the object to the desired location, and release the mouse
button to confirm.

Delete Cursor
The Delete Cursor is used by the editing tools, such as the Line Editor and the
Control Point Editor. When the Delete Cursor appears, it normally indicates that
you can delete an editing object by pointing at the object and clicking the left
mouse button.
ID Cursor
The ID Cursor is used by the Line Editor
to assign or label generated lines. When
the ID Cursor appears, it indicates that you
can now assign or modify an ID number to
an existing line. Simply select the line
using the left mouse button and enter the
value in the Current ID Value dialog box
(See Figure).

17

I N T R O D U C T I O N

A N D

T U T O R I A L

1.5.7 The Keyboard
Use the keyboard to enter alphanumeric data and initiate menu options. When in the
zoom mode, use the ARROW keys, PAGE UP, and PAGE DOWN keys to scroll in the IMAGE
WINDOW.
R2V uses shortcut keys for quick access to some of the frequently used functions.
The following is a list of hot keys:















F1: Help function
F2, +: Zoom in. This can be used with a selection rectangle drawn using the left
mouse button or move the cursor to a specific area to zoom.
F3, -: Zoom out.
F4: Opens the Image Contrast dialog box for grayscale images.
F5: Shows the image in full view, or fits the entire image in the window.
F6: Goes back to the previous view.
CONTROL + Left Mouse Button: Gets the distance measurement to show in the Status
Bar at the bottom of the IMAGE WINDOW.
SHIFT + Left Mouse Button: Draws a selection rectangle under any editing mode.
SPACEBAR: Finishes a line while using the New Line command.
"T" or "t" under Line Editor/New Line: Toggles the Auto Tracing mode on and off.
"C" or "c" under Line Editor/New Line: Finishes the current line by connecting it to
the starting point to make a closed polygon.
"S" or "s" under Line Editor/New Line: Finishes the current line and connects it to
another line end that is the closest.
CONTROL-Z: Undo the last editing under the Line Editor.
BACKSPACE (←): Undo the last addition under the Line Editor/New Line.

1.5.8 Toolbars
At the top of the IMAGE WINDOW, there are a number of toolbars for those frequently
used R2V functions, such as viewing controls, editing tools, and other functions. Moving
your mouse over to a tool button for a short moment will bring up a short description of
the command.
Edit Bar:
View Bar:
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1.6 Starting to Use R2V in 30 Minutes
1.6.1 Basic Concepts
The principle behind the development of R2V for Windows software is to implement a
system for you to use quickly. The system is very straightforward and intuitive and
anyone should be able to get started within 30 minutes. Of course, the best way to learn
R2V is to use it. We suggest that you follow this section and go through all the steps with
a demo image or your own image. (We assume the software has already been installed on
your hard drive. If you have not done so, you should do it now).
R2V is developed using object-oriented structure that makes the software highly efficient
to process and manipulate both raster and vector data. It is important to have a good
understanding of how different types of data, such as images, vector lines, points, control
points, and text, are handled by the software and how they are generated, displayed, and
saved to files.
Each type of data, such as raster images, lines, points, and text, are treated differently and
each has their own set of processing editing functions. Each data type can be stored in a
separate file with a different file format. For example, images are stored in TIFF (*.tif)
or BMP (*.bmp) format and vector lines are stored in GEN (*.gen) and other vector file
formats. Each data layer is also displayed as a graphical display layer, which can be
toggled “on” and “off” using the functions under the View/Overlay submenu.
In R2V, each vector data type is editable using its own editing functions under the Edit
menu. For example, use the Edit/Line Editor commands to edit lines and polygons, and
use the Edit/Point Editor commands to edit points. Once an editor for a data type is
started, you are in that particular editing mode and are allowed to do certain types of
editing related to the data layer until you exit or switch to another editor. Raster images
can be edited using the Image Pixel Tool under the Image menu or the Image Editor
under the Edit menu.
R2V supports the concept of layers, which is similar to the layer concept used by some
GIS and CAD software packages, such as AutoCAD. The use of layers makes data
creation and editing more flexible, and is a powerful way to get your data organized the
same way as they are in the original map or drawing.
A layer is a container for data items, such as lines, points, and text notes. In R2V, a user
can define as many layers as needed. Each layer has a name and other properties, such as
a color. Layers can be created and modified using the Edit/Layer Define function. A layer
can be turned “on”, “off”, or set as “current”. There must always be one “current” layer
at any time. All layers with an “on” status will be displayed in the IMAGE WINDOW
provided the graphical overlay control is also set as “on” (See Section 4.6 Overlay (View
Menu)). If you do not want some layers to be affected by some global post processing
functions, you should turn these layers “off”. You can always turn them back “on” to
view the data.
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Data can be moved or copied between layers using the Edit/Layer Manipulate function
(See Section 3.2 Layer Manipulate…command (Edit Menu)).
R2V has a default data layer with the name “zero (0)”. If you just need to vectorize some
simple one layer maps, you do not need to worry about layer definition. All data created
will be in the default layer.
If you need to use layers to organize your data, you should define the layers before you
create your vector data. Define the layers using the Edit/Layer Define command or the
tool button
(See Section 3.1 Layer Define…command (Edit Menu)). Set a layer as
“current” before putting data into it.
When doing automatic vectorization or interactive tracing, all vector data generated will
be put into the “current” layer.
When doing editing and vector processing, all layers currently turned “on” will be
available to the functions. For layer sensitive functions, such as line snapping and
polygon creation, R2V will use layer information to make sure lines and polygons are
processed correctly.
When exporting a vector file, all vectors in the “on” layers will be saved in the output
file. If you need to export only one layer, you should turn all the rest of the layers “off”
and leave only one layer “on” for the exporting.
DXF export is an exception because it completely supports layers. When saving to a DXF
file, all layers (“on” and “off”) are exported.
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1.6.2 R2V Tutorial
Follow the steps below to experiment with the software. This will enable you to have a
better understanding of how data layers are handled and how easily you can get your
raster images vectorized.
Step 1. Start the program by double clicking the R2V for Windows Icon.
Step 2. Open an image by selecting the File/Open Image or Project option. Specify the
image file name (*.tif or *.bmp) in the file Open dialog box. The original image is
displayed in the IMAGE WINDOW.
Step 3. Resize the IMAGE WINDOW by moving the mouse to the display window's
border and drag. The image is zoomed to its proper aspect ratio. Now you can Zoom In
(F2 key), Zoom Out (F3 key). The ARROW keys and the PAGE UP and PAGE DOWN keys
can be used to move the zoom window to a different portion of the image.
If the image is a 1-bit black and white image, you can change the display colors using the
View/Set Image Color. If the image is a grayscale image, use the View/Image Contrast
command to change the contrast display.
Image processing functions can be applied now to improve the quality of the
vectorization results. Chapter 5, Image Menu Commands, explains in detail the specific
processing functions under the Image menu. Image smoothing (Image/Smooth) can be
applied to grayscale images, and the despeckle (Image/Despeckle) function can be
applied to monochrome images to remove image noise. To change image orientation,
you can use the Vertical Flip, Horizontal Flip, Rotate (for a specified angle), Transpose
(for 90 degree rotations), and Resize (to change the spatial resolution) options under the
Image menu. If you want to process only a portion of an image, you can use the
Image/Crop Region command to keep only the selected image region and remove the
rest, or use the Image/Region of Interest command. If your image is scanned at a very
high resolution, you can use the Image/Resize command to down sample the image and
make it smaller for faster processing. If image processing functions have been applied to
the image, you may want to save your images to a new file so the changes won’t be lost.
For 1-bit monochrome or grayscale images, you can go to the next step to start the
vectorization process.
If you are working with a color image, you may want to perform a classification first to
clean up the color image before vectorization. For some color images with noise pixels,
you can use the options under the Image/Image Pixel Tool submenu or the Image Editor
under the Edit menu. To remove noise pixels use the Map Pixel Values command to
change pixel values to the correct color. You can clean up unwanted pixels by using the
Draw Pixel Value command to redraw the pixels in the image.
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Step 4. If your image has the same type of lines, for example, a map separate with only
contour lines or a parcel map with only parcel boundaries, then you can vectorize your
image using the Vector/Auto Vectorize command.
If you need to create several layers to organize the vector data, you have to define the
layers to be used. Use the Edit/Layer Define command for this (See Section 3.1 Layer
Define…command (Edit Menu)). After the layers are defined, select one layer as the
“current” layer to store vector data from the automatic vectorization or interactive
tracing processes. When vectors have been generated for one layer, you can select
another layer as the “current” layer to create more vector data for the image. It is
recommended to leave only the layer you are using as the “current/on” layer and set all
other layers “off” so only the data in the “current” layer will be affected by the editing
and processing functions.
If the scanned image is in good quality, you can use the fully automatic vectorization
function by selecting the Vector/Auto Vectorize command. The Vectorize dialog box
appears to allow selections of vectorization parameters (See Figure). Select the “Start”
button to start the vectorization process.
The cursor becomes an hourglass when
processing and returns to an arrow when
vectorization is finished. The extracted lines
will be displayed in the IMAGE WINDOW
as green lines. Use the View/Overlay
options to turn “on” and “off” display items,
such as Line Nodes, Line Ends, and Line
IDs if you intend to assign values to the
lines.
The color of lines can be changed based on
their layer definition using the View/Line
Colors/Use Layer Color option or on their
IDs using the View/Line Colors/Set Line
Color By ID option, if lines are labeled.
If the image is a complex one with many graphic layers or items mixed together, you may
want to use R2V’s interactive tracing functions to vectorize the image selectively. To
start interactive tracing, you need to get into the Line Editor by selecting the Edit/Line
Editor option. Once you are in the Line Editor, stay in the New Line editing mode by
selecting the option from the Line Editor submenu, the toolbar button ( ), or the
floating pop-up menu. Make sure the Auto Trace option is selected. Simply click a
starting point using the left mouse button, and select the next point the same way within a
line for the tracing function to follow. Use the BACKSPACE (←) key to remove the last
point. When the line is completed, press the SPACEBAR or any key to finish. Repeat the
above steps to trace other lines. If you need to trace lines for another layer, simply select
the layer as “current” and then start the tracing process again.
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If you want to trace lines as a group, for example, contour lines, the Multi-Line Trace
option under the Line Editor is for this. Select the Multi-Line Trace mode under the Line
Editor submenu, the toolbar button ( ), or the floating pop-up menu. Draw a line using
the left mouse button across the lines to be traced. The selected lines will be traced
automatically by R2V. Repeat this step for other lines.
Step 5. Edit the detected lines using the Edit/Line Editor submenu options. You can also
use the right mouse button to bring up the pop-up menu of the editing options. Clicking
on the toolbar buttons can also access the Line Editor functions. Within the Line Editor,
you can add new lines (New Line), add nodes (Add Node), move nodes (Move Node),
delete nodes (Delete Node), split lines (Split Line), delete lines (Delete Line), and delete
all lines (Delete All Lines) within a selected region or an entire image. Lines can be
labeled using the Assign ID option after you set the ID value (Set ID Value). Various
vector data post processing and display functions are available under the Vector menu.
Step 6. To convert the generated vector data to a certain projection system, such as UTM,
select control points by using the Vector/Select Control Points command. Select 4 or
more control points and specify the destination coordinates.
NOTE: The control points will not be applied to the vector data until the vector data is
exported to a vector file. The registration is applied only when exporting vector data to a
file.
The raster image can be geo-referenced by creating an Image World File using the
selected control points. Raster images can also be registered or geometrically corrected
based on selected control points using the Image/Warp command.
Step 7. Use the File/Save Project command to save all your data to an R2V project file. If
you have done all the processing and editing, you can save your vector data by selecting
the File/Export Vector command. The generated vector data can be saved to an Arc/Info
generate file (*.gen), an ArcView Shapefile (*.shp), a MapInfo (*.mif) file, a 3D points
file (*.xyz), a DXF (*.dxf) file, an IGES (*.igs) file, and a MapGuide SDL (*.sdl) file.
When exporting to a certain vector file format, you will be prompted with options
(depending on what format you are exporting your data to), including whether you want
to apply the control points to the vector data and what transformation method you want to
use. Select the Apply Control Points box and the transformation method (for example, BiLinear method) and then export your data (See Section 2.13 Export Vector…command
(File Menu)).
Now, you have extracted the vector data from the scanned image and saved the data to a
file that other mapping or GIS software can use. If you are still not confident with the
basic procedure, repeat the above steps and get more information on certain commands
using R2V’s online help or the user manual.
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Chapter

File Menu Commands

2

Open and save all files, including images, vector lines, polygons, points, control points, TFW,
and text notes…
The File menu offers the following commands:
Open Image or Project

Opens an existing image or a project.

Reload Image

Select Scanner

Reload the original image to undo all changes made to
the image.
Creates a new workspace for vector data editing and
merging
Imports raw or non-standard binary images. Often
used to read satellite imagery.
Allows you to select your scanning device

Scan Image

Starts the scanning process to obtain a new image

Save Project...

Saves the current project.

Save Image As

Saves an opened image to a specified file name.

Save World File

Saves an Image World File (TFW) or TAB file using
the selected control points for an image. It is used to
geo-reference the image.
Saves the currently active window

New Workspace
Import Raw Image

Save Window
Send Mail
Close

Opens up an Outlook Express window to send an
email
Closes and open image

Save Layers

Saves defined layers to a layer file.

Load Layers

Loads layers from a layer file.

Import Vector...

Opens an existing line or point file for display or
editing. An existing vector file can be merged to the
currently displayed vector data set using this
command.
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Import Geo-Coded Vector...

Save Control Points…

Opens a geo-coded line or point file for display and
editing. Can be used to update an existing dataset
using a new raster image source.
Saves the currently generated line and/or point data to
a vector file. If control points are selected, registration
can be applied when exporting.
Saves the currently generated vector data to a raster
image file.
Loads a control point file, a World file or a TAB file
for geo-referencing.
Saves selected control points to a file.

Open 3D File

Opens a grid or DEM file for 3D display.

Create 3D Grid File

Creates a 3D grid dataset from the labeled line data
and save to a grid file.
Creates a 3D DEM file from the labeled line data.

Export Vector...

Save Vector As Image...
Load Control Points/TFW…

Create 3D DEM File
Export 3D Model

OCR and Text/Load Text Blocks

Exports the surface of a 3D model to a polygon or
triangle-based DXF file, or a 3D XYZ file.
Drapes the entire image or a selected region to the 3D
dataset currently being displayed in the 3D window.
Loads text blocks from a text block file.

OCR and Text/Save Text Blocks

Saves detected text blocks to a text block file.

OCR and Text/Load OCR File

Loads OCR signatures from an OCR file.

OCR and Text/Save OCR File

Saves trained OCR signatures to an OCR file.

OCR and Text/Load Notes

Loads text note items from a text note file.

OCR and Text/Save Notes

Saves generated text note items to a text note file.

Print

Prints a document.

Print Preview
Print Setup

Displays the document on the screen, as it would
appear printed.
Selects a printer and printer connection.

Print Screen

Prints the entire screen.

Print Window

Prints the current active IMAGE WINDOW.

Exit

Exits R2V for Windows.

Image Drape
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2.1 Open Image or Project…command (File Menu)
Use this command to open an existing image in a new IMAGE WINDOW or to open an
R2V project, which may include all your previously created line data, point data, control
points, and other data. You can open multiple R2V projects at once. Use the Window
menu to switch among the multiple open documents.
The raster image file formats supported are tagged image file format (*.tif), GeoTIFF
(TIFF file with geo-referencing extension), Windows Bitmap (*.bmp), JPEG (*.jpg), GIF
(*.gif), PNG (*.png), RLC (*.rlc), and raw image files (*.hdr). The currently supported
image types include: 1-bit bi-level, 8-bit grayscale, 4-bit palette, 8-bit palette color, and
24-bit true color. 16-bit grayscale images are not supported in the current version.
If an image is saved as a GeoTIFF file with raster image geo-referencing information, the
geo-referencing parameters will be read into R2V and can be used for vector georeferencing. If geo-referencing parameters are available, you can use the View/GeoCoded Coordinates command to toggle on the display of geo-coded coordinates in the
Status Bar. Depending on the geo-referencing scheme used in the GeoTIFF image, R2V
will use either control points when the points exist or TFW when transformation
parameters exist.
Windows BMP files (*.bmp) save most image types (1-bit monochrome, 4-bit grayscale,
8-bit grayscale, 8-bit color) as palette type images. R2V automatically converts 1-bit and
4-bit images to black and white image types. For 8-bit grayscale images that are saved as
palette color image types, you should convert the image type from 8-bit palette color to 8bit grayscale before vectorization is done. This ensures the image will be processed and
vectorized correctly. Use the Image/Information option to check the image type.
The PNG (*.png) format is an open source standard format that uses a loss-less
compression to maintain the original quality of the image.
R2V can import raw uncompressed image files using the File/Import Raw Image
command. A header file (*.hdr) is created for reading a raw image file.
The project file (*.prj) is in a binary format that stores all vector data and parameters
generated in R2V. The raster image itself is not saved in the project file; only the file path
to the image is saved. Once a project is saved, you should keep the image at the same
location so when the project is opened, the image will be found and displayed.
Shortcuts
Keys:

CTRL+O (directly brings up the Open dialog box)

2.1.1 File Open dialog box
The File Open dialog box will appear when certain commands are selected. It allows
you to specify which file to open.
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File Name
Type or select the filename you want to open. This box lists files with the extension
you select in the Files of Type box.
List Files of Type
Select the type of file you want to open:
The currently supported image file formats are TIFF (*.tif), Windows BMP (*.bmp),
JPEG (*.jpg), GIF (*.gif), RLC (*.rlc), PNG (*.png) and other raw image formats
(*.hdr).
Drives
Select the drive in which R2V for Windows stores the file that you want to open.
Directories
Select the directory in which R2V for Windows stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.
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2.2 Reload Image…command (File Menu)
Use this command to reload the original image to undo all the changes made to the
image.
For example, if you have converted your color image to grayscale for vectorization, you
can reload the image using this command after the image is vectorized. You can then
perform the line editing using the original color image as the backdrop.

2.3 New Workspace…command (File Menu)
Use this command to create a new workspace in R2V for vector editing and merging
when no image is available for the dataset. This new document does not contain an
image. Use the File/Import Vector command to open one or more vector files for display
or editing. The New Workspace function can also be used to merge multiple vector files
into one vector file using the File/Import Vector.
When merging vector data sets together, use the View/Resize Workspace option to
change the size of the current workspace.
You can open an existing image or R2V project file with the File/Open Image or Project
command.
Shortcuts
Keys: CTRL+N

2.4 Import Raw Image...command (File Menu)
Use this command to import raw or non-standard format binary images.
R2V supports various image file formats directly, including TIFF, GEOTIFF, BMP,
JPEG, GIF, RLC, and other raw image formats. For other image file formats, such as 8bit raw binary files used to store satellite imagery, R2V can import these images by
creating an image header file for an image data file with its image parameters defined.
Once the header file is created, you can use it to open the image, which is treated the
same way as a directly support file format, like TIFF or BMP.
When the File/Import Raw Image command is selected the Import Image Dialog box
appears (See Figure). All parameters listed in the dialog box must be correctly entered in
order for the software to read the image data. If you do not know the parameters, you
should contact the image vendor about those parameters.
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Enter the following parameters:
Image Data File Name: Use the “Browse” button or
enter directly the file name where the image data is
stored. Enter the file name exactly the way it appears
as it is used by R2V to find the image data.
Number of Columns: This is the number of pixels in
the X or column direction in one image plane or slice.

# Bytes To Skip

# Columns (X)

0 plane

# Rows (Y)

Number of Rows: This is the number of pixels in the
Y or row direction in one image plane or slice.
Number of Image Planes or Slices: This is the number
of image planes or slices in the file.
Number of Bits Per Pixel: This tells the size of each
image pixel. If the number of bits is 8, then each
pixel is one byte in size and can store up to 256 levels.
The currently supported number of bits per pixel is 8.

........

# Planes (Z)

Number of Bytes to Skip Before the Image Data
Array: Some image files have a fixed length header
that stores vendor specific information. The length or
the size of this header must be provided so the
software knows to skip it in order to read the image data correctly. If this value is

29

F I L E

M E N U

C O M M A N D S

unknown, then enter -1 to let the software estimate it automatically using the image size
and file size.
Header File Name: Use this field to enter a header file name to save the configuration
parameters and use it later to read your image. If you want to copy or edit all the
information from an existing header file, use the “Browse” button to open the existing
header file. All parameters will be read in for you to modify.
Click the “OK” button to save all the information to the header file. You are now able to
work with your image data by using the File/Open command and selecting the header file
type (*.hdr).

2.5 Save Project…command (File Menu)
Use this command to save an R2V project file (*.prj), which includes all the data layers
(excluding the image) you have created using R2V’s processing functions. As a backup,
the existing project file is kept with file extension (*.pbk). In case you need to go back to
a previous project, you can change the backup file extension (*.pbk) to the project
extension (*.prj) and then open the file. Project files can be opened using the File/Open
Image or Project command.
Project files are in binary format and are only used internally by R2V. To use data
generated in R2V, such as lines, points, or text notes, you should use the File/Export
Vector command.

2.6 Close…command (File Menu)
Use this command to close all windows containing the active document.
R2V for Windows suggests that you save changes to your document
before you close it. If you close a document without saving, you lose all
changes made since the last time you saved it. You can use the File/Save
Image As command to save the modified image to a new file while the
original image is kept the same.
You can also close a document by using the Close icon on the document's window (See
Figure).
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2.7 Save Image As…command (File Menu)
Use this command to save the current image to a TIFF, GeoTIFF, or JPEG file. R2V
displays the Save As dialog box so you can name your image (See Figure). The JPEG
format supports grayscale and 24-bit RGB image types only and is a compressed format.
Other image types should use the TIFF format.
If control points have been selected (more than 4 required) or a TFW file is read into the
program, R2V will ask you whether to save the TIFF image with or without the GeoTIFF
extension.
The GeoTIFF format is an industry standard designed to handle geo-referencing
information in TIFF format. GeoTIFF image files are the same as a general TIFF file, but
with more fields to save geo-referencing information.
GeoTIFF is currently supported by many other software packages as a way to georeference raster images.

2.8 File Save As dialog box
The File Save As dialog box will appear when certain commands are selected. It allows
you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name. A filename can
contain up to eight characters and an extension of up to three characters. R2V for
Windows adds the .tif extension in the Save As Type box.
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Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.

2.9 Save World File…command (File Menu)
Use this command to create and save an Image World File (TFW) or TAB file. These
files can be used to register an image to a projection system using selected control points.
The Image World File is used to overlay a raster image with geo-referenced vector data
in a GIS package. The TAB file is supported by MapInfo software.
This file can only be created when the control points are selected. Use the Vector/Select
Control Points command to select new control points or use the File/Load Control
Points/TFW command to read control points from a control point file.
The world file format is currently supported by several GIS software packages, including
ESRI's Arc/Info and ArcView. Although world files could have different file extensions
depending on the image file, R2V uses only the *.tfw extension for all world files. You
can change your world file to the *.tfw extension so it can get loaded automatically.
The world file consists of a six parameter affine transformation:
x' = Ax + Cy + E
y' = Bx + Dy + F
Where, x' and y' are calculated coordinates of a pixel in the world coordinate system; A,
B, C, D, E and F are the transformation parameters.
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2.10 Layer (File Menu)
2.10.1 Save Layers…command (Layer submenu)
Use this command to save currently defined layer data to a layer file. The layer data can
be used later when working on a different map or drawing that has the same layer
definition.
Use the Edit/Layer Define command to define, update, and set the status of layers.
Use the Edit/Layer Manipulate command to copy or move vector data between layers.

2.10.2 Load Layers...command (Layer submenu)
Use this command to load layer data from a layer file. Maps or drawings with the same
layer definitions can share the same layer data stored in a layer file.
Use the Edit/Layer Define command to define, update, and set the status of layers.
Use the Edit/Layer Manipulate command to copy or move vector data between layers.

2.11 Vector Commands
2.11.1 Import Vector...command (File Menu)
Use this command to open an existing vector file and display it in an IMAGE WINDOW.
When the file Open dialog box appears, use the File of Type area to specify whether you
want to import a Line File (*.gen, *.arc), an ArcView Shape file (*.shp), an AutoCAD
DXF file (*.dxf), an IGES File (*.igs), a MapInfo exchange file (*.mif, *.mid), or a Point
File (*.pnt, *.xyz). For a vector file that stores only one data layer (*.gen, *.shp, *.mif),
the vector data is read into the “current” layer. For vector files that have multiple layers
(*.dxf), the layer information is maintained and all vector data items are kept in their
separate layers in R2V.
MapGuide SDL files (*.sdl) can be imported for editing, however, the attribute data are
saved to an attribute file with the same file name but with an *.sda extension. See Section
3.16 Attribute File (SDL)…command (Edit Menu) for information on the format of an
SDL/SDA file. The vector data items (lines, polygons, points) are associated with the
attribute data by their ID values. When exporting vector data to an SDL file, the attributes
in an SDA (attribute) file can be merged into the SDL file. Vector data with the same ID
value will be linked to a name and a URL with the same ID.
The IMAGE WINDOW can have an image or just an empty window created using the
File/New Workspace command for vector manipulation. If there exists vector data in the
“current” window, you will be asked whether you want to delete the current data set. If
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your answer is “Yes”, only the vectors imported from the file are kept for future
processing. If your answer is “No”, the imported vectors will be appended to the current
data. The two data sets are merged into one dataset.
By using this command repeatedly, you can merge any number of vector files into one
set. This is often used when the original map or drawing is too large to scan into one
image. You can split images into portions by performing several scans, process the
portions using R2V to get the vector data, and then merge the portions together by
selecting the proper control points for each scanned portion.

2.11.2 Import Geo-Coded Vector...command (File Menu)
This function allows the import of a geo-referenced vector file to display on top of a georeferenced image so you can use all the editing and processing tools provided by R2V to
update or edit the data. This function is very similar to the File/Import Vector command.
The only difference is that control points are applied to map the vector data to the image
coordinate system when they are read into R2V.
This function is normally used in the following sequence:
Step 1. Open an image you want to use as the backdrop using the File/Open Image or
Project command.
Step 2. Import the geo-coded vector file by using the File/Import Geo-Coded Vector
command.
If your image is already geo-referenced with control points or saved as a GeoTIFF file,
simply specify the vector file name and open it.
If the image is not geo-referenced, an Import Geo-Coded Vector File dialog box will
appear (See Figure).
You need to provide two file names: one
is the Control Point or TFW File To Be
Applied, which was used to create the
geo-coded vector data from the image
coordinate system, and the other is the to
be imported Vector File Name.
NOTE: The control points or TFW file
should be created in the “From Image
Coordinate to Geo-Coded Coordinate
System” direction. That is, the source or
“From” side of (X,Y) should be in image
pixel coordinates, and the destination side
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of (X,Y) should be in the geo-coded coordinate system. If they are specified reversed,
you won’t get the correct mapping between the two coordinate systems (See Section 3.8
Control Point Editor (Edit Menu)).
The import vector file formats currently supported by R2V are: GEN (*.gen), ARC
(*.arc), MIF (*.mif), SHP (*.shp), PNT (*.pnt), SDL (*.sdl), and XYZ (*.xyz).
Step 3. Once the file is imported, all lines and points are actually projected to the image
pixel coordinate system using the control points or TFW file provided.
You can now use R2V’s functions to edit or process your data the same way as you
normally do.
Step 4. When processing is done, you can export your data using the File/Export Vector
command.
You should apply your control points or the TFW data if exporting the data back to a
geo-coded coordinate system is desired. If more editing needs to be done later, use the
File/Save Project command to save all your data layers.

2.11.3 Export Vector...command (File Menu)
Use this command to save the extracted vector data to a vector data file, including lines,
points, and text notes for some formats. The currently supported formats include:
Arc/Info Generate file format (*.gen, *.arc), Shape File format for ArcView (*.shp),
MapInfo vector format (*.mif), CAD drawing exchange file format (*.dxf), IGES (*.igs),
MapGuide file (*.sdl), and 3D XYZ formats (*.xyz).
When layers are defined, only data in the layers that are set as “on” can be exported. To
include layers in the output file, you need to turn the layer “on” before you export. To
exclude a layer from the output file, simply turn the layer “off” before you export. The
layer status is set using the Edit/Layer Define command. However, there is an exception
when exporting to DXF, which supports multiple layer structure. In this case, all data
layers (both “on” and “off”) are included.
When exporting vector data, use the export options in the corresponding dialog box to set
the configuration of the output vector file.
Common to all the option dialog boxes for all supported vector file formats, the
transformation parameters need to be set. The transformation method is used to map the
vector data to a required projection system. One option is the Bi-linear method using
least squares to estimate a set of transformation formulae for the entire data set. The other
method is Delaunay Triangulation, which divides the entire space into individual
triangles and each triangle provides a set of linear transforms for all the points within
itself.
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The two methods are different in how the projection is done. If you are going to use the
vector data together with a raster image registered by a TFW (image world file) and you
do not have many control points (for example, less than 7), the bi-linear method may
work better for you. If you have a lot of control points available and intend to stitch maps
together, you may want to try the Delaunay triangulation method first as they maintain
high accuracy level in areas close to control points.
If TFW data is available to the image, you can use the parameters to geo-reference your
vector data, in a way similar to using control points. With TFW, a linear transformation is
generated and its 6 parameters are saved in an ASCII file.
Whatever transformation method used to import geo-coded vector data, you should use
the same method to export the data to maintain the alignment of both raster image and
vector data layer.
The ArcView Shape File
generates three files for a set of
vector data with the extensions,
*.shp (main shape file), *.shx
(index file), and *.dbf (attribute
file in DBase format). Point
and line data need to be saved
to separate files using the
Shape File format. Labeled ID
values are kept and saved in the
corresponding attribute file
(*.dbf). Text notes are exported
as a point layer with the text stored in the database table. Check the Text Notes option if
you need to export the text notes. If you have created a polygon layer, you should use
Edit/Layer Define to turn off all layers except the polygon layer and then export.
Otherwise, all layers will be exported to the same shapefile.
The Arc/Info generate file is an ASCII file
and used for both import and export by
R2V. Points and lines are saved in separate
files. The point file has an extension *.pnt.
Text data is not supported by this format.
The MapInfo (*.mif) file can save all
different items into one file, including
lines, polygons, points, and text strings.
Use the MIF File Parameters dialog box
to select layers for export. Because MIF
supports many projection systems, make sure the projection system parameters are set
properly. When in doubt, you can try to export your vector data to a Latitude/Longitude
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projection system, which does not need the projection parameters. The control points
must be selected in order to map the vector data to latitude and longitude coordinate
system.

The DXF file can save all different
items into one file, including lines,
polygons, points, and text strings. Use
the DXF Export Options dialog box
to select layers for export (See
Figure). The control points must be
selected in order to map the vector
data into the desired projection
system. When scanning information
is available, you can also use the
scale of the original paper source as
the coordinate system.
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The SDL file is supported by
MapGuide software and is
used to publish a map on the
Internet. The SDL Export
Options dialog box appears to
allow you to set the necessary
parameters (See Figure).

The XYZ file is an ASCII file format
where all lines and points are saved as
3D points, with the labeled ID value as
the Z value. This format is supported by
many of the 3D mapping and
visualization software packages. When
exporting to the XYZ file format, the
3D XYZ File Options dialog box
appears and allows you to set the
necessary parameters (See Figure).
If you want to apply registration when exporting, you need to select proper control points
before you use this command. When control points are selected for the current data set,
the Apply Control Points options will be enabled in the export option dialog box. Select
the transformation method you intend to use. When control points are applied, a
geometric transformation derived from the specified control points is used to map vector
data to the new coordinate system when saving to a file.
Be careful when applying registration if you plan to do more editing on the data set being
exported. This can cause a problem if you plan to use the scanned image as the backdrop
when doing vector editing because the coordinates of the vector data have been mapped
to a different domain specified by the control points and they will not match the image
any more. The right way to deal with this is to save the vector data to a file without
applying the registration and also save the data to a separate file with registration applied.
Always use the unregistered file for editing with the image and apply registration when
needed. It is suggested to always save an unregistered vector data file along with the
registered one as a back up.
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2.11.4 Save Vector As Image…command (File Menu)
This command creates a raster image from the vector data, including lines, points and text
notes. You can use the Edit/Layer Define command to turn off layers not to be included
in the final image.
After this command is called, a file dialog box appears so you can enter an image
filename to store the output image. When the command is done, use the File/Open Image
command to display.

2.12 Control Point File Commands
2.12.1 Save Control Points…command (File Menu)
Use this command to save the currently selected control points to a control point file.
The control point file is in ASCII format with a file extension (*.cpt) and can be edited
using a text editor if needed. Normally, you should use the Vector/Select Control Points
option to select control points and make modifications.
A control point is displayed as a circle in red.

2.12.2 Load Control Points/TFW…command (File Menu)
Use this command to load a control point file (*.cpt), a world file (*.tfw), or a MapInfo
TAB file for geo-referencing the current vector set or raster image. The control point file
is in ASCII format with a file extension (*.cpt). The TFW file is in ASCII format, which
includes the geometric transformation parameters. After the control points are loaded,
they are displayed as circles in red and can be modified using the Vector/Select Control
Points option.
The control points or TFW data can then be used to register the vector data when
exporting to a vector file.
When control points or TFW data exist for the current IMAGE WINDOW, the display of
the mouse location at the bottom in the Status Bar can be switched between image pixel
coordinate and geo-coded coordinate using the View/Geo-Coded Coordinates command.
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2.13 3D Data (File Menu)
2.13.1 Open 3D File…command (3D Data submenu)
Use this command to open an existing grid file or DEM (digital elevation model) file for
3D display. The 3D DEM file is compatible with USGS DEM file format.
This commands requires the OpenGL
graphics library, which is provided by
Windows.
The grid data will be displayed in a 3D
VIEW WINDOW (See Figure). You
can use the View/3D Setting command
within the 3D VIEW WINDOW to
change the parameters used for the
display. This command brings up the
3D Setting dialog box (See Figure).
The parameters include:
Zoom: This parameter adjusts the zoom factor.
Azimuth Angle: This is the viewing azimuth angle in degrees, which adjusts the viewer
position to the left or the right.
Apex Angle: This is the apex angle in degrees, which adjusts the viewer position up or
down.
If image draping is applied, use the “Drape Set” button to choose how the draping can be
done.
Use the “Animation” button to let the 3D VIEW rotate continuously. Press the
“Animation” button again to stop.
You can use the File/Print Window command to create a hard copy of the 3D display.
To save the 3D display to a bitmap file, use the File/Save Window to File command.
A grid file can be created using the File/Create 3D Grid File command or imported from
other packages that support the grid file format.
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2.13.2 Create 3D Grid File…command (3D Data submenu)
Use this command to create a grid file from the labeled line data. You must have a line
data layer present in your current display window to be able to use this command. The
line IDs will be used as the height when creating the 3D grid file.
A Grid Cell Size dialog box appears to allow you to specify the parameters (See Figure).
If you want to change the default grid file
name, use the “Browse” button to specify
a new file name. The Cell Size determines
how many Rows and Columns will be used
in the grid data. A larger cell size will
result in a smaller grid file, but coarser 3D
data and display. A smaller cell size will
result in a larger grid file size, longer
processing time to create, and a finer 3D
display.
The grid file can be displayed in 3D using
the File/Open 3D File command.
3D grid data can be used for 3D visualization of your vector data and accuracy
verification of the labeled IDs.

2.13.3 Create 3D DEM File…command (3D Data submenu)
Use this command to create a DEM
(digital elevation model) file from
the labeled line data. The 3D DEM
file is compatible with the USGS
DEM file format.
You must have a line data layer
present in your current display
window to be able to use this
command. The line IDs will be used
as the height when creating the 3D
data.
The DEM Setting dialog box
appears to allow you to specify the
parameters (See Figure).
If you want to change the default file
name, use the “Browse” button to
specify a new file name. The Cell
41

F I L E

M E N U

C O M M A N D S

Size determines how many Rows and Columns will be used in the grid data. A larger cell
size will result in a smaller grid file, but coarser 3D data and display. A smaller cell size
will result in a larger grid file size, longer processing time to create, and a finer 3D
display.
Other DEM parameters can be entered: The Quad name field refers to the name of the
area. The Units code (ground planametric coordinates) refers to the unit defined by
USGS. The Units code (elevation coordinates) refers to the elevation unit defined by
USGS. You can also specify the Ground coordinates of the 4 corners of the DEM.
The DEM file can be displayed in 3D using the File/Open 3D File command.
3D DEM data can be used for 3D visualization of your vector data and accuracy
verification of the labeled IDs.

2.13.4 Image Drape…command (3D Data submenu)
Use the File/3D Data/Image Drape command to drape the currently displayed image to
the currently displayed 3D dataset. The image will
be used as the surface in the 3D display. Use the
View/3D Setting command in the 3D VIEW
WINDOW to choose how the draping should be
done once the image has been draped onto the 3D
display. The Drape Setting dialog box appears
when you click the “Drape Set” button in the 3D
Setting dialog box (See Figure).

If a selection rectangle is
present, R2V will display a
Dialog box with the selected
region parameters. You can
confirm or modify the
parameters to adjust the
region to match the 3D
dataset. If no selection
rectangle is present, the
entire image will be used to
cover the 3D dataset. Any
image that can be displayed
in R2V can be draped onto the 3D data.
Before you drape the image, make sure the image orientation matches the orientation of
the 3D data. Use the image orientation adjustment functions under the Image menu if
necessary. A 3D dataset must be currently present to use this command.
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A 3D data file (DEM or Grid) can be displayed in 3D using the File/Open 3D File
command.

2.13.5 Export 3D Model…command (File Menu)
Use this command within the 3D VIEW WINDOW to save the current 3D model data to
a DXF, WRL (VRML), STL, or XYZ file. The DXF file contains the surface polygons
and triangles generated from the 3D dataset. The binary STL file can be used on a rapidprototyping machine to create 3D physical models. The VRML (Virtual Reality
Modeling Language) is a standard 3D graphics format widely used over the Internet for
3D visualization. You can simply download a VRML plug-in for your web browser and
use it to display your 3D models.
The XYZ file contains 3D points of the 3D dataset.
The grid file can be displayed in 3D using the File/Open 3D File command in the 3D
VIEW WINDOW.
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2.14 OCR and Text (File Menu)
This section has functions to load and save text and OCR related files.

2.14.1 Load Text Blocks...command (OCR and Text submenu)
Use this command to load text blocks from a text block file. Text blocks are region
markers that indicate the extracted lines within each block are from a text character.
Text blocks can be generated automatically using the Vector/Detect Text Blocks
command or manually using the Edit/Text Block Editor functions.
Text blocks are used for OCR signature training and converting extracted lines to text
strings. Vector lines within each text block can be edited using the Edit/Text Block Editor
options.

2.14.2 Save Text Blocks...command (OCR and Text submenu)
Use this command to save existing text blocks to a text block file. Text blocks are
regional markers that indicate the extracted lines within each block are from a text
character. Text blocks should be saved to a file when text editing and OCR functions will
be used.
Text blocks can be generated automatically by using the Vector/Detect Text Blocks
command or manually using the Edit/Text Block Editor functions.
Text blocks are used for OCR signature training and converting extracted lines to text
strings. Vector lines within each text block can be edited using the Edit/Text Block Editor
options.

2.14.3 Load OCR File...command (OCR and Text submenu)
Use this command to load OCR signatures from an OCR signature file. OCR signatures
are used to convert detected text blocks to editable text strings or number strings. OCR
signatures are saved to a file using the File/OCR and Text/Save OCR File command.
OCR signatures are generated interactively using the Edit/Text Block Editor/Train OCR
command.
OCR signatures generated from a map can be applied to other similar types of maps with
text of the same fonts and styles. You should generate different sets of OCR signatures if
there are texts that are in different fonts and styles within a map. Use the File/OCR and
Text/Load OCR File command or Edit/OCR Signatures to load different OCR signatures.
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2.14.4 Save OCR File...command (OCR and Text submenu)
Use this command to save trained OCR signatures to an OCR signature file. OCR
signatures are used to convert detected text blocks to editable text strings or number
strings. OCR signatures can be loaded from a file using the File/OCR and Text/Load
OCR File command.
OCR signatures are generated interactively using the Edit/Text Block Editor /Train OCR
command.
OCR signatures generated from a map can be applied to other similar types of maps with
text of the same fonts and styles. You should generate different sets of OCR signatures if
there are texts that are in different fonts and styles within a map. Once a set of OCR
signatures is trained, use the File/OCR and Text/Save OCR File command or Edit/OCR
Signatures to save to a file.

2.14.5 Load Notes...command (OCR and Text submenu)
Use this command to load text notes from a text note file. Text notes are used for vector
labeling and annotation purpose. Text notes are saved to a file using the File/OCR and
Text/Save Notes command.
Text notes can be generated in two ways. One way is automatic conversion by
recognizing text from the scanned image using R2V’s OCR engine (Vector/Convert to
Text Notes (OCR)). Another way is to use R2V’s Text Notes Editor under the Edit menu.
The Text Notes Editor allows you to generate text notes interactively.
Text notes can only be loaded from R2V’s text note file (*.nts). Text notes can be
exported to some of the supported vector file formats, such as DXF (*.dxf) and MIF
(*.mif).

2.14.6 Save Notes...command (OCR and Text submenu)
Use this command to save text notes to a text note file. Text notes are used for vector
labeling and annotation purpose. Text notes can be read back into R2V using the
File/OCR and Text/Load Notes command.
Text notes can be generated in two ways. One way is automatic conversion by
recognizing text from the scanned image using R2V’s OCR engine (Vector/Convert to
Text Notes (OCR)). Another way is to use R2V’s Text Notes Editor under the Edit menu.
The Text Notes Editor allows you to generate text notes interactively.
Text notes can only be loaded from R2V’s text note file (*.nts). Text notes can be
exported to some of the supported vector file formats, such as DXF (*dxf) and MIF
(*.mif).
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2.15 Print (File Menu)
Under the File/Print menu, a number of options are available. You can print your images
or data files (Print), you can adjust your print setup (Print Setup), you can preview an
image or other data file (Print Preview), you can print an entire R2V screen (Print
Screen), and print an R2V window (Print Window).

2.15.1 Print Screen…command (Print submenu)
Use this command to print a screen dump on your default printer. Make sure the printer is
turned on and set up properly before using this function.

2.15.2 Print Window…command (File Menu)
Use this command to print the currently active IMAGE WINDOW on your default
printer. Make sure the printer is turned on and set up properly before using this function.

2.16 Scan Commands
2.16.1 Select Scanner...command (File Menu)
R2V supports the standard TWAIN interface. If a scanner is TWAIN compatible, it can
be used to scan images into R2V for vectorization and other processing.
To select a scanning device:
1. On the File menu, click Select Scanner.
2. Click the scanner you want to use and confirm.

2.16.2 Scan Image...command (File Menu)
R2V supports the standard TWAIN interface and can use any scanner that’s compatible
with the standard.
To acquire a new image document:
1. Under the File menu, click Scan Image.
2. Follow the instructions on the screen. See your scanner or camera documentation for
more scanner specific information.
3. The scanned image will be displayed in an IMAGE WINDOW for vectorization and
processing. You should save the image to a file if you need to keep a copy.
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2.17 1, 2, 3, 4…command (File Menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four
images you closed. Choose the number that corresponds with the image you want to
open.

2.18 Exit…command (File Menu)
Use this command to end your R2V for Windows session. You can also use the Close
command on the application Control menu. R2V for Windows prompts you to save
documents with unsaved changes.
Shortcuts
Mouse:

Double-click the application's Control menu button.

Keys: ALT+F4
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Chapter

3
Edit Menu Commands
All data layers can be edited using the editors or editing commands described in this chapter.
The Edit menu offers the following commands:
Layer Define

Defines, updates, and sets the status of layers.

Layer Manipulate

Moves or copies data between layers.

Line Editor

Starts the interactive Line Editor tool. Use the right
mouse button to select the editing functions.
Assigns a unique ID to each line automatically.

Auto Line IDs
Image Editor

Delete Points

Starts the interactive Image Editor tool. Use the right
mouse button to select editing options.
Starts the interactive Point Editor tool. Use the right
mouse button to select specific point editing functions.
Deletes all current points

Auto Point IDs

Assigns a unique ID to each point automatically.

Control Point Editor

Starts the interactive Control Point Editor tool. Use the
right mouse button to select specific control point editing
functions.
Displays the statistics of currently selected control points.

Point Editor

Control Point
Statistics
Geo-Coord Convert

OCR Signatures

Performs coordinate conversion between State Plane,
UTM, and Latitude/Longitude projection systems.
Calculates and displays Delaunay Triangulation using the
currently specified control points. Use the View/Overlay
options to turn it on and off.
Starts or stops the Text Block Editor. Use the right mouse
button to select editing options.
Text vector editing functions.

Delete Text Blocks

Deletes all text blocks.

Delaunay
Triangulate
Text Block Editor
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Text Notes Editor

Starts the interactive Text Notes Editor. Use the right
mouse button to select specific text note editing functions.

Attribute file
(SDL)…
Undo (Ctrl+Z)

Undo the last edit.

Copy (Ctrl+C)

Copies data from the document to the clipboard.

3.1 Layer Define…command (Edit Menu)

Use this command to define new layers, update existing layers, or set the status of
existing layers. After the Edit/Layer Define command is selected, the Layer
Management dialog appears (See Figure).
R2V always has a default layer with the name 0 (zero). This layer will always exist and
can’t be deleted or changed.
When adding a new layer to the “current” layer list, type the name of the new layer in
the edit box and then select the “Add Layer” button to confirm. The new layer will be
added to the layer list.
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To define a color for a layer, first select a layer by highlighting it in the layer list, and
click the “Color” button. Choose a color from the Color dialog box to apply. The color
defined for the layer will be applied to all the data within the layer automatically with the
exception when lines have been labeled with an ID value. In this case, the lines will use
the color defined by the View/Line Colors/Set Line Color by ID command.
To define the line type of a layer, first select a layer by highlighting it in the layer list,
and click the “Line Type” button. Clicking
the “Line Type” button will bring up the
Define Line Types dialog box (See
Figure). This will allow you to choose a
type of line from the list to apply to the
layer.
For layers with closed polygons, the
polygons can be displayed with a fill hatch
pattern using the View/Fill Polygons
command. To define the fill hatch pattern,
first highlight a layer from the list and then
click the “FillHatch” button. Clicking the
“FillHatch” button will bring up the Fill Hatch dialog box (See Figure). Select a pattern
from the list to apply to the layer.
Click the “Current” button to set a selected layer
as the “current” layer if you are going to work
within this layer. All data created from
automatic vectorization or interactive tracing
will be put into the “current” layer. Vector data
can be copied or moved between layers using the
Edit/Layer Manipulate command.
When one or more layers are turned “on” using
the “On/Off” button, all data within those layers
will be active to the display control commands
(View/Overlay), editing commands (if not
locked), and vector processing commands.
The “All On/Off” button is used to turn all
layers on or off the same time.
When a layer is turned “on” and locked by using the “Lock/Unlock” button, the lines in
the layer will be visible but not available to the Line Editor. This is very useful when
using an existing layer as the basis to create data for the “current” layer, for example,
creating polygons with existing line segments using the Edit/Line Editor/Form Polygon
command. In this case, you need to first create a new layer for the polygons or use a layer
created by the Vector/Create Polygon Layer command. Lock this layer and make it the
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“current” layer. Once it is locked, it can accept data and be displayed, but not be edited
by the Line Editor.
When a layer is turned “off”, all data within the layer will not be visible and will not be
affected by the editing and processing commands. When working on a specific layer, it is
highly recommended to turn the rest of the layers “off” so they won’t be affected by
commands you want to apply only to the “current” layer.
Use the File/Layer/Save Layers command to save defined layer data to a layer file. Other
maps or drawings can share layer data when they have the same layer definition.
Use the File/Layer/Load Layers command to load layer data from a layer file.
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3.2 Layer Manipulate…command (Edit Menu)
Use this command to copy or move vector data between layers. When the Edit/Layer
Manipulate command is selected, the Layer Manipulate dialog box appears (See
Figure). Layers can then be defined and updated using the Edit/Layer Define command.

When one or more layers are turned “on” using the “On/Off” button, all data within those
layers will be active to the display control commands (View/Overlay), editing
commands, and vector processing commands.
When a layer is turned “off”, all data within the layer will not be visible and will not be
affected by the editing and processing commands. When working on a certain layer, it is
highly recommended to turn the rest of the layers “off” so they won’t be affected by
commands you want to apply only to the “current” layer.
Use the File/Layer/Save Layers command to save defined layer data to a layer file. Other
maps or drawings can share layer data when they have the same layer definition.
Use the File/Layer/Load Layers command to load layer data from a layer file.
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3.3 Line Editor (Edit Menu)
Use the Edit/Line Editor/Line Editor On/Off command to start the Line Editor . With
the Line Editor, you can add new lines, add a node, move a node, delete a node, assign an
ID to one or a group of lines, label contour lines, highlight a line, put a line into a layer,
delete a line, and delete all lines. When the tool is started, the cursor will change
according to the editing mode. Use the right mouse button to get the editing pop-up menu
for options, select the editing options from the Edit/Line Editor submenu, or from the
toolbars. An option is checked if the corresponding editing mode is currently active.
When layers are defined, it is highly suggested to leave only the layer you are working
with “on” and turn the rest of the layers “off”. If all of the layers are left “on”, then all
lines will be available to all the editing options.
The Line Editor options are:
New Line

Start adding a new line or finish the current line.

Auto Trace

Toggles interactive line tracing mode on and off.

Free Trace

Toggles free hand tracing mode on and off.

Multi-Line Trace

Toggles multiple line tracing mode on and off.

New Rectangle

Draws rectangles.

New Circle

Draws circles or ellipses.

B-Spline Line

Smoothes individual lines using B-Spline.

Smooth Line

Smoothes individual lines.

Set Smoothing

Sets smoothing threshold for auto tracing and multi-line
tracing.

Add Node

Adds a node to an existing line.

Move Node

Moves a node of an existing line.

Delete Node

Deletes a node from an existing line.

Split Line

Splits an existing line into two lines at a selected location.

Join Lines

Joins two lines into one.

Close Line

Closes a line.

Copy Line

Copies an existing line and moves it to a new location.

Move Line

Moves a line to another location.

Delete Line

Deletes an existing line.

Delete All Lines

Deletes all lines within a selected region or the entire image.
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Snap to Node

Toggles the snap to node mode on and off for the Move
Node and New Line functions.

Snap to End

Undo

Toggles the snap to end mode on and off for the Move Node
and New Line functions.
Toggles the snap to line mode on and off for the Move
Node and New Line functions.
Allows you to interactively set the distance for the snap
function
Undo previous editings.

Set ID Value

Sets current ID value for line labeling.

Assign Line ID

Assigns the current ID to a line.

Highlight Line

Visually highlights a selected line and shows its area and
length.
Labels contour lines.

Snap to Line
Snap Distance…

Label Contours
Intersection Symbol
Set Layer

Shrinks identified intersection symbols using existing
markers or a selection rectangle.
Puts selected lines into the “current” layer.

Form Polygon

Creates polygons from existing line segments

When editing is finished, select the Done option or select the Edit/Line Editor/Line Editor
On/Off command again to exit the tool.
R2V uses shortcut keys for quick access to some of the frequently used functions.
The following is a list of keys used frequently with the Line Editor:













F1: Help function
F2, +: Zoom in. This can be used with a selection rectangle drawn using the left
mouse button or move the cursor to a specific area to zoom.
F3, -: Zoom out.
F4: Opens the Image Contrast dialog box for grayscale images.
F5: Shows the image in full view, or fits the entire image in the window.
F6: Goes back to the previous view.
CONTROL + Left Mouse Button: Gets the distance measurement to show in the Status
Bar at the bottom of the IMAGE WINDOW.
SHIFT + Left Mouse Button: Draws a selection rectangle under any editing mode.
SPACEBAR: Finishes a line while using the New Line command.
"T" or "t" under Line Editor/New Line: Toggles the Auto Tracing mode on and off.
"C" or "c" under Line Editor/New Line: Finishes the current line by connecting it to
the starting point to make a closed polygon.
"S" or "s" under Line Editor/New Line: Finishes the current line and connects it to
another line end that is the closest.
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CONTROL-Z: Undo the last editing under the Line Editor.
BACKSPACE (←): Undo the last addition under the Line Editor/New Line.

3.3.1 Line Tracing Commands (Line Editor submenu)
3.3.1.1 New Line…command (Line Editor submenu)
Use this command to start a new line either manually or semi-automatically when the
Auto Tracing option is on. The cursor will change to a Cross Cursor. Point the cursor at
an image location and click the left mouse button. A new segment will be added to the
current line and a rubber band line will follow the current cursor location to indicate the
line segment to be selected. Repeat this step to draw the entire line until all the segments
are drawn.
When the line is completed, hit any key (except the “C” key and the “S” key) or select
the New Line command again to finish. If the “C” key is used, the line is finished as a
closed polygon. If the “S” key is used, the line will snap to another line that is closest to
it. Repeat the process to add another line.
For semi-automatic interactive line tracing, use the Auto Tracing command.
The traced line is always put into the “current” layer. To create lines for a different
layer, you need to set the new layer as “current” by selecting the layer from the toolbar
or using the Edit/Layer Define command.
While tracing a line, you can use the ARROW KEYS or the PAGE UP and PAGE DOWN keys
to scroll within the image or move to a different image area.
If the Snap to Node mode is on (checked), then the first and last point of the currently
added line will snap to the closest node of a line that is closest to it.
If the Snap to End mode is on (checked), then the first and last point of the currently
added line will snap to the closest end of a line that’s next to it.
Use the Edit/Undo or CONTROL-Z to undo the current operation. .
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button or by using the Edit/Line
Editor/Line Editor On/Off command.
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3.3.1.2 Auto Trace…command (Line Editor submenu)
Use this command to toggle the interactive line tracing mode on and off. Auto
Tracing is used to control the New Line editing mode. Auto Tracing should be used
when a line is drawn interactively.
This function is designed to effectively trace raster images, which are either in poor
quality, or too complex to use automatic vectorization function. The Auto Tracing option
can also be used when only portions of an image need to be vectorized.
When in the New Line editing mode and the Auto Tracing option is on (the command is
checked), you can trace a line interactively by giving directions to R2V and letting R2V
do the hard part. To start a line, move the mouse to a line and click the left mouse button
within the line to get the starting point. Then move the mouse a short distance away from
the first point and click the left mouse button again for the next point. This point is used
to lead the direction of the line tracing. Once the next point is clicked, R2V will trace the
line until it encounters the end of the line, a broken point, or a multi-line intersection. To
continue the tracing on the same line, move the mouse along the line and click the left
mouse button to give R2V the next point and direction. Repeat the above steps to trace a
complete line.
If a line is not traced correctly, you can use the BACKSPACE (←) key to delete a point
from the end of the line and then use the mouse to select a new point to lead the tracing
on the correct course. Use the BACKSPACE (←) key repeatedly to remove multiple
incorrectly traced points from the line.
To finish the tracing of a line, simply press any key (except the BACKSPACE (←) key,
“C” or “c” key, and “S” or “s” keys). The BACKSPACE (←) key is used only for deleting
a point from the end of the currently traced line.
The “C” or “c” key will close the currently traced line to make a closed polygon. If the
currently traced line is closed, R2V will automatically close the line and finish the
session.
The “S” or “s” key will snap the current line to another line that is the closest.
Smoothing is automatically performed for each traced line. Use the Line Editor/Set
Smoothing command to change the smoothing threshold.
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3.3.1.3 Multi-Line Trace…command (Line Editor submenu)

This function is used to trace a group of lines in a single step. After you are in the
Multi-Line Trace mode, you can start the process by holding down the left mouse button
and drawing a line (rubber band line) across the group of lines to be traced (See Figure).
The Multi-Line Trace command selects all the lines between the two points and traces the
lines when the left mouse button is released. R2V will automatically trace all the lines
selected and the tracing will stop when it encounters one of the following cases:
1) A multiple line intersection
2) A broken point
3) The end of line
4) A closed polygon.
Repeat the above steps to trace a new group of lines.
The traced lines are always put into the “current” layer. To create lines for a different
layer, you need to set the new layer as “current” by selecting the layer from the toolbar
or using the Edit/Layer Define command.
Smoothing is automatically performed for each traced line. Use the Line Editor/Set
Smoothing command to change the smoothing threshold.
Note: Even of a line is traced, it can still be traced again and this will cause the software
to have duplicate copies of a line. When tracing a group of lines, be careful to not trace
lines that have already been traced. Use the Line Editor to delete redundant lines if a line
is traced more than one time.
3.3.1.4 Free Trace…command (Line Editor submenu)
Use this command to switch to the free hand tracing mode to manually trace line.
The cursor will change to a hand drawing cursor. Point the cursor at an image location
where you want to start a line, hold down the left mouse button to draw or trace along the
line. Release the left mouse button to confirm the line segment. Repeat this step to
continue tracing. Press the SPACEBAR to finish.
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3.3.1.5 New Rectangle…command (Line Editor submenu)
Use this command to switch to the rectangle drawing mode to add rectangles.
The cursor will change to a Cross Cursor. Point the cursor at an image location where
you want to start a rectangle and drag the mouse to finish the rectangle. Release the left
mouse button to confirm the rectangle.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.1.6 New Circle…command (Line Editor submenu)
Use this command to switch to the circle drawing mode to add circles or ellipses.
The cursor will change to a Cross Cursor. Point the cursor at an image location where
you want to start a circle and drag the mouse to draw a bounding rectangle. Release the
left mouse button to confirm and a circle or ellipse will be created.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.2 Line Smoothing Commands (Line Editor submenu)
3.3.2.1 Line…command (Line Editor submenu)
This mode is used to smooth individual lines with the smoothing threshold set using the
Set Smoothing command (See Section 3.3.8 Set Smooth…command). The threshold
value is in pixels and is similar to the threshold used by the Vector/Smooth Lines
command. The value can be a floating point but must be equal or larger than 0.0. A
smaller threshold will result in less smoothing and leave more nodes or vertices for the
traced line. On the other hand, a larger threshold value will result in more smoothing and
leave fewer nodes for the line.
Once in the Smooth Line mode, move the cursor to a line and click the left mouse button
to smooth. This function uses the same smoothing algorithm as the Vector/Smooth Lines
function but only smoothes selected lines.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
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3.3.2.2 B-Spline Line…command (Line Editor submenu)
This mode is used to smooth individual lines using the B-Spline method. The smoothed
line normally has more nodes then the original because of the B-Spline interpolation.
Once in the B-Spline Line mode, move the cursor to a line and click the left mouse button
to smooth. This function uses the same smoothing algorithm as the Vector/B-Spline
Smooth function but only smoothes selected lines.
Use the Edit/Undo command or CONTROL-Z to undo the smoothing operation.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.2.3 Set Smoothing…command (Line Editor submenu)
This option is used to set the smoothing
threshold value used by the Auto Tracing,
Multi-Line Trace, and Smooth Line
commands under the Line Editor
submenu. When the Set Smoothing
command is selected, an Auto Tracing
Parameters dialog box appears (See
Figure). The threshold value is in pixels
and is similar to the threshold used by the Vector/Smooth Lines command. The value can
be a floating point but must be equal or larger than 0.0. A smaller threshold will result in
less smoothing and leave more nodes or vertices for the traced line. On the other hand, a
larger threshold value will result in more smoothing and leave fewer nodes for the line.
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3.3.3 Node Editing Commands (Line Editor submenu)
3.3.3.1 Add Node…command (Line Editor submenu)
Use this command to add a node to an existing line. The cursor will change to a
Cross Cursor. Point the cursor at an image location where you want to add a node to a
line and click to add. The node should be close to a line so the system knows which line
to add the node to. If you need to add a node that is not close to the line, you should add a
node close to the line first and then use the Move Node option to move it to the desired
location.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.3.2 Move Node…command (Line Editor submenu)
Use this command to move a node of an existing line. The cursor will change to a
Move Cursor. Point the cursor at a node and hold the left mouse button to move. When
the node is moved to the desired location, release the left the mouse button to confirm the
new location.
Repeat this process to move another node. If a location on a line does not have a node,
you need to add a node first using the Add Node option and then move the node to the
desired location using the Move Node command.
If the Snap to Node mode is on (checked), the node to be moved will snap to the closest
node of a line that is next to it.
If the Snap to End mode is on (checked), the node to be moved will snap to the closest
end of a line that is next to it.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
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3.3.3.3 Delete Node…command (Line Editor submenu)
Use this command to delete a node of an existing line. The cursor will change to a
Delete Cursor. To delete one node, point the cursor at a node and click the left mouse
button to remove it. The system will always remove the closest node to the location
clicked. When deleting a node, try to be as close as possible to the node to be removed.
To delete nodes within a region, hold down both the SHIFT key and the left mouse button
to drag and draw a selection rectangle that includes the nodes to be removed. Once the
rectangle is in place, release the SHIFT key and left mouse button. Select the Delete Node
option again and you will be asked to confirm the removal. If the answer is YES, all
nodes and ends within the selected rectangle will be removed. Lines will not be split if
both ends are outside the region.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.4 Line Editing Commands (Line Editor submenu)
3.3.4.1 Split Line…command (Line Editor submenu)
Use this command to split an existing line into two lines. The cursor will change to a
Cross Cursor. Point the cursor at a node and click the left mouse button to split the line at
the selected location. Repeat the process to split another line.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.2 Join Lines…command (Line Editor submenu)
Use this command to join two lines together. The cursor will change to a Cross
Cursor. Only lines within the same layer can be joined.
To join two lines, point the cursor at one end of the first line, click and hold down the left
mouse button to select the end. Hold down and drag the left mouse button from the
current position to an end node of the second line and release the left mouse button to
join the two lines. A rubber band line will appear during the dragging process.
It is recommended to toggle the display of line ends (View/Overlay/Line Ends) on when
in the Join Lines mode so you can see easily where line ends are located and how they
disappear after being joined.
Use the Edit/Undo command or CONTROL-Z to undo the last operation.
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You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.3 Close Line…command (Line Editor submenu)
Use this command to create a closed line or polygon. The cursor will change to a
Cross Cursor when the Line Editor is in the Close Line editing mode.
To close a line, point the cursor at a line and then click the left mouse button to close it.
The closed line is then displayed. Repeat this step if more lines are to be closed.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.4 Copy Line…command (Line Editor submenu)
Use this command to copy an existing line and move it to a new location. The cursor
will change to a Cross Cursor when the Line Editor is in the Copy Line editing mode.
To copy a line, point the cursor at a line. Click and hold down the left mouse button to
copy and drag the mouse to move it to a new location.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.5 Move Line…command (Line Editor submenu)
Use this command to switch to the Move Line mode. The cursor will change to a
Move Cursor. Point the cursor at a line and hold the left mouse button to move. When the
line is moved to the desired location, release the left mouse button to confirm it. Repeat
this process to move another line.
To move a group of lines, hold down SHIFT key and drag the left mouse button within
the image to draw a selection rectangle to include the lines to be moved. Release the
SHIFT key. Hold down the left mouse button inside the rectangle and drag the mouse to
move the lines. Release the left mouse button to confirm.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
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You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.6 Delete Line…command (Line Editor submenu)
Use this command to delete an existing line. The cursor will change to a Delete
Cursor. Point the cursor at a node that belongs to the line to be deleted and click the left
mouse button to remove the line. The system will always remove the closest line to the
location clicked. When deleting a line, try to be as close as possible to avoid deleting the
wrong line.
Use the Edit/Undo command or CONTROL-Z to recover a line mistakenly deleted.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.7 Delete All Lines…command (Line Editor submenu)
This command can only be accessed from the main menu by selecting Edit/Line
Editor/Delete All Lines. It is not available from the right mouse floating pop-up menu to
avoid accidental loss of data. Use this command to delete all existing lines or all the lines
within a selected region if a selection rectangle exists in the IMAGE WINDOW. To get a
selection rectangle, hold down the SHIFT
key and then drag the left mouse button to
draw the selection rectangle. An R2V for
Windows dialog box will appear to
confirm this operation (See Figure). You
can cancel this operation by selecting the
“No” button in the confirmation dialog
box.
Caution: The Delete All Lines command will delete all the lines within the selected
region or the entire image and all the vector data will be lost if they are not saved to a
file. You should save the lines to a file using the File/Export Vector command in case
you want to get the data back after deleting.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
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3.3.4.8 Intersection Symbol…command (Line Editor submenu)
Use this command to change to the Intersection Symbol editing mode. The cursor will
change to a Cross Cursor.
When intersection symbols are detected and displayed using the Vector/Detect
Intersection Symbols command, point the cursor within a rectangle symbol marker and
click the left mouse button to shrink the symbol.
If no intersection symbol marker is present around an intersection symbol, you can first
draw a selection rectangle for the symbol by holding down both the SHIFT key and the
left mouse button, and then select the Intersection Symbol command again to shrink the
symbol.
If a mistake is made, use the Edit/Undo command or CONTROL-Z to recover.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.4.9 Reverse…command (Line Editor submenu)
Use this command to reverse the direction or order of nodes for a line. The cursor will
change to a Reverse Tool cursor.
If a mistake is made, use the Edit/Undo command or CONTROL-Z to recover.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.5 Node Snapping Commands (Line Editor submenu)
3.3.5.1 Snap To Node…command (Line Editor submenu)
Use this command to toggle the Snap To Node mode on and off for the Move Node and
New Line functions. When the Snap To Node mode is “on”, it is checked in both the
main menu and the floating pop-up menu.
When using the New Line function and the Snap To Node mode is “on”, the last node
will snap to the closest node of a line that is next to it when the line is finished.
When using the Move Node function and the Snap To Node mode is “on”, the moved
node will snap to the closest node of a line that is next to it when the line is finished.
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You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.5.2 Snap To End…command (Line Editor submenu)
Use this command to toggle the Snap To End mode on and off for the Move Node and
New Line functions. When the Snap To End mode is “on”, it is checked in both the main
menu and the floating pop-up menu.
When using the New Line function and the Snap To End mode is “on”, the first and last
node will snap to the end of a line that is next to it.
When using the Move Node function and the Snap To End mode is “on”, the moved node
will snap to the closest end of a line that is next to it when the line is finished.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.5.3 Snap To Line…command (Line Editor submenu)
Use this command to toggle the Snap To Line mode on and off for the Move Node and
New Line functions. When the Snap To Line mode is “on”, it is checked in both the main
menu and the floating pop-up menu.
When using the New Line function and the Snap To Line mode is “on”, the first and last
node will snap to the closest line that is next to it.
When using the Move Node function and the Snap To End mode is “on”, the moved node
will snap to the closest line that is next to it when the line is finished.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.5.4 Snap Distance…command (Line Editor submenu)
Use the Snap Distance command to
interactively set the desired distance for line
snapping. When this command is selected,
the Snap Distance dialog box will appear
(See Figure). The snap distance is measured
in pixel units.
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You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.6 Line Labeling Commands (Line Editor submenu)
3.3.6.1 Label Contours…command (Line Editor submenu)
Use this command to start the
contour labeling session. The values
assigned to the lines are stored as their
IDs. The cursor will change to a Cross
Cursor.
To label a group of contour lines, point at
a starting point, hold down the left
mouse, and drag to an ending point to
select a group of lines. During the mouse
dragging process, a rubber band line is displayed to show the trace. After the left mouse
button is released, the selected lines are displayed with reversed color and the Enter
Contour Values dialog box appears to take the Starting Value and Increment Value for
the labeling. The starting value is applied to the first line in the group and the next line
has a value added by the increment value. This applies to all the lines selected. If negative
increment value is selected, the increment value is then subtracted from the previous one
and assigned to a line.
The assigned ID numbers are saved when exporting using the Arc file format, ArcView
Shape files, and MIF/MID files. For the DXF file format, there is an option to save the ID
value as the Z value (the third dimension). The ID value is saved as the Z value for the
IGES file format.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.6.2 Highlight Line…command (Line Editor submenu)
Use this command to highlight a line. The cursor will change to an Arrow Cursor.
Point and hold down the left mouse button at a line to see the display change. Release the
left mouse button to restore the display of the selected line.
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The layer name and ID value of the selected line are displayed in the Status Bar at the
bottom of the IMAGE WINDOW. If the line is a closed polygon, its area and length are
also calculated and displayed in the Status Bar. If the line is not a closed polygon, only
the length is calculated and displayed in the Status Bar.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
3.3.6.3 Set Layer…command (Line Editor submenu)
Use this command to get into the Set Layer mode. Once in the Set Layer editing
mode, lines selected will be put into the “current” layer. Use this command to assign a
line to a desired layer.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.7 Form Polygon…command (Line Editor submenu)
Use this command to create polygons from existing line segments.
Before you start creating polygons, you should set a layer, which does not contain the
line segments to be used as “current” to hold the polygon data. Make sure the polygon
layer is locked so new polygons will not interfere with this process.
Once in the Form Polygon editing mode, select lines that will be used as the new polygon
boundary with the left mouse button. Selected lines are displayed with inverted color. To
deselect the last line, simply press the BACKSPACE (←) key or the ESC key. When all
lines are selected, press any key to form the closed polygon. The newly created polygon
is put in the “current” layer and the existing line segments stay unchanged.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Line Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.3.8 Undo…command (Line Editor submenu)
Use this command to undo a previous editing operation. The Undo command is available
for a certain number of steps during the editing session from the start to end. Once the
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editing session is turned off or switched to another editor, the undo data buffer is
refreshed.
Note: You should save the vector data to a file frequently by using the File/Export Vector
command if you are doing intensive editing.

3.3.9 Done…command (Line Editor submenu)
Use this command to exit the Line Editor.

3.3.10 Auto Line IDs…command (Edit Menu)
Use this command to assign a unique ID to each
line. When the Auto Line IDs command is selected,
the ID Range Dialog box appears (See Figure).
The Starting ID and the Increment Value can be
specified in the ID Range Dialog box. The IDs can
be changed using the Line Editor.
This function works in a random fashion and
should not be used when specific IDs need to be
assigned to specific lines.

3.4 Line Attributes…command (Edit Menu)
Use this command to add new and edit existing attributes to lines.
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The Number and Location columns are derived from the lines and cannot be changed.
The ID column can be edited by entering new values in the table. This column is the
default attribute of lines that cannot be deleted.
The “Add Column” button adds a new column to the table for adding new attributes to
the lines.
The “Delete Column” button deletes a selected column from the attribute table.
The “Rename Column” changes the name of a selected column.
To edit or enter attributes for a line, you can click on a line in the Image Window. The
corresponding row in the attribute table will be highlighted. You can also select a row in
the table to highlight the corresponding line in the image window.
Click the OK button to finish.

3.5 Point Editor (Edit Menu)
Use this command to start the Point Editor. With the Point Editor, you can add new
points, move a point, delete a point, and delete all points within a selected region. You
can also label the points with a specified ID value. When the Point Editor is started, the
cursor will change according to the editing mode. Use the right mouse button to get the
editing pop-up menu or use the toolbars for editing options. An option is checked if the
corresponding editing mode is currently active.
When layers are defined, it’s highly suggested to leave only the layer you are working
with “on” and turn the rest of the layers “off”. When layers are turned “on”, all point data
in these layers will be available to the editing functions.
The Point Editor options are:
New

Adds new points.

Delete

Deletes a selected point or points
within a selected region.
Moves a point to a new location.

Move
Set ID Value
Assign ID

Sets current ID value for point
labeling.
Assigns the current ID to a point.

Show ID Value

Displays the ID of a selected point.

Set Layer

Puts a point into the “current”
layer.
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3.5.1 New…command (Point Editor submenu)
Use this command to add new points to the “current” layer. The cursor will change
to a Cross Cursor. Point the cursor at an image location and click the left mouse button. A
new point will be added to the “current” point layer. Repeat this step to add more points
to the point layer.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.2 Delete Point…command (Point Editor submenu)
Use this command to delete a point in the “current” point layer. The cursor will
change to a Delete Cursor. Point the cursor at a point and click the left mouse button to
remove it. The system will always remove the closest point to the location clicked. When
deleting a point, try to be as close as possible to the point to be removed.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.3 Move Point…command (Point Editor submenu)
Use this command to move a point to a new location. The cursor will change to a
Move Cursor. Point the cursor at a point and hold down the left mouse button to move.
When the point is moved to the desired location, release the left mouse button to confirm
the new location.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.4 Set ID Value…command (Point Editor submenu)
Use this command to set the current ID value to be used to label a point. The
Current ID Value dialog box will appear to allow you to enter a number (See Figure).
The value can be either positive or negative. After the ID value is set, you can start
labeling by switching to the Assign ID mode under the Point Editor. If the Increase ID
every time by option is selected, then the current default ID value is increased by the
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specified increment value or decreased if the
specified value is negative, every time you label a
point. If the option is not selected, all the points
labeled will have the same ID value until you reset
the value to a different value.
You can switch to a different editing session by
selecting another option from the floating pop-up
menu brought up by pressing the right mouse
button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.5 Assign ID…command (Point Editor submenu)
Use this command to assign the current specified ID number to an existing point. The
cursor will change to an ID Cursor. Point and click the left mouse button at a point to set
the value. Use the Show ID option to verify the ID value.
The assigned ID numbers are saved when exporting to Point files (*.pnt), ArcView files
(*.shp), and MapInfo files (*.mif). They are saved as the Z value when exporting to DXF
files (*.dxf) and IGES files (*.igs).
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.6 Show ID Value…command (Point Editor submenu)
Use this command to show the ID value and layer name of a selected point. The
cursor will change to an Arrow Cursor. Point at a point and click the left mouse button.
The ID value is displayed in the Status Bar at the bottom of the IMAGE WINDOW.
You can switch to a different editing session by selecting another option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.
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3.5.7 Set Layer…command (Point Editor submenu)
Use this command to select points to add to the “current” layer. First set the layer you
want to get the points into as the “current” layer, then move the mouse to a point and
click the left mouse button to put it into the layer.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Point Editor by selecting the Done option from the floating pop-up
menu brought up by pressing the right mouse button.

3.5.8 Auto Point IDs…command (Edit Menu)
Use this command to assign a unique ID to each
point. The ID range can be specified in the ID
Range Dialog box. The IDs can be changed using
the Point Editor commands.
This function works in a random fashion and
should not be used when specific IDs need to be
assigned to specific points.

3.6 Delete Points…command (Edit
Menu)
The Delete Points command will delete all points in
the IMAGE WINDOW. When this command is
selected an R2V for Windows dialog box will appear
asking to confirm the operation (See Figure). You can
cancel this operation by selecting the “No” button in
the confirmation dialog box.
Caution: The Delete Points command will delete all
the points within the selected region or the entire image and all the vector data will be
lost if they are not saved to a file. You should save the points to a file using the
File/Export Vector command in case you want to get the data back after deleting.
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3.7 Point Attributes…command (Edit Menu)
Use this command to add new and edit existing attributes to points.

The Number and Location columns are derived from the points and cannot be changed.
The ID column can be edited by entering new values in the table. This column is the
default attribute of points that cannot be deleted.
The “Add Column” button adds a new column to the table for adding new attributes to
the points.
The “Delete Column” button deletes a selected column from the attribute table.
The “Rename Column” changes the name of a selected column.
To edit or enter attributes for a point, you can click on a point in the Image Window. The
corresponding row in the attribute table will be highlighted. You can also select a row in
the table to highlight the corresponding point in the image window.
Click the OK button to finish.
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3.8 Control Point Editor (Edit Menu)
The Control Point Editor On/Off command is used to start the Control Point Editor to
select or modify control points for vector data registration. Once the Control Point Editor
is started, the cursor will change according to the editing function used. The initial editing
function is New. Use the right mouse button to get the pop-up menu for editing options or
select the options from the Edit/Control Point Editor submenu.

The Control Point Editor options are:
New

Add a new control point.

Move

Move an existing control point.

Modify
Delete

Change the specified control point destination
coordinates.
Delete an existing control point.

Check

Check control point residual error.

Pick Point

Pick a point in the target image and use it for the
source image with the New control point option.
Deletes all control points within the IMAGE
WINDOW.
Deletes the world file data for the IMAGE WINDOW.

Delete All Control Points
Delete TFW Data

3.8.1 New…command (Control Point Editor submenu)
Use this command to switch to the mode for adding new control points. The cursor is
changed to a Cross Cursor in this mode.
To add a new control point, point at a
location in the IMAGE WINDOW and
then click the left mouse button. The
Control Point dialog box will appear for
you to enter the destination coordinates
(See Figure). The current image location
is displayed in the dialog box and cannot
be changed. To change the source
location, you can switch to the Move
option under the Control Point Editor to
move the control point to the correct location. When a new control point is added, a
control point mark (red circle with a cross) is displayed at its location.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
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You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.

3.8.2 Move…command (Control Point Editor submenu)
Use this command to switch to the Move mode for changing the location of an existing
control point. The cursor is changed to a Move Cursor in this mode.
To move an existing control point, point at the mark, hold down the left mouse button,
and drag to the desired location. This operation only changes the source location, but the
specified destination coordinates are not changed. Use the Modify option under the
Control Point Editor to change the destination coordinates.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.

3.8.3 Modify…command (Control Point Editor submenu)
Use this command to switch to the Modify mode for changing the destination coordinates
of existing control points. The cursor is changed to a Cross Cursor in this mode.
To modify an existing control point, point at the mark and click the left mouse button.
The Control Point dialog box will appear to allow changing the coordinate value.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.

3.8.4 Delete…command (Control Point Editor submenu)
Use this command to switch to the Delete mode for deleting existing control points. The
cursor is changed to a Delete Cursor in this mode.
To delete an existing control point, point at the mark and click the left mouse button. The
control point mark will disappear after it is deleted.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.
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3.8.5 Check…command (Control Point Editor submenu)
Use this command to switch to the Check
control points mode. This option checks a
control point by comparing its entered
destination coordinate to the calculated values
based on all of the defined control points. The
residual error is displayed in an R2V for
Windows dialog box (See Figure). Higher
residual error indicates the poor quality of the
control point selection.
To check a control point, point at the control point and click the left mouse button to
show the residual error.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.

3.8.6 Pick Point command (Control Point Editor submenu)
Use this command to switch to the Pick Point mode for picking a location in the target
image to be used for adding a new control point into the source image.
To use this option, you need to open both the source image and the target image at the
same time. Start the Control Point Editor for both images. Switch to the Pick Point mode
for the target image and the New control point mode for the source image. Move the
cursor to a location in the target image that is also visible in the source image. Click the
left mouse button to pick the location. A temporary marker is placed in the target image.
Once a location is picked up for the target image, switch back to the source image. You
should be in the New control point mode now. Move the cursor to the location that
matches the object location in the target image (identical point on the object, not
coordinates). Click the left mouse button to define a new control point. The coordinates
picked from the target image are used for the To fields in the Control Point dialog box.
Edit the values if necessary.
You can switch to a different editing session by selecting a different option from the
floating pop-up menu brought up by pressing the right mouse button.
You can terminate the Control Point Editor by selecting the Done option from the
floating pop-up menu brought up by pressing the right mouse button.
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3.8.7 Control Point Dialog Box
The Control Point dialog box allows you to
specify the destination coordinates (To) of a
selected control point (See Figure). The selected
control point location is displayed and can be
modified. The X is equivalent to the row
direction and Y is the column direction. The
destination coordinates (To) are to be entered and
used when generating a geometric transform for
vector data registration.

3.8.8
Delete
All
Control
Points…command (Control Point Editor submenu)
The Delete All Control Points command will automatically erase all of the existing
control points in the IMAGE WINDOW.

3.8.9 Delete TFW Data…command (Control Point Editor submenu)
This command removes the geo-referencing information loaded from a world file from
the IMAGE WINDOW. When you need to use a different set of control points or world
file for the image, you should use this command to delete the current world file data and
then open the new world file.
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3.9 Control Point Statistics...command (Edit Menu)
This command shows the statistics of currently selected control points. When the Control
Point Statistics command is selected, the Control Point Statistics dialog box appears
(See Figure).
The estimated data is calculated based on
a least-square bi-linear transformation
from the currently selected control points.
If a control point's specified coordinate is
significantly different from the calculated
coordinate, you should check this control
point and redefine its location to reduce
the error.
Use the View/Overlay/Control Point IDs
command to turn on the display of
control point IDs so you can see which
control point is which in the statistics
dialog box.
The menu item is grayed out if no control
point is present for the current image.

3.10 Geo-Coordinate Convert (Edit Menu)
The geo-coordinate conversion commands are used to convert points in one projection
coordinate system to another. For example, you can convert from a UTM coordinate
system to the geography coordinate system (latitude/longitude) or vice versa. You can
also convert coordinates between the state plane system and the geography coordinate
system.
If you have defined your control points in one coordinate system, you can use the
conversion commands to convert them to another projection system.
If conversion between two projection systems cannot be done directly using the
commands provided, for example, converting from State Plane NAD27 to State Plane
NAD83, you can convert the coordinates to an intermediate system first and then convert
to the target system. For this example, you can convert NAD27 to latitude and longitude
first, and then convert from latitude and longitude back to NAD83 system.
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3.10.1 UTM and Latitude/Longitude…command (Geo-Coord Convert
submenu)
This command converts coordinates between UTM and geography coordinate system.
The UTM–Latitude/Longitude Conversion dialog box appears when this command is
selected (See Figure).

The following table lists the names and parameters for the geodetic datums used by R2V
for Windows:
Reference Ellipsoid
Airy
Australian National
Bessel 1841
Bessel 1841
(Nambia)
Clarke 1866
Clarke 1880
Everest
Fischer 1960
(Mercury)
Fischer 1968
GRS 1967
GRS 1980
Helmert 1906
Hough
International
Krassovsky
Modified Airy
Modified Everest
Modified Fischer
1960
South American

Equatorial
Radius
6377563.396
6378160.0
6377397.155
6377483.865

Reciprocal
Flattening (1/f),
299.3249646
298.25
299.1528128
299.1528128

Delta a

Delta f (*10^4)

573.604
-23.0
739.845
653.135

0.11960023
-0.00081204
0.10037483
0.10037483

6378206.4
6378249.145
6377276.345
6378166.0

294.9786982
293.465
300.8017
298.3

-69.4
-112.145
860.655
-29.0

-0.37264639
-0.54750714
0.28361368
0.00480795

6378150.0
6378160.0
6378137
6378200.0
6378270.0
6378388.0
6378245.0
6377340.189
6377304.063
6378155.0

298.3
298.247167427
298.257222101
298.3
297.0
297.0
298.3
299.3249646
300.8017
298.3

-13..0
-23.0
0.0
-63.0
-133.0
-251.0.0
-108.0
796.811
832.937
-18.0

0.00480795
-0.00113048
-0.00000016
0.00480795
-0.14192702
-0.14192702
0.00480795
0.11960023
0.28361368
0.00480795

6378160.0

298.25

-23.0

-0.00081204
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6378165.0
6378145.0
6378135.0
6378137.0

298.3
298.25
298.26
298.257223563

-28.0
-8.0
2.0
0.0

0.00480795
-0.00081204
0.0003121057
0.0

The following steps are used to convert a point from latitude/longitude to a UTM
coordinate:
Step 1. Select the reference ellipsoid from the geodetic datum list.
Step 2. Enter the Latitude and Longitude values in the edit boxes. The latitude and
longitude are in decimal degrees. East Longitudes are positive and west longitudes are
negative. North latitudes are positive and south latitudes are negative.
Step 3. Click the “LL to UTM” button to do the conversion. The calculated UTM
coordinates are displayed in the Northing and Easting edit boxes. The UTM Zone number
is also displayed.
Step 4. If your control points are defined using latitude and longitude and need to be
converted to a UTM coordinate system, then click the “Convert Control Points to UTM”
button to convert. Once the control points are converted, you can apply them when
exporting your vector data.
The following steps are used to convert a point from a UTM coordinate to
latitude/longitude:
Step 1. Select the reference ellipsoid from the geodetic datum list.
Step 2. Enter the UTM coordinate in the Northing and Easting edit box. UTM
coordinates are in meters.
Step 3. Enter the UTM Zone number. If you are not sure about the UTM Zone, one simple
way to generate it is to enter an approximate latitude and longitude value and click the
“LL to UTM” button to calculate.
Step 4. Click the “UTM to LL” button to do the conversion. The calculated geography
coordinates are displayed in the Latitude and Longitude edit boxes. Latitude and
longitude are in decimal degrees.
Step 5. If your control points are defined using a UTM coordinate system and need to be
converted to latitude and longitude, then click the “Convert Control Points to LL” button
to convert. Once the control points are converted, you can apply them when exporting
your vector data.
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3.10.2 State Plane and Latitude/Longitude…command (Geo-Coord
Convert submenu)
This command converts coordinates between a State Plane coordinate system and the
geography coordinate system (latitude/longitude). The State Plane Coordinate
Conversion dialog box appears when this command is selected (See Figure).

The following steps are used to convert a point from latitude/longitude to a State
Plane coordinate:
Step 1. Select the correct State Plane and the zone number. The state plane name is
displayed in the list with the zone number following the name. Check NAD27 if you are
using NAD1927 or NAD83 if you are using NAD1983.
Step 2. Enter the Latitude and Longitude values in the edit boxes. The latitude and
longitude are in decimal degrees. East Longitudes are positive and west longitudes are
negative. North latitudes are positive and south latitudes are negative.
Step 3. Click the “LL to SPL” button to do the conversion. The calculated State Plane
coordinates are displayed in the Northing and Easting edit boxes.
Step 4. If your control points are defined using latitude and longitude and need to be
converted to a State Plane coordinate system, then click the “Convert Control Points to
SPL” button to convert. Once the control points are converted, you can apply them when
exporting your vector data.
The following steps are used to convert a point from a State Plane coordinate system
to latitude/longitude:
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Step 1. Select the correct State Plane and the zone number. The state plane name is
displayed in the list with the zone number following the name. Check NAD27 if you are
using NAD1927 or NAD83 if you are using NAD1983.
Step 2. Enter your State Plane coordinates in the Northing and Easting boxes. State Plane
coordinates are in meters.
Step 3. Click the “SPL to LL” button to do the conversion. The calculated geography
coordinates are displayed in the Latitude and Longitude edit boxes. Latitude and
longitude are in decimal degrees.
Step 4. If your control points are defined using a state plane coordinate system and need
to be converted to latitude and longitude, then click the “Convert Control Points to LL”
button to convert. Once the control points are converted, you can apply them when
exporting your vector data.

3.11 Delaunay Triangulation…command (Edit Menu)
This command calculates the Delaunay Triangulation using currently specified control
points. The entire image or vector space is divided into individual triangles and each
triangle provides a linear transformation based on the control points on its three vertexes.
The Delaunay Triangulation method is used in the Image/Warp command, when mapping
vector data to a user specified projection system, such as UTM or Latitude/Longitude,
and when exporting vector data using the File/Export Vector command.
The display of triangulation can
View/Overlay/Triangulation command.
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3.12 Text Block Editor (Edit Menu)
Use the Text Block Editor On/Off command to start the Text Block Editor. With the text
block and OCR editor, you can quickly remove vectorized text from the vector data set,
add and remove text block markers, group and ungroup text blocks for words, and train
and test the OCR engine.
The OCR engine can be trained only when text blocks exist. Text blocks can be
automatically detected using the Vector/Detect Text Blocks command or manually using
the Add Block function under the Text Block Editor.
The Text Block Editor options are:
Delete
Lines
Delete All

Text Delete vectorized text lines within a text block.

Undelete

Delete all vectorized text lines within the text blocks in the
entire image or a selected region.
Undelete or recover deleted lines.

Add Block

Add new text blocks.

Remove Block

Remove existing text blocks.

Group

Link individual text blocks into a word or string group.

Ungroup

Unlink text blocks from a word or string group.

Train OCR

Train OCR signatures using existing text blocks.

Test OCR

Test current OCR signatures.

Done

Exit from the Text Block Editor.

3.12.1 Delete Text Lines…command (Text Block Editor submenu)
This command switches to the Delete Text Lines editing mode that allows you to delete
all vectorized text lines within a detected text block.
The cursor will change to a Delete Cursor. Point the cursor within a red box (text block
marker) and click the left mouse button. All vectorized lines within the box will be
deleted. Repeat this step to delete other text lines located within text blocks.
When lines are deleted incorrectly, you can use the Undelete command under the Text
Block Editor to recover.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
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You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.2 Delete All…command (Text Block Editor submenu)
Use this command to Delete All vectorized text lines located within text blocks in the
entire image or within a selected region if a selection rectangle exists.
When lines are deleted incorrectly, you can use the Undelete command under the Text
Block Editor to recover.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.3 Undelete…command (Text Block Editor submenu)
Use this command to recover deleted text lines during the same editing session. Repeat
this command to recover more lines if available.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.4 Add Block…command (Text Block Editor submenu)
This command switches to the Add Block editing mode that allows you to add new text
blocks. Text blocks are used for vectorized text line editing, OCR signature training, and
OCR text recognition functions.
The cursor will change to a Cross Cursor during this editing session. Point the cursor at
the upper-left corner where you want to place a text block, click and hold down the left
mouse button, and move to the lower-right corner. Once you reach the correct size for the
text block, release the left mouse button. A red box (text block marker) will be displayed.
Repeat this process to add more text blocks.
Use the Remove Block command under the Text Block Editor to delete an existing text
block.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
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You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.5 Remove Block…command (Text Block Editor submenu)
This command switches to the Remove Block editing mode that allows you to remove
existing text blocks. This command removes only the text block markers and has no
effect on the vectorized lines or other data.
The cursor will change to a Delete Cursor. Point the cursor within a red box (text area
marker) and click the left mouse button. The marker will disappear from the display
window. Repeat this step to delete other text lines.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.6 Group…command (Text Block Editor submenu)
This command switches to the Group editing mode that allows you to link individual text
blocks into a word or text string group. Text blocks within the same group are displayed
with a line connecting the centers of the text blocks. Grouping indicates that individual
characters belong to a word or individual number digits belong to a number and is
important for the accuracy of the OCR functions, such as Vector/Convert to Text Notes
(OCR).
When using the Vector/Detect Text Blocks function, individual text blocks are grouped
automatically based on their locations. Careful examination and correcting of errors are
necessary before you can apply the Vector/Convert to Text Notes (OCR) command to get
text notes.
The cursor will change to a Cross Cursor. Point the cursor within the first text block to be
grouped, press and hold down the left mouse button, drag the cursor to the last text block,
and then release the left mouse button. The grouped text blocks will then be linked with a
red line from center to center. Repeat this process to group other text blocks.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.
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3.12.7 Ungroup command (Text Block Editor submenu)
This command switches to the Ungroup editing mode that allows you to unlink grouped
text blocks. Text blocks within the same group are displayed with a line connecting the
centers of the text blocks. Grouping indicates that individual characters belong to a word
or individual number digits belong to a number and is important for the accuracy of the
OCR functions, such as Vector/Convert to Text Notes (OCR).
When using the Vector/Detect Text Blocks function, individual text blocks are grouped
automatically based on their locations. Careful examination and correcting of errors are
necessary before you can apply the Vector/Convert to Text Notes (OCR) command to get
text notes.
The cursor will change to a Cross Cursor. Point the cursor within the first text block to be
ungrouped, press and hold down the left mouse button, drag the cursor to the last text
block, and then release the left mouse button. The text blocks will then be displayed as
individuals without the red lines connecting them from center to center. Repeat this
process to ungroup other text blocks.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.8 Train OCR…command (Text Block Editor submenu)
This command switches to the Train OCR interactive training mode that allows you to
generate OCR symbol signatures to be used to recognize text in the scanned image. Text
blocks must exist before the training starts. Text blocks are generated automatically using
the Vector/Detect Text Blocks function. For each character (a to z, A to Z, etc.) or
number digit (0 - 9) or symbols from another language, you need to train it at least once
to have a signature. Multiple signatures for the same character are recommended when
fonts and styles vary in a scanned image. Use the Train OCR command to generate
signatures for all the characters and digits to be recognized.
The cursor is changed to a Cross Cursor during
the training session. Point the cursor at a text
block that includes a clear and typical character
image and click the left mouse button. The OCR
Training Dialog box appears to allow the
entering of the code of the symbol. Repeat this
process to train other characters.
To view and edit the current set of OCR signatures, use the Edit/OCR Signatures
command.
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To see how the generated OCR signatures perform, switch to the Test OCR mode under
the Text Block Editor.
One single map or drawing may have text in different sizes, fonts and styles. It is best to
generate separate sets of OCR signatures for each type of text style and perform OCR
functions on each type of text separately.
If numerical text will be used to label the vectorized lines, these numbers should be
grouped with number digits. No other characters or symbols should be grouped with them
because numbers are converted from text string to numerical value directly.
Signatures can be saved to an OCR signature file (*.ocr) using the File/ OCR and
Text/Save OCR File command or the Edit/OCR Signatures command. Signatures can be
read back from an OCR file using the File/OCR and Text/Load OCR File command or
the Edit/OCR Signatures command.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.12.9 Test OCR…command (Text Block Editor submenu)
This command switches to the Test OCR mode that helps to check the accuracy of the
current OCR signatures.
The cursor is changed to a Cross Cursor during the testing session. Point the cursor at a
text block and click the left mouse button. The detected symbol code, such as A, B... or 0,
1, 2..., is displayed in the Status Bar at the bottom of the IMAGE WINDOW.
If some characters cannot be identified correctly, you should remove the existing
signatures for this character and retrain it. Multiple signatures for the character may be
needed.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Block Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.
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3.13 OCR Signatures...command (Edit Menu)
When the OCR Signatures command is selected the OCR Signature dialog box appears
(See Figure). The dialog box shows the list of current OCR signatures and provides
options to remove, save, and load other OCR signatures.
Some description about the current signature set
can be entered in the notes area. The notes are
kept when the signatures are saved to an OCR
file (*.ocr).

3.14 Delete Text
command (Edit Menu)

Blocks…

Use this command to remove all text block
markers (red boxes) in the entire image or a
selected region if a selection rectangle exists.
This command removes only the markers and
has no effect on the vectorized lines or other
data.
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3.15 Text Notes Editor (Edit Menu)
Use the Text Notes Editor On/Off command to start the Text Notes Editor. With the Text
Note Editor, you can add new text note
items, delete text note items, or modify
existing ones. When the tool starts, a Note
Dialog box appears for entering or
modifying text. Closing the Text Note
Editor or changing to a different editing
tool will automatically close this dialog
box.

The Text Notes Editor options are:

Modify

Add new text notes into the “current”
layer.
Delete existing text notes and delete
notes in a region if selected.
Modify the text of an existing text note.

Move

Move text note to a new location.

Rotate

Rotate text note to a new angle.

Set Layer

Put a text note into the “current” layer.

Done

Exit from the Text Block Editor.

Add
Delete

3.15.1 Add…command (Text Notes Editor submenu)
This command switches to the Add editing mode that allows you to add new text notes.
The cursor will change to a Cross Cursor during this editing session. Point the cursor at
the upper-left corner where you want to place a text note, press and hold down the left
mouse button, and move to the lower-right corner. Once you reach the correct size for the
text note, release the left mouse button. The cursor or window focus is moved to the Note
Dialog box to allow you to enter the text. Click the “Apply” button to confirm the text
note. The added text note will be displayed in the IMAGE WINDOW. Repeat this
process to add more text notes or text labels.
Use the Delete option under the Text Notes Editor to delete an existing text note.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
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You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.15.2 Delete…command (Text Notes Editor submenu)
This command switches to the Delete editing mode that allows you to remove existing
text notes.
The cursor will change to a Delete Cursor. To remove a single text note, point the cursor
within a text note and click the left mouse button. The text note will disappear from the
display window. Repeat this step to delete other text notes.
To remove all text notes within a rectangle region, hold down the SHIFT key and the left
mouse button and drag the mouse to draw a rectangle. When the region is selected,
release both the SHIFT key and the left mouse button. Select the Delete option again from
the floating pop-up menu using the right mouse button or from Text Notes Editor
submenu.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.15.3 Modify…command (Text Notes Editor submenu)
This command switches to the Modify editing mode that allows changing the text of an
existing text note.
The cursor will change to a Cross Cursor during this editing session. Point the cursor
within a text note and click the left mouse button. The cursor or window focus is moved
to the Note Dialog box to allow you to modify the text. Click the “Apply” button to
confirm. The updated text note will be displayed in the IMAGE WINDOW. Repeat this
process to modify other text notes or text labels.
Use the Delete option under the Text Notes Editor to delete an existing text note or use
the Add option under the Text Notes Editor to add a new text note.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.
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3.15.4 Move…command (Text Notes Editor submenu)
This command switches to the Move editing mode that allows you to move a text note to
a new location.
The cursor will change to a Move Cursor during this editing session. Point the cursor
close to the center of a text note, press down the left mouse button, and drag the text note
to a new location. Repeat this process to move other text notes or text labels.
Use the Delete option under the Text Notes Editor to delete an existing text note or use
the Add option under the Text Notes Editor to add a new text note.
To adjust the orientation, switch to the Rotate mode under the Text Notes Editor.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.15.5 Rotate…command (Text Notes Editor submenu)
This command switches to the Rotate editing mode that allows you to adjust the
orientation of a text note.
The cursor will change to a Move Cursor during this editing session. Point the cursor
close to a text note, press down the left mouse button, and drag to set the orientation.
Repeat this process to adjust other text notes or text labels.
Use the Delete option under the Text Notes Editor to delete an existing text note or use
the Add option under the Text Notes Editor to add a new text note.
To adjust the orientation, switch to the Move mode under the Text Notes Editor.
You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.15.6 Set Layer…command (Text Notes Editor submenu)
This command switches to the Set Layer editing mode that allows you to put a text note
into the “current” layer. First set the “current” layer to the correct layer you want to put
data into. Then move the mouse cursor to a text note and click the left mouse button
within the rectangle to select it into the “current” layer.
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You can switch to another editing session by selecting a different option from the floating
pop-up menu brought up by pressing the right mouse button.
You can terminate the Text Notes Editor by selecting the Done option from the floating
pop-up menu brought up by pressing the right mouse button.

3.16 Attribute File (SDL)…command (Edit Menu)
This command starts a text editor to edit an SDA (SDL attribute) file. A MapGuide SDL
file is an ASCII type file that has attribute data, such as Name, ID, and Internet URL,
associated with each vector data item (lines, points, polygons).
When opening an SDL file in R2V, the attribute data are saved to an attribute file, with
the same file name but with an SDA extension (*.sda). This file keeps the Name, ID, and
URL for each spatial data item. The vector data items (lines, polygons, and points) and
their ID values can be edited directly using R2V’s vector editors. The attribute data are
edited separately using a text editor and merged back when exporting the vector data to
an SDL file format.
The SDA file is a simple ASCII text file, which can be created easily using a text editor.
The following example describes the format (comments in the brackets are not included
in the file):
ABLE SOFTWARE ATTRIBUTE FILE (tag to validate the file type)
ID1 (numerical ID for vector data items)
NAME1 (text string, for name)
URL1 (Internet URL)
ID2
NAME2
URL2
ID3
NAME3
URL3
...
IDn
NAMEn
URLn
END (indicates the end of the file)

3.17 Undo/Can't Undo…command (Edit Menu)
The Undo command is only supported by a limited number of operations, such as the
Line Editor and the Point Editor operations.
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Use this command to reverse the last editing action, if supported.
Shortcuts
Keys:

CTRL-Z or
ALT- BACKSPACE (←)

3.18 Image Editor (Edit Menu)
This is the same as the Image Pixel Tool under the Image menu. See Section 5.5 Image
Pixel Tool (Image Menu) for specific command information.
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Chapter

4
View Menu Commands
Control the display of data layers, zoom in and out in an IMAGE WINDOW, toggle
on and off graphics, adjust image contrast, and switch the display in geo-coded coordinate
system on and off.
The View menu offers the following commands:
View Bar

Shows or hides the View Bar.

Tool Bar

Shows or hides the Tool Bar.

Status Bar

Shows or hides the Status Bar.

Birds Eye Window

Shows or hides the BIRDS EYE WINDOW.

Zoom In

Zoom Out

Zooms in a selected image region. Hold the left mouse
button to drag a selection rectangle and then use this
command to zoom in.
Zooms out a level to see a larger portion of the image.

Pan Tool

Moves around the image window.

Full View

Zooms out to fit the image into the current display
window.
Switches back to the previous view location.

Previous View
Overlay

Overlay/Lines

Toggles on and off the display of all available data
layers
Toggles the display of selected image region of interest
(ROI).
Toggles the display of extracted lines.

Overlay/Line Nodes

Toggles the display of line node markers.

Overlay/Image ROI

Overlay/User Color for Toggles the user color for line nodes display on and off.
Nodes
Overlay/Line Ends

Toggles the display of line end point markers.
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Overlay/User Color for Toggles the user color for line ends display on and off.
Ends
Overlay/Line IDs

Toggles the display of line IDs.

Overlay/Points

Toggles the display of the point layer.

Overlay/Point IDs

Toggles the display of point IDs.

Overlay/Control Points

Toggles the display of user selected control points.

Overlay/Control Point IDs

Toggles the display of control point IDs.

Overlay/Triangulation

Toggles the display of Delaunay Triangulation.

Overlay/Text Blocks

Toggles the display of text block markers.

Overlay/Text Notes

Toggles the display of text notes.

Overlay/Text Note Boxes

Toggles the display of text note boxes.

Overlay/Intersection
Symbols

Toggles the display of detected intersection symbol
markers.

Resize Workspace

Changes the size of a workspace for vector data display,
editing and merging. It is only available when no image
is present in the IMAGE WINDOW.
Switches the current cursor position display between the
image pixel coordinate system and the geo-coded image
coordinate system. It is enabled when control points are
specified or TFW parameters are available.
Turns on paper space coordinate display. It is available
when image resolution (dpi) parameters are defined.

Geo-Coded Coordinates

Paper Space Coordinates
Image Contrast...
Image Palette...
Set Image Color

Adjusts the display contrast of the current image. This
function is used for grayscale images only.
Displays and modifies the current image palette.

Set Node Color

Defines the foreground and background display colors
for a binary image.
Applies the layer colors to all data items within the
layer.
Sets the display colors for all lines in the “current”
layer using ID values.
Sets a user-specified color for the display of line nodes.

Set End Color

Sets a user-specified color for the display of line ends.

Fill Polygons

Toggles the polygon fill mode on and off.

Set Point Color by ID

Sets the display colors for all points in the “current”
layer using ID values.

Use Layer Color
Set Line Color by ID

95

V I E W

M E N U

C O M M A N D S

Font for Line IDs

Defines the font and size for the line ID display.

Font for Point IDs

Defines the font and size for the point ID display.

Font for Text Notes

Defines the font and size for the text note display.

4.1 Toolbars (View Menu)
4.1.1 View Bar…command (Toolbars submenu)
Use this command to display and hide the View Bar. The View Bar includes buttons for
some of the most common commands for opening and saving files, displaying layer
controls, and image zoom in and zoom out. Move your mouse to a toolbar button and
stay there for a few seconds to see the tool tip. The tool tip tells what command is
associated with the button (See Figure).

A check mark appears next to the menu item when the View Bar is displayed.

4.1.2 Tool Bar…command (Toolbars submenu)
Use this command to display and hide the Tool Bar. The Tool Bar includes buttons for
some of the most common commands for editing vector lines, points, control points, and
other data layers. Move your mouse to a toolbar button and stay there for few seconds to
see the tool tip. The tool tip tells what command is associated with the button (See
Figure).

A check mark appears next to the menu item when the Tool Bar is displayed.
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4.1.3 Status Bar…command (Toolbars submenu)
Use this command to display and hide the Status Bar. The Status Bar describes the action
to be executed by the selected menu item or pressed toolbar button, and the keyboard
latch state.
A check mark appears next to the menu item when the Status Bar is displayed.

The current image coordinates of the cursor location are displayed in the Status Bar.
Status Bar

The Status Bar is displayed at the bottom of the R2V IMAGE WINDOW. To display or
hide the Status Bar, use the Toolbars/Status Bar command in the View menu.
The left area of the Status Bar describes actions of menu items as you navigate through
menu commands. This area similarly shows messages that describe the actions of toolbar
buttons as you depress them, before releasing them. If after viewing the description of
the toolbar button command you wish not to execute the command, then release the
mouse button while the pointer is off the toolbar button.
The right area of the Status Bar indicates which of the following keys are latched down:
Indicator
CAP

Description
The Caps Lock key is latched down.

NUM

The Num Lock key is latched down.

SCRL

The Scroll Lock key is latched down.
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4.2 Birds Eye Window…command (View Menu)
Use this command to show or hide the BIRDS EYE WINDOW. The BIRDS EYE
WINDOW helps you to view the entire raster image and the current display location
visible in the IMAGE WINDOW. Each raster IMAGE WINDOW has one BIRDS EYE
WINDOW, where a rectangle is shown to indicate the position and size of the IMAGE
WINDOW relative to the entire image (See Figure).
When the raster image is scrolled, zoomed in, or zoomed out
in the IMAGE WINDOW, the position and size of the
rectangle in the BIRDS EYE WINDOW will update
accordingly. To scroll the raster image to a desired position
using the BIRDS EYE WINDOW quickly, you can move the
mouse to the BIRDS EYE WINDOW and drag the rectangle to
the desired position. The IMAGE WINDOW will scroll to the
specified location automatically.
When image data is changed by some image processing functions, toggling the BIRDS
EYE WINDOW off and on again can refresh the display.

4.3 Zoom commands (View Menu)
4.3.1 Zoom In…command (View Menu)
To zoom in on an image area, hold the left mouse button to drag a selection rectangle in
the IMAGE WINDOW and then use the Zoom In command to display the zoomed
region. When the cursor is not an arrow, the selection is not directly available because it
is currently in an editing session, such as the Line Editor or the Point Editor. To get a
selection rectangle during an editing session, hold the SHIFT key down and use the left
mouse button to drag a selection rectangle in the IMAGE WINDOW.
If no selection rectangle is present, the area around the current cursor location is zoomed.
When in the Zoom In mode, you can use the ARROW keys to move around the image.
Shortcuts
Keys:

F2

4.3.2 Zoom Out…command (View Menu)
This command will zoom out the current IMAGE WINDOW to a lower level to display a
larger image area.
Shortcuts
Keys:

F3
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4.4 Pan Tool…command (View Menu)
Use the Pan Tool to move around within the image window.
Once the tool is selected, you can hold down the left mouse button to move the image
within the window.

4.5 Full View and Previous View commands (View Menu)
Use Full View command to display the entire image in the IMAGE WINDOW. The
IMAGE WINDOW will be resized to adjust to the image aspect ratio.
Shortcuts
Keys:

F5

Use Previous View command to display the previous view location in the IMAGE
WINDOW.
Shortcuts
Keys:

F6

4.6 Overlay (View Menu)
The View/Overlay submenu provides controls to toggle the display on and off for all
available data layers, including image data, vector data, points, text, control points, and
other data items. The controls affect the display only. A data layer, for example, the
image, is not removed or changed when its display is turned off using the
View/Overlay/Image option. When an overlay item is checked under the menu, it means
the display is on whether there is data or not.
The Overlay options are:
Image

Toggles the display of the background image.

Image ROI

Toggles the display of selected image region of interest
(ROI).

Lines

Toggles the display of extracted lines.

Line Nodes

Toggles the display of line node markers.

User Color for Nodes

Toggles the user-specified color for line nodes display
on and off.
Toggles the display of line end point markers.
Toggles the user-specified color for line ends display on
and off.
Toggles the display of line IDs.

Line Ends
User Color for Ends
Line IDs

99

V I E W

M E N U

C O M M A N D S

Points

Toggles the display of the point layer.

Point IDs

Toggles the display of point IDs.

Control Points

Toggles the display of user selected control points.

Control Point IDs

Toggles the display of control point IDs.

Triangulation

Toggles the display of Delaunay Triangulation.

Text Blocks

Toggles the display of text block markers.

Text Notes

Toggles the display of text notes.

Text Note Boxes

Toggles the display of text note boxes.

Intersection Symbols

Toggles the display of detected intersection symbol
markers.

4.6.1 Image…command (Overlay submenu)
This command toggles the display of the background image. This option is for display
only and will not affect any data or processing.
The menu item is checked when the image is displayed.
The menu item is grayed out if the image data is not available in the current session.

4.6.2 Image ROI command (Overlay submenu)
This command toggles the display of a selected image region of interest. This option is
for display only and will not affect any data or processing.
The menu item is checked when the image ROI is displayed.
The menu item is grayed out if the image data is not available in the current session.

4.6.3 Lines…command (Overlay submenu)
This command toggles the display of extracted lines. This option is for display only and
will not affect any data or processing.
The menu item is checked when lines are displayed.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.4 Line Nodes…command (Overlay submenu)
This command toggles the display of node markers for all of the existing lines. This
option is for display only and will not affect any data or processing.
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The menu item is checked when line node markers are displayed.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.5 User Color for Nodes…command (Overlay submenu)
This command toggles a user-defined color for line nodes on and off. This option is for
display only and will not affect any data or processing.
By default, line nodes are displayed using the line color. The menu item is checked when
a user defined color is used.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.6 Line Ends…command (Overlay submenu)
This command toggles the display of end point markers for all of the existing lines. This
option is for display only and will not affect any data or processing. The ends display the
order of the nodes going from a circle to an arrow.
The menu item is selected when line end point markers are displayed.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.7 User Color for Ends…command (Overlay submenu)
This command toggles a user-defined color for line ends on and off. This option is for
display only and will not affect any data or processing.
By default, line ends are displayed using the line color. The menu item is checked when a
user defined color is used.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.8 Line IDs…command (Overlay submenu)
This command toggles on and off the display of line ID values for all of the existing
lines. This option is often used during the line labeling process. Use the View/Fonts/
Fonts for Line IDs command to change the font type and size.
The menu item is checked when the line ID values are displayed.
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The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.9 Line Width…command (Overlay submenu)
This command toggles on and off the use of line width detected from the vectorization
process. If it is checked, the detected line width is used in the display. If not, the width
defined by the layer is used for display.
Lines with different width can be selected into different layers using the “Vector/Select
Lines By Width” command.
The menu item is grayed out if the image is not yet vectorized or no line data is available
in the current session.

4.6.10 Points…command (Overlay submenu)
This command toggles on and off the display of the point feature layer. This option is for
display only and will not affect any data or processing.
The menu item is checked when the point data is displayed.
The menu item is grayed out if the point data is not available in the current session.

4.6.11 Point IDs…command (Overlay submenu)
This command toggles on and off the display of the ID value of all points. This option is
often used during the point labeling process. Use the View/Fonts/Font for Point IDs
command to change the font type and size.
The menu item is checked when point IDs are displayed.
The menu item is grayed out if the point data is not available in the current session.

4.6.12 Control Points…command (Overlay submenu)
This command toggles on and off the display of control point markers for all user
selected control points. This option is for display only and will not affect any data or
processing.
The menu item is checked when control point markers are displayed.
The menu item is grayed out if control point data is not available in the current session.
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4.6.13 Control Point IDs…command (Overlay submenu)
This command toggles the display of control point IDs on and off. This option is for
display only and will not affect any data or processing.
The menu item is checked when control point IDs are displayed.
The menu item is grayed out if control point data is not available in the current session.

4.6.14 Triangulation…command (Overlay submenu)
This command toggles the display of Delaunay Triangulation on and off. The display
shows how Delaunay Triangulation is calculated using the currently defined control
points. Delaunay Triangulation is used to generate the mathematical transformation for
exporting vector data to a user specified projection system and for image warping or
registration. Delaunay Triangulation is calculated using the Edit/Delaunay Triangulate
command. The Overlay/Triangulation option is for display only and will not affect any
data or processing.
The menu item is checked when triangulation is displayed.
The menu item is grayed out if triangulation has not been calculated for the current
session.

4.6.15 Text Blocks…command (Overlay submenu)
This command toggles the display of text block markers (red boxes) on and off. Text
block markers are detected using the Vector/Detect Text Blocks command. This option is
for display only and will not affect any data or processing. Text blocks can also be
generated or edited using the Text Block Editor .
The menu item is checked when text block markers are displayed.
The menu item is grayed out if no text blocks are available for the current session.

4.6.16 Text Notes…command (Overlay submenu)
This command toggles on and off the display of text notes detected using the
Vector/Convert to Text Notes(OCR) command. This option is for display only and will
not affect any data or processing. Text notes can also be generated using the Text Notes
Editor.
The menu item is checked when text notes are displayed.
The menu item is grayed out if no text notes are available in the current session.
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4.6.17 Text Note Boxes…command (Overlay submenu)
This command toggles on and off the display of text note boxes. This option is for
display only and will not affect any data or processing. Text note boxes can be edited
using the Text Notes Editor.
The menu item is checked when text note boxes are displayed. The menu item is grayed
out if no text note boxes are available in the current session.

4.6.18 Intersection Symbols…command (Overlay submenu)
This command toggles on and off the display of detected intersection symbol markers.
Intersection symbol markers are detected using the Vector/Detect Intersection Symbols
command. This option is for display only and will not affect any data or processing.
Intersection symbols can be physically removed using the Vector/Remove Intersection
Markers command.
The menu item is checked when intersection symbol markers are displayed.
The menu item is grayed out if no intersection symbols are available in the current
session.

4.7 Resize Workspace…command (View Menu)
Use this command to change the size of
the current workspace. This command is
only available when no image is present
in the IMAGE WINDOW. The
workspace is normally created using the
File/New Workspace command.
When using a non-image workspace for
vector editing and merging, you can
change the four size parameters (left,
top, right, and bottom) to adjust the
display area of the current workspace (See Figure).

4.8 Geo-Coded Coordinates...command (View Menu)
This command is used to switch the display of the current mouse pointer coordinates
between "geo-coded" coordinates (with control points or TFW data applied) and image
pixel coordinates (without using control point or TFW data). This function makes it
convenient when editing geo-coded data or viewing images under a real world coordinate
system.
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This command is enabled only when control points are defined or TFW parameters are
available. To define control points, use the Edit/Control Point Editor or the Vector/Select
Control Points commands. To read TFW parameters from a TFW file or control points
from a control point file, use the File/Load Control Points/TFW command.
Please note, the image itself is not physically changed in any way, instead, only the
coordinate display of location is recalculated.

4.9 Paper Space Coordinates...command (View Menu)
This command is used to turn on the paper space coordinate display.
While in this display mode, cursor locations are calibrated using the image scanning
resolution (dots per inch or centimeter). Distance measurements are also calibrated using
the paper unit and vector lines are displayed using their defined line width or thickness.
This command is enabled when an image and its scanning resolution parameters are
available. You can use the Image/Information to define or change the image resolution
parameters.
Please note, the image itself is not physically changed in any way, instead, only the
coordinate display of location is recalculated based on the image resolution.

4.10 Image Contrast...command (View Menu)
This command will display the Image Contrast dialog box to allow adjustment of the
image contrast used for display (See Figure). This command
is only used for grayscale images. To increase or decrease
the bright range image pixels, adjust the scroll bar for the
bright range. Adjust the dark range scroll bar if the dark
range pixels need to be adjusted. The pixel gray levels
between the lower threshold (dark) and the upper threshold
(bright) will be displayed using the full dynamic range of
the display device.
The Image Contrast dialog box allows the user to
interactively adjust the contrast of the image display. You
can adjust the gray level thresholds for both the lower and
upper limits. The gray levels between the two thresholds are
displayed using the full display dynamic range, for example,
256 levels on an 8-bit display device.
Note: This command does not change the raw image pixel values; it only affects the
display.
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4.11 Image Palette...command (View Menu)
This command displays
the currently used image
palette. The Image Palette
command allows you to
modify the colors and use
different
palettes
for
display. This command
affects only the display
and not the image data.
When the Define Color
Palette
dialog
box
appears, the color palette
is displayed. Hold down
the left mouse button and
drag to draw rectangle to
select colors for change.
Once the color entries are
selected, click the “Pick Color” button to pick a new color that will be assigned to all of
the selected colors.
Click the “Apply” button to use the defined palette for the current image display.
Click the “Save Palette” button to save the palette entries to a file and click the “Open
Palette” button to read palette entries from a file.
Click the “Reset” button to change the palette to the original image palette.

4.12 Set Image Color...command (View Menu)
This command is used to change both the foreground
and the background colors used to display a binary or
monochrome image. After this command is selected, the
Set Image Colors dialog box will appear to allow you
to specify the colors for the image display (See Figure).
If you click on the “Foreground” or the “Background”
buttons a Color dialog box will appear where you can
select the desired color for the display (See Figure).
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This command only works with binary or monochrome images and will only affect the
display. The image data is not changed.
For other image types, such as grayscale and
color, you can convert them to binary image type
first and then apply the View/Set Image Color
command if you need have a specific type of
display for an image.

4.13 Line Colors (View Menu)
4.13.1 Use Layer Color...command
(Line Colors submenu)
Use this command to apply the colors defined for
each layer to display vector data within those
layers. The color of a layer can be defined using
the Edit/Layer Define command. When the Use
Layer Color command is selected, the Set Vector
Display Colors By Layer dialog box appears (See Figure).
If you need to apply colors to all active data items, then make sure the data types are all
selected.
Select the Current Layer Only option if
you only want to apply color to the data
items in the “current” layer.
Select the All Layers Except Current
Layer option to apply colors to all other
layers except the “current” layer.
Select the All Layers option to apply
colors to all layers.
If vectors are displayed with colors defined using other command, such as View/Line
Colors/Set Line Color By ID the use of this command will reset the color of the lines
based on their layer color definitions. If the colors need to be changed to another scheme,
then use the corresponding command, such as View/Line Colors/Set Line Color By ID
again.
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4.13.2 Set Line Color By ID…command (Line Colors submenu)
This command defines a color for lines within the specified ID range. This command can
be used to display vector layers using different colors when lines are labeled by different
ID values. Lines can be labeled using the Line Editor under the Edit menu.
This command only changes the colors of lines within the “current” layer. To change
colors for other layers, simply set a layer as “current” and then apply this command
again.
This command is often used to make vector data more visible when manipulating lines
using a color image as the backdrop.
This command is useful to help identify if lines or contours are labeled correctly. Before
you start the labeling process, use this command to define the color scheme based on the
ID range you want to apply to the lines. Once the colors are defined, you can start the
labeling process using the Edit/Line Editor/Assign Line ID command. When a line is
labeled or has an ID value, the color will update to the color specified (the line must be in
the “current” layer).

4.13.3 Set Node Color...command (Line Colors submenu)
This command allows you to select a user-defined color for the line nodes display. By
default, line nodes are displayed with the same color as the lines. This command defines
a different color so nodes can be viewed more easily. When the Set Node Color
command is selected a Color dialog box will appear so you can specify the desired node
color. Setting the node color different than the line color is especially useful when editing
lines.

4.13.4 Set End Color...command (Line Colors submenu)
This command allows you to select a user-defined color for the line ends display. By
default, line ends are displayed with the same color as the lines. This command defines a
different color so ends can be viewed more easily. When the Set End Color command is
selected a Color dialog box will appear so you can specify the desired end color. Setting
the end color different than the line color is especially useful when editing lines.

4.14 Fill Polygon…command (View Menu)
This command toggles the polygon-filling mode on and off. When the polygon fill mode
is on, all polygons in the active layers will be displayed with their interior filled with a
color and hatch pattern. The color will be the same as the line color, and the hatch pattern
can be defined using the Edit/Layer Define command.
The Fill Polygon command is often used when editing polygons.
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4.15 Set Point Color by ID…command (View Menu)
This command is used to define a color for displaying
points within a certain ID range. Multiple colors can
be defined by specifying groups of point ID values.
When the Set Point Color by ID command is selected,
a Set ID Display Color dialog box will appear (See
Figure). This command only changes the colors of
points within the “current” layer. To change colors
for other layers, simply set a layer as “current” and
then apply this command again.
The color file can be saved for later use or used for
other data sets.

4.16 Fonts (View Menu)
4.16.1 Font for Line IDs...command (Fonts submenu)
This command defines the font and size used for displaying line IDs. The font
information is saved to the project file if one is created. The font is used in later session
when the project file is opened. When the Font for Line IDs command is selected, a Font
dialog box appears
(See Figure).
The menu item is
grayed out if no
lines have been
vectorized.
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4.16.2 Font for Point IDs...command (Fonts submenu)
This command defines the font and size used for displaying point IDs. The font
information is saved to the project file if one is created. The font is used in later session
when the project file is opened. When the Font for Point IDs command is selected, a Font
dialog box appears allowing you to interactively set the font parameters.
The menu item is grayed out if no point data are available.

4.16.3 Font for Text Notes...command (Fonts submenu)
This command defines the font and size used for displaying text notes. The font
information is saved to the project file if one is created. The font is used in later session
when the project file is opened. When the Font for Text Notes command is selected, a
Font dialog box appears allowing you to interactively set the font parameters.
The menu item is grayed out if no text notes are available.
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Chapter

5
Image Menu Commands
Image processing functions used to clean up images prior to vectorization.
The Image menu offers the following commands:
Information
Region of Interest (ROI)

Shows the image parameters, such as data type, dimensions,
and image type.
Defines regions of interest for vectorization and cropping.

Crop Image by ROI

Crops image using defined regions of interest.

Clear All ROIs

Removes all defined regions interest (ROI).

Image Pixel Tool
Vertical Flip

Shows and changes change pixel values. It is used for raster
editing.
Flips the image vertically.

Horizontal Flip

Flips the image horizontally.

Transpose

Transposes the current image or rotates the image 90 degrees.

Check Angle

Checks image skew angle for image rotation.

Rotate

Rotates the current image to a user-defined angle.

Crop Region

Crops a selected image region for processing.

Resize
Warp

Resizes the image with a specified down-sampling or upsampling factor.
Warps or registers the image using selected control points.

Mosaic

Creates an image mosaic from multiple image files.

Merge

Merges another image into the current image to create an
image overlay or mosaic.
Reverses the image.

Negate
Despeckle
Smooth/Median Filter

Despeckles and removes noise from a monochrome or binary
image.
Smoothes the image using a median filter.

112

I M A G E

M E N U

C O M M A N D S

Smooth/Average Filter

Smoothes the image using a 3x3 average filter.

Remove Background

Removes grayscale image background.

Edge Detection/Sobel Filter

Image edge detection using a Sobel filter.

Edge Detection/Gradient
Magnitude

Image edge detection using a gradient magnitude.

Edge Detection/Edge
Propagate
Set Image Threshold...

Propagates image edges.

GrayScale→ 1-bit Bi-Level

Converts an 8-bit grayscale image to a 1-bit bi-level image
using an automatically estimated optimal threshold or a userselected threshold.
Converts a 1-bit Bi-Level image to an 8-bit grayscale image

Sets image threshold interactively for thresholding of
grayscale images when extracting vectors.
Classification...
Automatic image classification for color or multi-spectral
satellite images.
Colorize
Colorize a grayscale image using color or multi-spectral
images. This function is proprietary and often used to create
high-resolution color images using high-resolution grayscale
images and low-resolution multi-spectral images.
Fusion
Creates a RGB color image using 3 individual images
representing the red, green, and blue bands.
Segmentation
Grayscale image area segmentation and boundary line
vectorization. Often used to segment aerial photo images.
24-bit RGB→ 8-bit Palette
Converts a 24-bit RGB true color image to an 8-bit palette
color image.
24-bit RGB→ GrayScale
Converts a 24-bit RGB true color image to an 8-bit grayscale
image.
8-bit Palette→ 24-bit RGB
Converts an 8-bit palette color image to a 24-bit RGB color
image.
8-bit Palette→ GrayScale
Converts an 8-bit palette color image to an 8-bit grayscale
image.
8-bit Palette→ 1-bit Bi-level Converts an 8-bit palette color image to a 1-bit bi-level
monochrome image.
GrayScale → 24-bit RGB
Converts a grayscale image to a 24-bit RGB color image.

1-bit Bi-Level → GrayScale
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5.1 Information…command (Image Menu)
This command displays the parameters associated with the image displayed. When the
Image/Information command is selected, the Image Attributes dialog box will appear
(See Figure).
The parameters include the
Number of Columns (Width),
Number of Rows (Height), Bits
Per Pixel, Number of Planes,
Image Type, Scanning Resolution,
and Resolution Unit.
The Scanning Resolution (Dots
per inch, dpi) and Resolution Unit
(inch, centimeter) can be changed
and
adjusted
using
the
Image/Information command. The
Scanning Resolution and the
Resolution Unit are used for
exporting vector data to DXF
format when the “Paper Space”
option is selected.

5.2 Region of Interest (ROI)…command (Image Menu)
The Region of Interest (ROI) command includes 3 tools for drawing ROIs. You can
draw circular, rectangular, and free form polygon regions for vectorization and image
cropping. Select one of the drawing tools to start: Rectangle, Circle, and Polygon.
R2V supports multiple regions so you can define ROIs as separate areas or area with
islands or holes. When multiple region boundaries are defined, caution must be taken to
assure a region is to be included or excluded.
The parity rule is used to determine if an area is inside the ROI or outside the ROI. It
works like this: count the number of boundaries you encounter from the inside area to the
outside area. If the number is odd, then the area is inside the ROI, if the number is even
the area is outside the ROI.
Once you are in the ROI editing mode, you can use the right mouse button to display the
floating pop-up menu to switch to a different drawing mode. The currently selected
drawing mode is shown with a check mark.
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When in the polygon drawing mode, move the cursor to a position and click the left
mouse button to start drawing. Move to the next position and click the left mouse button
again to confirm the line segment. Repeat this to draw the region. The BACKSPACE (←)
key will undo one step. Hit any key (keyboard key) to close the region.
When in the rectangle drawing mode, move the cursor to a position for the upper-left
corner of the rectangle. Hold down the left mouse button and drag the cursor to a
position where the lower-right corner of the rectangle is. Release the left mouse button
and a rectangle boundary will be created. Repeat this step to add more rectangles.
The circle drawing mode is similar to the rectangle drawing mode. You need to draw the
enclosing rectangle to define the circle. Move the cursor to a position for the upper-left
corner of the rectangle. Hold down the left mouse button and drag the cursor to a
position where the lower-right corner of the rectangle is. Release the left mouse button
and a circle or ellipse boundary will be created based on the bounding rectangle. Repeat
this step to add more circles.
When you are finished, select the Done option from the floating pop-up menu to exit the
Region of Interest (ROI) command.
The newly defined region of interest (ROI) can be removed using the Image/Clear All
ROIs command.
Use the View/Overlay/Image ROI command to toggle the ROI display on and off. Once
the region of interest is used by the vectorization command, it is removed. You can set a
new region of interest by repeating the above steps.

5.3 Crop Image by ROI…command (Image Menu)
This command is used to crop an image using defined regions of interest (ROI). All
image pixels within the regions of interest (ROI) will remain the same in the cropped
image, while the rest of the pixels will be set as the background value, normally white
color. You should save the image to a different file if you plan to use the image and the
extracted vector data together in the future.

5.4 Clear All ROIs (Image Menu)
Use this command to remove the currently defined regions of interest (ROIs).
Use the Image/Region of Interest (ROI) command to define a new region of interest for
image segmentation.
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5.5 Image Pixel Tool (Image Menu)
The Image Pixel Tool On/Off command starts the Image Pixel Tool. The Image Pixel
Tool supports the following options: Show Pixel Value, Draw Pixel Value, Map Pixel
Value, and Fill Color. The options can be selected by
using the main drop down menu or the floating pop-up
menu brought up by clicking the right mouse button (See
Figure).

5.5.1 Show Pixel Value…command (Image
Pixel Tool submenu)
When this command is selected, you can see pixel values by holding down the left mouse
button and moving the cursor to various pixel locations. The image pixel value of the
current cursor position is displayed in the Status Bar at the bottom of the IMAGE
WINDOW. Make sure the Status Bar is visible when using the Image Pixel Tool. The
Status Bar can be toggled on and off by using the View/Toolbars/Status Bar command.

5.5.2 Draw Pixel Value…command (Image Pixel Tool submenu)
The Draw Pixel Value command is used for raster image editing and repairing.
When this command is selected, a Define Pixel Value To Draw dialog box appears (See
Figure). The dialog box allows you to define the Pen Size (in pixels) and the Current
Pixel Value.
Use the Show Pixel Value command to
determine a pixel color value if you are not sure
what color to use. The pen size determines how
large of an area is to be painted.
Once all of the parameters are set properly, you
are ready to draw the selected color into the
image. The Paint Cursor appears in the
IMAGE WINDOW. Move the cursor to a
location where you want to start drawing and
hold down the left mouse button to draw.
Release the left mouse button to stop. Repeat
this process to draw a different image area.
If you need to change the color and pen size, select the Draw Pixel Value command again
from the Image Pixel Tool submenu or the floating pop-up menu brought up by clicking
the right mouse button. The Define Pixel Value To Draw dialog box appears and you
can change the parameters and draw with a new color and pen size. To undo the last
operation, use the Edit/Undo command.
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5.5.3 Draw Line…command (Image Pixel Tool submenu)
The Draw Line command is used to paint straight lines into a raster image.
When this command is selected, a Define Pixel Value To Draw dialog box appears (See
Figure). The dialog box allows you to define the Pen Size (in pixels) and the Current
Pixel Value. The pen will be used for drawing lines in the image.
To draw a line, move the cursor to the starting location and hold down the left mouse
button to draw. A rubber band line will appear when you move the mouse. Once you
reach the ending location of the line, release the left mouse button to confirm. The image
display will be updated with the new line. Repeat this step to draw more lines.
To undo the last operation, use the Edit/Undo command.

5.5.4 Map Pixel Values…command (Image Pixel Tool submenu)
This command maps all pixels within the defined
pixel value range to a new value. When the Map
Pixel Values command is selected, the Map Pixel
Values dialog box appears (See Figure). The
dialog box allows you to specify the Pixel Values
to be Mapped defined by the Minimum (Min) and
Maximum (Max) value and the New Value to be
assigned.
For grayscale images, you can draw a selection
rectangle within an image area to let R2V find the
grayscale range automatically. The values will be
displayed in the Min and Max box and can be
modified if needed.
The Map Pixel Value command is often used for global image pixel editing and removing
undesired colors or pixel values.
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5.5.5 Fill Color…command (Image Pixel Tool submenu)
This command changes the Image
Editor to the fill area mode, which will
flood fill a selected image area with a
user-defined color. When the Fill
Color command is selected, a Define
Pixel Value dialog box appears to
define the pixel value or color to be
used for the area flood fill (See
Figure).
The cursor will be changed to the Area Fill Cursor.
To fill an area, move the cursor to a pixel within the area and click the left mouse button
to start the process. All pixels with the same color in the area will have a new color when
it is done.
To undo the process, use the Edit/Undo command, CONTROL-Z, or select the Undo
command from the floating pop-up menu.
This function is useful for the processing of certain raster images, such as parcel maps or
images with a lot of connected polygons. For example, if you have a 1-bit monochrome
parcel map, you can use the fill area to remove text and other symbols that do not need to
be vectorized. You can also convert the image to a grayscale image using the
Image/Conversion/1-bit Bi-level to Grayscale command, and use the Fill Color command
to change parcel boundaries to a color that is different from the background and the other
lines. Use the Image/Set Image Thresholds command to define the thresholds and then
use the Vector/Auto Vectorize command to vectorize only the boundaries lines. Other
lines will not be processed and a significant amount of editing can be saved when doing
so.
Use the floating pop-up menu or the Image Pixel Tool submenu to change to a different
pixel tool. Select the Done option to exit from the Image Pixel Tool.

5.5.5 Undo…command (Image Pixel Tool submenu)
This command reverses the last operation using Image Pixel Tool, such as Draw Pixel,
Draw Line and Fill Color and restores the affected pixels to their previous colors.
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5.6 Vertical Flip…command (Image Menu)
This command is used to flip the image vertically. The Vertical Flip command changes
the raw image data. You should save the image first if you plan to use the image and the
extracted vector data together in the future.

5.7 Horizontal Flip…command (Image Menu)
This command is used to flip the image horizontally. The Horizontal Flip command
changes the raw image data. You should save the image first if you plan to use the image
and the extracted vector data together in the future.

5.8 Transpose…command (Image Menu)
This command is used to transpose or rotate the image 90 degrees. The Transpose
command changes the raw image data. You should save the image first if you plan to use
the image and the extracted vector data together in the future.

5.9 Check Angle…command (Image Menu)
This command is used to interactively measure image skew angle for image rotation.
After this command is selected, the cursor becomes an Angle Cursor
.
Find a location in the image where rotation is obvious, for example, a horizontal or
vertical line that is tilted. Click the left mouse button on the line and release it to define
the anchor point. Move away from the anchor point and click the left mouse button and
release to define the first line. Move away from the first line, and you will see a second
rubber band line that will form an angle
together with the first line. The second line
should indicate the corrected position of the
first line if the image is rotated. When the
cursor is at the right location, click the left
mouse button and release to confirm the
second line.
An R2V for Windows dialog box will appear to display the angle you have measured
(See Figure). The angle is in degree and can be used for image rotation.
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5.10 Rotate…command (Image Menu)
This command is used to rotate or deskew the image to a user-defined angle. When the
Rotate command is selected, a Rotate Image dialog box appears (See Figure).
If the Angle to Rotate is unknown, use the
Image/Check Angle function to measure the
skew angle. The angle is defined in degrees
within the range of 0 to 360. No decimal
point is used. Select the Turn Left option
when rotating an image counter-clockwise
and select the Turn Right when rotating an
image clockwise. The rotation is performed
around the image center and the white pixels are filled in if rotated outside the current
image range. Some pixels will be lost during this process.
The Rotate command changes the raw image data. You should save the image if you plan
to use the image and the extracted vector data together in the future.

5.11 Crop Region…command (Image Menu)
This command is used to crop a subregion
from the current image. The cropped region
can be used for further processing. To crop
a region, an image region needs to be
defined by holding down the left mouse
button and drawing a selection rectangle.
After the selection rectangle is defined,
select the Crop Region command from the
Image menu.
When the command is
selected, a Define Image Region dialog
box appears to allow you to fine tune or
update the selected region.
Four parameters, Left and Right (in the horizontal or column direction), Top and Bottom
(in the vertical or row direction), are used in this operation. The values are in pixel
coordinate. Click the “OK” button to confirm the cropped region.
The original image file is not affected by the Crop Region command. The subregion
should be saved to a separate image file if vector data is generated using the subregion.
This command is often used to cut off the extra portions from an image to avoid editing
any lines generated from those areas.
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5.12 Resize…command (Image Menu)
This command resizes the image by using an increasing or decreasing resampling factor.
When the Resize command is selected, an Image Resampling dialog box appears (See
Figure).
The image size is either reduced or
enlarged by the specified Re-Sampling
Factor in both the column and row
dimensions. The image type (bi-level,
grayscale or color) remains the same but
the size is different.
Although down-sampling an image can
reduce the total image size significantly,
you should examine the image quality
carefully if the image is going to be
vectorized automatically. Down sampling
can degrade the image quality greatly and
can affect the quality of vector data
generated.
When up sampling an image, you need to watch the new image size as it can grow
significantly. Large images require more computer memory to process and disk space to
store while the vectorization quality may not be improved at all.
The Resize command changes the raw image data. You should save the image if you plan
to use the image and the extracted vector data together in the future.

5.13 Warp…command (Image Menu)
This command is used to register or warp an image using the currently specified control
points based on a target image. When the Warp command is selected, the Image Warp
Dialog box appears (See Figure).
The mathematical transform is generated
using either the Bi-Linear Transform or
the Delaunay Triangulation Transform.
With the Delaunay Triangulation method,
pixels more close to control points are
mapped with a higher accuracy level. If
one area does not appear to be registered
correctly, you may want to add more
control points in that area. The image
space is first triangulated into many triangles and then each triangle provides a linear
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transform using the three vertex control points. The Warp command is often used to
correct image distortion and transform one image to the coordinate system of another, for
example, to register a map and an air photo of the same area.
With the Bi-Linear method, a bi-linear transform derived from the control points is
applied to register the image.
To register an image against a target image, you should first define 4 or more control
points from the target image in the image pixel coordinate system. You can use the Pick
Point command under the Control Point Editor submenu option to pick a location from
the target image and then use the New option under the Control Point Editor to define the
control point for the image to be warped.
Because image warping is performed in the digital image domain and coordinates are
calculated in integer and floating-point projection systems, the Latitude/Longitude
coordinate system, is not suitable for this operation. You may simply register the image
using the Image World File (TFW), rather than physically change the image pixels.
The entire operation is done in memory, so make sure the projected image is not too big
and you have sufficient memory and swap space for the processing.
The image warping process is normally performed before geo-referencing. Image georeferencing is done through generating a world file (TFW supported by Arc/Info or
ArcView) or a TAB file (supported by MapInfo) that maps image pixel coordinates to a
real world coordinate system. If your vector data is geo-referenced using the Delaunay
Triangulation method, you need to make corrections to your image as well so it will
match the vector data on the target system.
The Warp command changes the raw image data. You should save the image if you plan
to use the image and the extracted vector data together in the future.
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5.14 Mosaic…command (Image Menu)
This command is used to create
an image mosaic from multiple
images. After the Mosaic
command is started, an Image
Mosaic Dialog box appears to
allow the entering of mosaic
parameters and image file names
(See Figure).
The Numbers of Images in a
Row and the Number of Rows
defines the layout of the image
mosaic. For example, if you
have 6 images to be merged
together, you plan to have 3
images for each row and have 2
rows, then the number of images
per column is 3 and the number
per row is 2. Use the “Add
Images” button to add image
files to the list. The order of an image in the list determines its location in the final
mosaic.
The images can have different sizes but they must be the same type, for example, a 1-bit
black and white or a 24-bit RGB image. All image types are supported by this command.
If the images are already geo-referenced by a control point file or world file with the
same file name, or saved as a GEOTIFF file, then they can be put together based on their
real world coordinates. Check the box “Images are geo-referenced” to do this. When this
option is checked, the overlap option will not be used.
If your images have overlapped regions, then you can check the “Has Overlap” box, and
define the amount of overlap. The amount of overlap is entered as a percentage to the
sub-image to be used for the mosaic. The overlapped image areas will be used to
calculate image correlation and find the best location for stitching. If images are not
stitched at the correct location, you may need to make the numbers larger for the Left
Overlap and/or the Top Overlap.
Image 1 Image 2 Image 3
If the sub-images don’t have any border overlap, simply
uncheck the “Has Overlap” box so the images will be
stitched together according to the layout matrix without
any image matching.
Image 4 Image 5 Image 6
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The final image mosaic will look like this (See Figure):
If there are distortions in the sub images, you can use the Image/Warp command to
correct them first and then use the Mosaic command.
Once the mosaic image is successfully created, use the File/Save Image As command to
save the new image to a file.

5.15 Merge…command (Image Menu)
The commands under the Merge submenu are used to interactively merge another image
stored in a file to the current image. This creates an image overlay or mosaic. The
process can be repeated to merge multiple images. If your images are in different scales,
you can define control points using the commands under the Control Point Editor. You
can then use the Image/Warp command to register the image first and finally, use the
Image/Crop Region command to remove unneeded regions before merging them.
The following are the steps used to merge two images together:
Step 1. Open the first image using the File/Open Image command.
Step 2. Select Image/Merge/Open Image command. Use the file Open dialog box to
open the image you want to merge with the current image.
Step 3. Once the image is opened, it is displayed on top of the current image. The image
and the overlapped area may look different from the normal display because the second
image is inverted to show the overlap. Hold down the left mouse button to move the
second image to the intended location for the new image and release the left mouse
button to confirm the location.
Step 4. Click the right mouse button to show the Merge options. Select the Paste option
to paste the second image into the first image. If you want to show both images in
transparent mode, select the Fuse option to combine the two images together. Click
Cancel if you want to stop the process.
Step 5. The newly merged image is displayed in the current IMAGE WINDOW. Use the
File/Save Image As command to save it to a new file.
If you need to merge more images, repeat Steps 2 to 4.
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5.16 Negate…command (Image Menu)
This command is used to reverse the image pixel intensity values. For example, if the
image is a 1-bit bi-level image, pixels with a value of 1 will become 0 and pixels with a
value of 0 will become 1 after the Negate operation. This command is only needed when
somehow an image is scanned in reverse. It is necessary to negate an image if it is
reversed because R2V for Windows will only extract black lines.
The Negate command changes the raw image data. You should save the image if you
plan to use the image and the extracted vector data together in the future.

5.17 Despeckle…command (Image Menu)
This command is used to despeckle and remove white and black noise pixels from a
monochrome or binary image. If the Vector/Auto Vectorize command is going to be used
to vectorize a monochrome image, it is highly recommended to run the Despeckle
command at least once to remove noise and speckle from the image. Images with less
speckle or noise points will generate higher quality vector data in the automatic
vectorization process, which will result in less editing.
The Despeckle command works only with binary or monochrome images. Other image
types must be converted to binary or monochrome first if despeckle or noise removal
needs to be done.
The Despeckle command changes the raw image data. You should save the image if you
plan to use the image and the extracted vector data together in the future.

5.18 Smooth (Image Menu)
5.18.1 Average Filter…command (Smooth submenu)
This command is used to smooth the raw image when the image is so noisy that the
automatic vector extraction function is greatly affected. The smoothing function uses an
average filter (3x3) and it can be applied multiple times if needed.
The Smooth/Average Filter command works only with grayscale images. If an image is
in color, you can convert it to grayscale first and then use this command.
The Smooth/Average Filter command changes the raw image data. You should save the
image if you plan to use the image and the extracted vector data together in the future.
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5.18.2 Median Filter…command (Smooth submenu)
This command is used to smooth the raw image when the image is so noisy that the
automatic vector extraction function is greatly affected. The smoothing function uses a
median filter and it can be applied multiple times if needed.
The Smooth/Median Filter command works only with grayscale images. If an image is in
color, you can convert it to grayscale first and then use this command.
The Smooth/Median Filter command changes the raw image data. You should save the
image if you plan to use the image and the extracted vector data together in the future.

5.19 Remove Background…command (Image Menu)
This command is used to remove or clean up grayscale image background caused by old
or dark paper or other factors. When this command is
selected, a Remove Background dialog box appears
where you can enter the Thickness of Foreground
Features (See Figure).
This command enhances the lines and foreground
linear features and improves the vectorization
accuracy when a dark background exists in an image.
The Remove Background command changes the raw
image data. You should save the image if you plan to use the image and the extracted
vector data together in the future.
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5.20 Edge Detection (Image Menu)
5.20.1 Sobel Edge…command (Edge Detection submenu)
This command creates an edge-enhanced image from the original image using a Sobel
edge detector. This command works only with grayscale images. Other image types, such
as color images, must be converted to grayscale before this command can be used.
If the edge-enhanced image is going to be auto-vectorized, it is highly recommended to
first set the image threshold using the Image/Set Image Threshold command (See Section
5.21 Set Image Threshold…command (Image Menu)) . When the threshold is set
properly, make sure the box (Use Existing Threshold) is checked in the Vectorize dialog
box when using the Vector/Auto Vectorize command.
The Sobel Edge command changes the raw image data. You should save the image if
you plan to use the image and the extracted vector data together in the future.

5.20.2 Gradient Magnitude…command (Edge Detection submenu)
This command creates an edge-enhanced image from the original image by calculating
the gradient magnitude image. This command works only with grayscale images. Other
image types, such as color images, must be converted to grayscale before this command
can be used.
If the edge-enhanced image is going to be auto-vectorized, it is highly recommended to
first set the image threshold using the Image/Set Image Threshold command (See Section
5.21 Set Image Threshold…command (Image Menu)). When the threshold is set
properly, make sure the box (Use Existing Threshold) is checked in the Vectorize dialog
box when using the Vector/Auto Vectorize command.
The Gradient Magnitude command changes the raw image data. You should save the
image if you plan to use the image and the extracted vector data together in the future.

5.20.3 Edge Propagate…command (Edge Detection submenu)
This command propagates the edges in an edge-enhanced image to make them thicker .
Edge-enhanced images are created using either the Sobel Edge command or the Gradient
Magnitude command. This command is often used to fill in gaps caused by high
frequency noise or other artifacts before performing vectorization. The way the
propagation works very much depends on the image itself and you may need to repeat
this function several times to get the gaps filled. This command works only with
grayscale images. Other image types, such as color images, must be converted to
grayscale before this command can be used.
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If the edge enhanced image is going to be auto-vectorized, it is highly recommended to
first set the image threshold using the Image/Set Image Threshold command (See Section
5.21 Set Image Threshold…command (Image Menu)). When the threshold is set
properly, make sure the box (Use Existing Threshold) is checked in the Vectorize dialog
box when using the Vector/Auto Vectorize command.
The Edge Propagate command changes the raw image data. You should save the image
if you plan to use the image and the extracted vector data together in the future.

5.21 Set Image Threshold...command (Image Menu)
This command is used to interactively select a grayscale threshold range (low and high
thresholds) to be used by the Vector/Auto Vectorize command. The image threshold is
used for grayscale images and other functions such as tracing and image conversions.
When the Set Image Threshold command is selected, a Set Image Threshold dialog box
appears with two scroll bars showing the Low and High image grayscale thresholds (See
Figure).
Image pixels with grayscale values
between the low and high threshold are
displayed as red and the rest of the image
is displayed as white. Use the scroll bar to
adjust both the low and high threshold
values so only those pixels to be
vectorized are displayed in red color.
If broken lines appear, you can make the threshold range wider. However, it will take a
longer time to vectorize if the lines are too thick or merged into other lines because of too
wide of a grayscale threshold range.
After the thresholds are adjusted to the desired range, select the “OK” button to confirm.
When the Vector/Auto Vectorize function is invoked, the system will show the option
Use Existing Thresholds that allows you to use the defined thresholds.
This function does not change the image; instead it keeps the threshold range for the use
of other functions, such as the Auto Vectorize command, the Line Editor commands, and
the Conversion commands.

5.22 Classification...command (Image Menu)
The Classification command is used to classify a color (8-bit and 24-bit) or multi-spectral
satellite image using a clustering algorithm. When the Classification command is selected
a Color Classification dialog box appears (See Figure).
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You can specify the Number of Colors and the
Number of Iterations to run the algorithm.
In the current version of R2V for Windows, the
maximum number of classes to be used is limited to
255 and there is no limit on the number of
iterations. More iterations will increase the
computation time but may improve the
classification quality.
To get the boundary from one class, simply draw a selection rectangle within the class
and then use the Vector/Auto Vectorize function with the Boundary Line mode selected
in the Vectorize dialog box. Use the Center Line mode in the Vectorize dialog box if the
line center will be traced.
Note: To avoid excessive fragmentation in the final region map, the number of classes
should not be specified too big.
If the image is a scanned map with color lines and you want to extract the lines, use the
Classification command to classify the image into color classes and then save it to a TIFF
file using the File/Save Image As command. You can then read the file back into R2V
and apply the Vector/Auto Vectorize command to vectorize one color layer at a time by
selecting a color feature region.
The Classification command changes the image to a single-band image. It should be
saved to an image file if it is going to be used later. The classified image is saved as an 8bit palette color image.

5.23 Colorize…command (Image Menu)
This command is used to colorize a grayscale image using color information from multispectral or color images of different scales or resolutions. This command uses a patentpending algorithm developed by Able Software to create high-resolution color images
using high resolution grayscale images and low resolution multi-spectral images.
Before using this command, each color band of the multi-spectral image should be
registered properly and cropped against the grayscale image. Each color band should be
stored in a separate file but they do not have to be exactly the same size as the grayscale
image.
After the Colorize command is started, a Colorize Image Dialog box appears to allow
you to enter the file names of the three color source images, the Red Source Image, the
Green Source Image, and the Blue Source Image (See Figure).
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The order of the
colors can be arranged
differently to create
pseudo color images.
Click the “OK” button
to start the process.
The final color image
will be displayed in
the current IMAGE
WINDOW. Use the
File/Save Image As
command to save the
image to a file.
One application of this
function is to create a
true color image from
high-resolution satellite images. For example, the Russian SPIN-2 2-meter resolution
grayscale image can be colorized with low-resolution multi-spectral satellite imagery,
such as LANDSAT TM or SPOT images.

5.24 Fusion…command (Image Menu)
This command is used to fuse 3 grayscale images together by using each image as a color
band to create a 24-bit RGB color image. Images such as multi-spectral satellite imagery,
aerial photo images, and computer generated images can be used as input to create color
image fusion.
Before using this command, each image band should be registered properly and cropped
against each other to avoid any shifting or alignment problem. Each color band must be
stored in a separate file but they do not have to be exactly the same size.
After the Fusion command is started, a Color Fusion Dialog box appears to allow you to
enter the file names of the three-color source images, Red Band Image, Green Band
Image, Blue Band Image (See Figure).
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The order of the colors can be arranged differently to create pseudo color images. Click
the “OK” button to start the fusion process. The resulting color image will be displayed
in the current IMAGE WINDOW. Use the File/Save Image As command to save the
image to a file.

5.25 Segmentation…command (Image Menu)
This command segments a grayscale image, such as a satellite image or an aerial photo,
and vectorizes the boundary lines of homogenous regions. One example of this function
is the detection and mapping of building roofs within an aerial photo.
The Segmentation command creates a region segmented image and lines for the region
boundaries. The vector lines are not yet closed polygons. If you need to create a polygon
layer from the data, it is recommended to clean up the data using the Line Editor options
and then use the Vector/Create Polygon Layer function to close the lines.
The Segmentation command works only with grayscale images. Other image types, such
as color images, must be converted to grayscale before this command can be used.
If you want to use the original image as the backdrop when editing vector lines with the
Line Editor options, you can save your line data to a GEN/ARC file (*.gen), close the
current IMAGE WINDOW, open the original image, and then import the GEN/ARC file
(*.gen) you just saved.
The Segmentation command changes the raw image data. You should save the image if
you plan to use the image and the extracted vector data together in the future.
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5.26 Conversion (Image Menu)
5.26.1 Convert 24-bit RGB → Palette (Conversion submenu)
This command is used to convert a 24-bit true color image or multi-spectral satellite
image to an 8-bit palette image. This command changes the image from a three-band
RGB color image to a single-band palette image. The color information is kept using a
color palette.

5.26.2 Convert 24-bit RGB → Gray Scale (Conversion submenu)
This command is used to convert a 24-bit true color image or multi-spectral satellite
image to an 8-bit grayscale image. This command changes the image from a three-band
RGB color image to a single-band grayscale image. The color information is lost in this
conversion.

5.26.3 Convert 8-bit Palette → 24-bit RGB (Conversion submenu)
This command converts an 8-bit palette color image to a 24-bit RGB color image. Instead
of using a color-coded palette, the new image uses RGB values for each pixel but looks
very similar to the previous image. The new image is 3 times larger than the palette
image.
Use the File/Save Image As command to save the image to a new file.

5.26.4 Convert 8-bit Palette → Gray Scale (Conversion submenu)
This command is used to convert an 8-bit palette color image to an 8-bit grayscale image.
The color information is lost in this conversion.

5.26.5 Convert 8-bit Palette → 1-bit Bi-level (Conversion submenu)
This command is used to convert an 8-bit palette color image to a 1-bit bi-level
monochrome image. A selection rectangle should be defined before using this command.
The selection rectangle is used to indicate the color to be extracted.

5.26.6 Convert Gray Scale → 24-bit RGB (Conversion submenu)
This command converts an 8-bit grayscale image to a 24-bit RGB color image. Instead of
using a coded color palette, the new image uses RGB values for each pixel but looks very
similar to the previous image. The new image is 3 times larger than the palette image.
You can use the Edit/Image Editor to put colors into the image.
Use the File/Save Image As command to save the image to a new file.
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5.26.7 Convert Gray Scale → 1-bit Bi-level (Conversion submenu)
This command is used to convert an 8-bit grayscale image to a 1-bit bi-level image. If no
threshold is selected, an optimal threshold is estimated based on the grayscale image
histogram and then applied to convert the image to 1-bit bi-level (0 and 1). If a threshold
is selected by using the Image/Set Image Threshold, you will be asked whether you want
to apply the existing threshold or let the system estimate the optimal threshold. Select the
“Yes” button if you want to use the selected threshold.
If a selection rectangle exists, you will have the option to use the area as a training area
for the conversion. The pixels within the selected region will be used to generate a
grayscale range and all values within the range will be mapped as black in the final
binary image.
This command can be applied as an enhancement tool to improve the quality of some old
documents or maps where the scanner fails to do a good job when scanning as a 1-bit bilevel image.

5.26.8 Convert 1-bit Bi-level → 8-bit Gray Scale (Conversion submenu)
This command is used to convert a 1-bit bi-level image to 8-bit gray-scale image. The
image will look similar to the original black and white image, but more image processing
functions can be applied, such as smoothing, despeckle, and connecting broken lines.
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Chapter

6
Vector Menu Commands
Vectorization of raster images, vector data post-processing, select control points for image and
vector geo-referencing, create polygon layer, text and symbol detection
The Vector menu offers the following commands:
Auto Vectorize

Batch Vectorize
Batch Script

Automatically extracts all the lines from the opened
image. It is fully automatic for bi-level and grayscale
images. For 8-bit palette color images, draw a selection
rectangle to indicate the color features to be extracted and
then choose this option.
Creates and runs a batch job to vectorize a list of raster
images.
Creates and edits a batch script to be use by the Batch
Vectorize command.

Information

Shows information of the extracted line data.

Decimal IDs
Convert IDs
Adjust Orientation

B-Spline Smooth

Toggles the use of decimal IDs on and off.
Converts line and point IDs to different values.
Adjusts vector data orientation, including flip vertically,
flip horizontally, or rotate 90 degrees.
Automatically generalizes lines and removes extra nodes
using a specified threshold and a search angle.
Smoothes lines using the B-Spline interpolation method.

Snap Lines

Automatically connects lines using a specified threshold.

Snap Ends

Automatically snaps line ends together using a userdefined tolerance.
Automatically deletes lines that are within a specified
threshold range.
Deletes lines by a specified ID range.

Smooth Lines

Delete Lines by Length
Delete Lines by ID
Delete Lines by Type

Deletes lines by line type, including open ends lines and
closed polygon lines.
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Detect Intersection
Symbols
Shrink Intersection
Symbols
Remove Intersection
Markers
Select Control Points

Detects intersection symbols for editing and processing.
Shrinks identified intersection symbols to one-node
intersections. Can be used within a selected region or the
entire image.
Detects intersection symbols for editing and processing.

Create Polygon Layer

Selects control points for vector data registration. More
than 4 control points should be provided for registration.
Vector data registration is done when data are exported to
a file. Use the right mouse button to select all of the
editing options.
Creates closed polygons from extracted lines.

Split Lines

Splits intersecting lines for creating a polygon layer.

Label Polygon with
Points
Snap Polygons

Labels closed polygons or all lines using ID values from
the point data layer.
Snaps polygons to merge common polygon boundaries.

Detect Text Blocks

Automatically detects text blocks and marks them for
editing and OCR applications.
Automatically detects text strings from text blocks using
the current set of OCR signatures. This is an OCR
function.
Automatically labels extracted lines using existing text
notes. Only numerical text notes are applied to label line
ID values.
Automatically labels points using existing text notes.
Only numerical text notes are used.

Convert to Text Notes
(OCR)
Apply Notes to Lines

Apply Notes to Points
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6.1 Auto Vectorize…command (Vector Menu)
This command performs the automatic vector extraction or vectorization algorithm to
detect all of the lines from the image and displays them for verification and editing. All
vectorized lines are stored in the “current” layer.
When the Vectorize dialog box appears, select the desired vectorization options if the
defaults need to be changed (See Figure).
The parameters in the Vectorize dialog box
are as follows:
Center Line: Extracts lines by tracing the
center of all of the line features.
Boundary Line: Extracts lines by tracing
the outer boundary of all of the line
features.
Use Existing Image Threshold: This is only
applicable for a grayscale image when a
user specified image threshold exists. The
threshold can be set using the Image/Set
Image Threshold option.
Use Selected Image Region (ROI): This option allows vectorizing a predefined region of
interest (ROI). The region has to be selected before you start the Auto Vectorize
command. To define a region of interest, use the Image/Region of Interest (ROI)
command. You can vectorize a different region by using the vectorization command
repeatedly on a different ROI.
Image Source: Select an image source type, such as a map or a CAD drawing. The
vectorization uses optimized methods to process each image type.
For black and white and most grayscale images, use the above options to get the image
vectorized. However, for some grayscale and color images, you may need to use some of
the advanced features in R2V for Windows to get the optimal vectorization result and
therefore reduce the amount of editing required. For example, you may need to adjust the
image threshold value (Image/Set Image Threshold) rather than use the system estimated
threshold, or you may only need to extract lines from a certain range of gray level values.
Note: The Vector/Auto Vectorize function will use some temporary disk space for data
swapping, so please make sure you have enough space (more than the current image file
size) on the disk drive where your current image is stored. If your image is stored on a
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removable disk or on a Read-Only drive like a CD-ROM, you should copy your image to
a hard disk drive and then vectorize the image from there.
If not enough space is available, R2V will display a message “Reload your image after
vectorization” and after vectorization your IMAGE WINDOW will be black. If you see
this message, save your vector data using the File/Export Vector option and close the
IMAGE WINDOW. Reload your image using the File/Open Image or Project command
or the file name listed under the File menu and then read in your vector data using the
File/Import Vector option.

6.1.1 Vectorizing Color Images
For a color image, image classification is suggested as a preprocessing step (See Section
5.22 Classification…command (Image Menu)). The Image/Classification command
classifies the image into classes and then applies the vectorization function.
For a classified color image, if you want to generate the boundary lines from only one
class, simply draw a selection rectangle within the class and then use the Vector/Auto
Vectorize command with the Boundary Line mode selected. You can repeat this step to
add more class boundaries to the current vector data set. Use the Center Line mode if line
centers are to be traced.
For a good quality color image, you can try to vectorize it directly by selecting a
rectangle training area before you use the Vector/Auto Vectorize command. The selected
rectangle region is used to get color information as a classifier to extract all lines similar
to the training area.
Select a rectangle by holding down the left mouse button and dragging to the right size.
When selecting the region, try to select a region that is homogeneous and representative
of the color feature you want to extract. Do some experiments on a sub-region to find a
region that works well and then apply it when working with the entire image.
Note: You need to select the Use Existing Threshold check box in the Vectorize dialog
box. The Vector/Auto Vectorize option is normally disabled when lines are generated for
the safety of existing data. To enable the function, you need to remove all the lines. Use
the Vector/Delete Lines commands or the Delete All Lines function under the Line Editor
for this purpose. If many lines are connected when they are actually separate, you can
follow the above steps with a lower image threshold.

6.1.2 Vectorizing Grayscale Images
For a grayscale image, if you need to get the center lines or boundary lines extracted from
a certain range of grayscale levels, you can treat the grayscale image the same as a color
image by selecting a rectangle in the image to indicate the training area. The image pixels
in the selected area are used to estimate the grayscale range and only image pixels within
the range are vectorized. If you see many broken lines after vectorization, you may need
to raise the threshold higher and then vectorize the image using the new threshold.
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Note: This feature does not apply to bi-level images.
See Section 5.11 Crop Region…command (Image Menu) on how to get a subregion for
processing.
Extracted lines can be edited using the Line Editor under the Edit menu and processed
using the vector post-processing functions under the Vector menu.
Lines and vector data can be saved to a vector file using the File/Export Vector
command.
If registration is needed, the Vector/Select Control Points command and the Control Point
Editor can be used to specify some control points for the mapping.

6.2 Batch Vectorize…command (Vector Menu)
This command creates and runs a batch job to vectorize a list of raster images. This
command is suitable for processing large images unattended. See Section 6.1 Auto
Vectorize…command (Vector Menu) for details on how a single image is vectorized.
When the Batch Vectorize command is selected, a Batch Vectorization dialog box
appears (See Figure).
To add one or more
image files to the Images
to be vectorized list, use
the “Add” button. When
the file Open dialog box
appears, select one file or
hold down the CONTROL
key to select multiple
files.
Only binary, grayscale,
and
color-classified
images are allowed in the
batch operation because
they normally can be
automatically processed
without requiring any
user input.
The

generated

vector
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data is saved to a vector file of the same name as the image file but with a file extension
corresponding to the selected file type. Use the ArcInfo (*.gen) file type if you intend to
edit the vector data using R2V.
If image preprocessing and vector post-processing functions need to be applied in the
batch, click the “Edit Script” button or use the Vector/Batch Script command to create
and edit a batch script.
The processing status information is saved to a Log File, “batch.log” by default.
The generated vector data is saved to a vector file of the same name as the image file but
with a *.gen file extension. You should verify the vector data using the File/Import
Vector command after the batch job is finished. The created vector file can then be saved
to a different vector file format using the File/Export Vector command.

6.3 Batch Scripts…command (Vector Menu)
This command allows you to create and edit a batch script to include high level R2V
image processing and vector processing functions for batch processing. All functions
supported by the batch script can be accessed through R2V’s main menu.
When the R2V Script Edit Dialog box appears, you can select a function from the
Functions list, which lists all functions supported (See Figure).

Click on a function to put the function into the Edit Command box, where the exact
format and parameters are typed in or modified. The syntax of the function is displayed
under the box. The format of each function must be entered exactly the same way as the
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syntax requires, otherwise R2V may be unable to recognize the command and fail to run
it during the batch processing. When the function is typed correctly in the Edit Command
box, click the “Add” button to add the function to the Function Script.
Use the “Insert” button to add a command before a selected function in the Function
Script list. Use the “Remove” button to remove a function from the Function Script.
It is highly recommended to have a typical image displayed when defining your batch
script so you can test the functions you put in. Click the “Run On Image” button to test
the functions and their sequence on the current image.
Use the “Save As” button to save the function script to a file so it can later be used with
the Batch Vectorize command.
Click the “Open” button to load a predefined script file.

6.4 Information…command (Vector Menu)
This command shows the total number of lines
and the average number of nodes per line. The
information can be used to verify the vector
data processed by the vector processing
functions, such as Smooth Lines, Snap Lines,
and Delete Lines by Length. When the
Vector/Information command is selected an
R2V for Windows dialog box appears with
the vector data description (See Figure).

6.5 Adjust Orientation...command (Vector Menu)
Use this command to adjust the vector data
orientation. When the Adjust Orientation
command is selected, an Adjust Vector Data
Orientation dialog box appears (See Figure).
Operations include Flip Vertical, Flip
Horizontal, and Rotate 90 Degree. You can
combine the operations to change the
orientation of the current vector data.
The vector data is modified by this command
so you should save your vector data.

6.6 Smooth Lines...command
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(Vector Menu)
This command does a global nodes thinning using a user specified threshold. When the
command is selected, a Smooth Lines dialog box appears (See Figure).
The Smoothing Threshold is a distance in
pixel between a node and its line. When the
distance between a node and its line is less
than the threshold, the node is removed from
the line.
If the threshold is set as 0, then only the
duplicate or redundant nodes are removed and
no further smoothing is performed.
When a selection rectangle is set in the image, you will have the option of applying this
operation to the Lines in the selected region only.
The default value for the threshold is 1. If this is the first smoothing, click the "Apply"
button to try it. Smoothed lines are displayed on the screen when the processing is done.
If more thinning is desired, enter a larger value for the Smoothing Threshold Value and
click the "Apply" button. Adding increments of 1 to the Smoothing Threshold Value can
cause significant thinning to the vector data. Be careful not to use too big of a threshold
to avoid over thinning.
When the thinning is done, click the "OK" button to confirm the smoothing operation. If
you want to recover your original data without the thinning, select the "Cancel" button.

6.7 B-Spline Smooth...command (Vector Menu)
This command does a global smoothing of lines using a B-Spline interpolation method.
When the B-Spline Smooth command is selected, a B-Spline Smoothing dialog box
appears (See Figure).
The Number of nodes to be added between existing
nodes defines how many more nodes will be added
between the existing nodes to smooth the line. The
smoothed lines will have more nodes than the
original ones.
The default value for the number of nodes to be
added is 2. If this is the first B-Spline smoothing,
click the “Apply” button to perform the smoothing. Smoothed lines are displayed on the
screen when the processing is done.
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Click the “OK” button to confirm the B-Spline Smoothing operation. If you want to
recover your original data without the smoothing, select the “Cancel” button.
The B-Spline Smooth command is often used together with the Smooth Lines function.
You can use the Smooth Lines command first to remove redundant nodes and then use
the B-Spline Smooth command to smooth the lines. The Smooth Lines command can also
be applied after the B-Spline Smooth command to reduce the number of nodes.

6.8 Snap Lines...command (Vector Menu)
This command connects lines together using a user specified gap threshold. When the
Snap Lines command is selected, a Snap Lines dialog box appears (See Figure).
The parameters in the dialog box include the
Distance threshold for snapping (pixels) and an
option Only snap lines with same ID. This connects
lines with the same ID value. The distance
threshold is a distance in pixels between any two
lines. When the distance between two lines is less
than the threshold and the IDs are the same (if that
option is selected) the two lines are joined together.
The default value for the distance threshold is 1. If
this is your first time using the Snap Lines command, click the "Apply" button to try it.
Snapped lines are displayed on the screen when the processing is done. If more snapping
is desired, enter a larger distance threshold and then click the "Apply" button again. Be
careful not to use too big of a threshold to avoid incorrect snapping operations.
When the processing is done, click the "OK" button to confirm the snapping operation. If
you want to recover your original data without any changes, select the "Cancel" button.

6.9 Snap Ends...command (Vector Menu)
This command snaps line ends that are within a user defined distance tolerance to a same
location. When the Snap Ends command is selected, a Snap Line Ends dialog box
appears for you to enter the tolerance value.
The default value for the tolerance is 1. If this is your first time using the Snap Ends
command, click the "Apply" button to try it. Snapped lines are displayed on the screen
when the processing is done. If more snapping is needed, enter a larger tolerance value
and then click the "Apply" button again. Be careful not to use too big of a value to avoid
incorrect snapping operations.
When the processing is done, click the "OK" button to confirm the snapping operation. If
you want to recover your original data without any changes, select the "Cancel" button.
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6.10 Delete Lines By Length...command (Vector Menu)
This command removes lines that are shorter
than a user specified length threshold.
When the Delete Lines By Length command is
selected, a Remove Lines dialog box appears
(See Figure).
The Threshold is the length in pixels.
When a selection rectangle is set in the image,
you will have the option of applying the
command only to the Lines in selected region.
This command removes lines that are within a user specified threshold range. The Min
and Max threshold values can be the length of an entire line or the number of nodes on a
line.
The default Threshold values are set for both the Min and Max thresholds. Make a
selection on whether the threshold values are By Length or By Number of Nodes. If this is
your first time using the Delete Lines by Length command, click the "Apply" button to
try it. Removed lines will disappear from the screen when the processing is done.
Note: For maps or drawings with dotted lines, a lot of small lines may be detected and
may need to be removed. To ensure the best result, the Snap Lines operation can be used
to merge broken lines to keep them from being removed while dotted lines will not be
snapped when the thresholds are properly selected. Then apply the Delete Lines by
Length command to remove the dotted lines automatically.
When the processing is done, click the "OK" button to confirm the operation. If you want
to recover your original data without any change, select the "Cancel" button.
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6.11 Delete Lines By ID...command (Vector Menu)
This command removes lines within the specified
ID range. When the Delete Lines by ID command
is selected, the Delete Lines in ID Range dialog
box appears (See Figure).
This command can be used to create vector layers
when lines are labeled by different ID values.
Lines can be labeled using the Line Editor under
the Edit menu.

6.12 Delete Lines By Type...command (Vector Menu)
This command removes lines using the user specified type or duplicated lines. When the
Delete Lines by Type command is selected, a Delete Lines by Type dialog box appears
(See Figure).
Currently supported line types include Closed Polygons, Open Ends Lines and
Duplicates. If a selection rectangle exists
when this command is started, an option to
apply Within Selected Rectangle Only can
be selected.
This command is often used to make vector
line layers with only closed polygons or
open ends lines. Polygons can be created
using the Vector/Create Polygon Layer
command (See Section 6.16 Create Polygon
Layer…command (Vector Menu)).

6.13 Detect Intersection Symbols…command (Vector Menu)
This command detects irregular intersection symbols, such as bubbles, circles, and
squares, that are vectorized as a pattern instead of a simple node intersection. These
intersections should be corrected to a one-node intersection before further processing can
be properly done.
To detect intersection symbols, first draw a selection rectangle as a training area around a
typical intersection symbol, and select the Detect Intersection Symbols command to start
the process. When intersection symbols are identified, they are marked by blue
rectangles. The selected rectangle or training area should be slightly bigger than the full
symbol pattern.
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You can then use the Vector/Shrink Intersection Symbols command to convert the
marked intersection symbols to one-node intersections. This command can be applied to
a selected region or the entire image.
If you want to correct the symbols one by one, you can use the Line Editor option
Intersection Symbol for the task.
If the command failed to detect most of the symbols, use the Vector/Remove Intersection
Markers command to remove the markers. Redraw a different training area and use the
Detect Intersection Symbols command to detect irregular intersections again.

6.14 Shrink Intersection Symbols…command (Vector Menu)
This command shrinks detected irregular intersection symbols to simple one-node
intersections. Irregular intersection symbols, such as circles, bubbles, and squares, are
vectorized as a group of lines in the vectorization process. These intersections should be
corrected to one-node intersections before further processing can be properly done.
The Shrink Intersection Symbols command physically changes the line data and cannot
be recovered if you have not saved your data. It is highly recommended to save your
vector data to a line file (*.gen) first and then use the Shrink Intersection Symbols
command to correct for irregular intersections.
If you want to apply this command to a specific region, hold down the left mouse button
to draw a selection rectangle for the region and select the Shrink Intersection Symbols
command to correct the symbols.
If you want to correct the symbols individually, you can use the Line Editor option
Intersection Symbol for the task.
The intersection symbols are detected using the Vector/Detect Intersection Symbols
command.
If the command failed to detect most of the symbols, use the Vector/Remove Intersection
Markers command to remove the markers. Redraw a different training area and use the
Vector/Detect Intersection Symbols command to detect irregular intersections again.
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6.15 Remove Intersection Markers command (Vector Menu)
This command removes all detected irregular
intersection symbol markers. The Remove
Intersection Markers command only removes
the intersection markers, but no other data is
affected. When the command is selected, an
R2V for Windows dialog box will appear
confirming the operation (See Figure).
The intersection symbols are detected using
the Vector/Detect Intersection Symbols command.

6.16 Select Control Points…command (Vector Menu)
This command is used to start the Control Point Editor to select control points for vector
data registration. Once the Control Point Editor is started, the cursor will change
according to the editing function used. The initial editing function is New. Use the right
mouse button to get the pop-up menu for the editing options (See Section 3.8 Control
Point Editor for specific information on the Control Point Editor functions).

6.17 Create Polygon Layer…command (Vector Menu)
This command creates closed polygons from the existing lines in the “current” layer. A
new layer is created to hold the polygon data. Existing lines in the “current” layer used
by the polygons will stay unchanged in the process.
When the Create Polygon Layer command is selected, a Create Closed Polygons dialog
box appears (See Figure). A user
specified distance threshold (Maximum
Gap Tolerance for Polygon Closing) is
used to check whether a line can be
connected as part of a polygon. The
threshold value should be selected
carefully because too large of a value
can generate fake polygons and too
small of a value may leave many
polygons not closed.
If lines are traced manually or semiautomatically using the Auto Tracing function under the Line Editor, you may want to
apply the Split Intersections option to ensure the correct closing of polygons. This
processing will take some time if you have a large data set. If you have used R2V’s
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automatic vectorization function (Vector/Auto Vectorize), then you do not need to apply
this processing step because the automatic vectorization function generates most line
intersections correctly.
The option No Overlap Outlines is checked on by default. This option will remove the
outlines that are the outermost boundaries and overlap with other polygons within. If you
need to keep these polygons, uncheck this box. Overlap Outlines can be removed later
using the Line Editor commands.
Click the “Apply” button to experiment with the parameters. The “Cancel” button will
undo the process and recover your original data set. The “OK” button will confirm the
process. The Undo option is not available once the Create Polygon Layer command is
confirmed.
Lines must be prepared and inspected carefully before this command is used to generate
polygons. For each line, only its two end points (ends) are used as potential candidates to
be connected to other lines to form a closed polygon. You may need to split a line to
create an intersection. This can be done using the Split Line option under the Line Editor
submenu or the Vector/Split Lines command.
Use the View/Fill Polygon command to toggle the polygon fill mode for display.
For some images with noise, you may find some small line segments vectorized at the
corners and intersections. They should be removed before polygons are created.
Vector/Delete Lines By Length or the Line Editor commands can be used for this
purpose.

6.18 Split Lines…command (Vector Menu)
This command automatically splits lines that intersect with other lines without
intersections. This command is often used as a preprocessing step before using the
Vector/Create Polygon Layer command or the Form Polygon command under the Line
Editor submenu.
Line segments must end at intersections when used to create closed polygons because
each line is used as a single unit of a polygon boundary. For lines that cannot be split by
the Split Lines command under the Vector menu, use the Line Editor/Split Line
command.

6.19 Label Polygons with Points...command (Vector Menu)
This command labels closed polygons or all lines with the ID values derived from the
“current” point data layer. When the Label Polygons with Points command is selected, a
Label Polygons with Points dialog box appears (See Figure).
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The default setting in the dialog box is to label the Closed Polygons Only. Select the All
Lines option if you want to label all of the lines in the line layer.
If a point is located inside a closed polygon, then
its ID value is assigned to the polygon. If no point
exists inside the polygon, then the closest point is
used to supply the ID value. For an open end line,
the closes point is used to get the ID value for
labeling.
If multiple points exist in a polygon, the first point
found in the point data layer is used for labeling.
If this happens, check the polygon ID values using
the Highlight Line option under the Line Editor.

6.20 Snap Polygons…command (Vector Menu)
When polygons are created using the Vector/Auto Vectorize command with the
Boundary Line mode highlighted, there may be a one-pixel gap between common
polygon boundaries. This is correct because the tracing algorithm used by R2V traces
within the color. But vector-based mapping or CAD systems may require the boundaries
be snapped together.
When the Snap Polygons command is selected, a Snap Distance dialog box appears (See
Figure).
This command snaps the polygons using a user
defined Snap Distance (in Pixels) threshold to
determine if two boundaries are close enough.
If the two boundaries are within the defined
snap distance, they will be snapped together.
Normally, a threshold of 1 works well for
polygons generated using the Vector/Auto
Vectorize command. A larger snap distance will result in more snapping but can also
snap lines incorrectly.

6.21 Detect Text Blocks…command (Vector Menu)
This command automatically detects text blocks where text characters are vectorized as
lines during the vectorization process. Use the mouse to draw a box around a single
character so the system can use the information in the detection process. If you have text
of different fonts and sizes, use the Detect Text Blocks command multiple times with the
selection rectangle drawn properly around the target character.
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If layers are defined, this command should only be applied to one layer at a time. Before
starting this command, use the Edit/Layer Define command to set the working layer as
“current” and turn all other layers “off”.
Text blocks are used to identify the size and location of a text character, train OCR
signatures, and further text recognition.
Text blocks that possibly belong to a word group are linked as a group. The group
information is used by the OCR or text recognition functions.
Text blocks and groups can be edited using the Text Block Editor under the Edit menu.
To remove all of the text block markers permanently, use the Edit/Delete Text Blocks
command.
The display of text blocks can be toggled on and off using the View/Overlay/Text Blocks
command.

6.22 Convert to Text Notes (OCR)…command (Vector Menu)
This command automatically identifies text from text blocks and the current set of OCR
signatures and stores the text in the form of text notes. Text blocks and OCR signatures
must exist before you can use this command. Text blocks are generated using the
Vector/Detect Text Blocks command and OCR signatures are trained using the Train
OCR command under the Text Block Editor or read into R2V from an OCR file.
If layers are defined, this command should only be applied to one layer at a time. Before
starting this command, use the Edit/Layer Define to set the working layer as “current”
and turn all other layers “off”.
If there are text symbols in different fonts and styles in the image, you should convert
them separately by using their own set of text blocks and OCR signatures. Detect the text
blocks using the proper selection area for the Vector/Detect Text Blocks command and
train the OCR signatures using these text blocks. Save the OCR signatures to a file
(File/OCR and Text/Save OCR File) as they can be used with other scanned images with
a similar type of text.
Text notes are treated as annotations and can be used to label vector lines. Text notes can
also be exported along with vector data to some vector files that support text attributes,
such as MapInfo’s MIF and DXF.
Text notes can be edited using the Text Notes Editor under the Edit menu.
The display of text notes can be toggled on and off using the View/Overlay/Text Notes
command.
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6.23 Apply Notes to Lines…command (Vector Menu)
This command automatically applies existing text notes to label line ID values. Because
vector lines can only have numerical ID values, only numerical text notes, such as
“23500”, are used in the labeling process.
R2V uses a distance rule to apply text notes to vector lines. A text note is applied to a line
when the rectangle of the text note intersects with the bounding rectangle of the line.
Line ID values can be edited using the Line Editor options and can be displayed in the
IMAGE WINDOW using the View/Overlay/Line IDs.

6.24 Apply Notes to Points…command (Vector Menu)
This command automatically applies existing text notes to label point ID values. Because
points can only have numerical IDs, only numerical text notes, such as “23500”, are used
in the labeling process.
R2V uses the closest distance to apply text notes to points. A text note is applied to a
point when the center point of the text rectangle is the closest to the point.
Text notes are created automatically using the Vector/Convert to Text Notes (OCR)
function or manually using the Edit/Text Notes Editor options.
Point ID values can be edited using the Point Editor options, and can be displayed in the
IMAGE WINDOW using the View/Overlay/Point IDs command.

6.25 Separate Text Lines…command (Vector Menu)
This command separates text lines labeled by text blocks into a new layer. You can use
the Edit/Layer Define command to turn the layer on and off for import/export and other
processing.
This command is available only when text blocks exist. Use the Detect Text Blocks
command to detect and label text lines.

6.26 Decimal IDs…command (Vector Menu)
This command turns on and off the use of decimal IDs for line and point labeling. When
this command is checked, decimal points are used for the IDs in labeling and exporting.
If the option is turned off, then only integer numbers are used in ID-labeling and vector
file exporting.
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6.27 Convert IDs…command (Vector Menu)
This command converts the IDs of lines and points to different values. It is often used to
convert between units, for example, from English unit to metric unit (feet to meters).
When this command is called, a “Convert Line and Point IDs” dialog box appears to
enter the parameters (see Figure).

The new ID values is calculated using the following formula:
NewID = OldID * Scale + Offset
For example, if the Scale is 1 and Offset is 0, then the ID is not changed. If the Scale is 2
and the Offset is 0, then the new ID will be twice the value of the original ID.

6.28 Select Lines By Width (Vector Menu)
Lines vectorized using the “Auto Vectorize” command will have a line width attribute
detected from the source image. The line width is measured in pixel unit.
This command can select lines with a range of width into a new layer or the current layer.
Line Width display can be turned on or off using the “View/Overlay/Line Width”
command.
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Chapter

7
Window Menu Commands
The Window menu offers the following commands, which enable you to arrange multiple
views of multiple documents in the application window:
New Window
Cascade

Creates a new IMAGE WINDOW that views the same
document.
Arranges windows in an overlapped fashion.

Tile

Arranges windows in non-overlapped tiles.

Arrange Icons

Arranges icons of closed windows.

Window 1, 2, ...

Goes to specified window.
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7.1 New Window…command (Window Menu)
Use this command to open a new IMAGE WINDOW with the same contents as the
active IMAGE WINDOW. You can open multiple document windows to display
different parts or views of a document at the same time. If you change the contents in
one window, all other windows containing the same document reflect those changes.
When you open a new window, it becomes the active window and is displayed on top of
all other open windows.

7.2 Cascade…command (Window Menu)
Use this command to arrange multiple opened windows in an overlapping fashion.

7.3 Tile…command (Window Menu)
Use this command to arrange multiple opened windows in a non-overlapping fashion.

7.4 Arrange Icons…command (Window Menu)
Use this command to arrange the icons for minimized windows at the bottom of the main
window. If there is an open document window at the bottom of the main window, then
some or all of the icons may not be visible because they will be underneath this document
window.

7.5 1, 2, ...command (Window Menu)
R2V for Windows displays a list of currently open document windows at the bottom of
the Window menu. A check mark appears in front of the document name of the active
IMAGE WINDOW. Choose a document from this list to make its window active.
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Chapter

8
Help Menu Commands
The Help menu offers the following commands, which provide you assistance with this
R2V for Windows:
Help Topics

Offers you an index to topics on which you can get help.

About

Displays the version number of this application.
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8.1 Help Topics…command (Help Menu)
Use this command to display the opening screen of the Help Topics: R2V Help System
window (See Figure).

From the opening screen, you can jump to step-by-step instructions for using R2V for
Windows and various types of reference information.
Once you open the Help Topics, you can click the “Contents” button whenever you want
to return to the opening screen.
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8.2 About R2V…command (Help Menu)
Use this command to display the copyright notice and version number of your copy of
R2V for Windows.

8.3 Context Help
Use the Context Help tool button to obtain help on some portion of R2V for
Windows. When you choose the Context Help button from the View Bar, the mouse
pointer will change to an arrow and question mark. Then click somewhere in the R2V
for Windows window, such as a Toolbar button. The Help topic will be shown for the
item you clicked.
Shortcut
Keys:

SHIFT+F1
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Appendix

A

Software License Agreement
Able Software Corp.
R2V for Windows
______________________________________________________________________________________________________________________________________________

Please read this license carefully before use.
You are purchasing a license to use the R2V for WindowsTM Software. The Software is
owned by and remains the property of Able Software Corp., is protected by international
copyrights, and is transferred to the original purchaser and any subsequent owner of the
Software media for their use only on the license terms set below. Opening the packaging
and/or using R2V for WindowsTM Software indicates your acceptance of these terms. If
you do not agree to all of the terms and conditions, or if after use you are dissatisfied with
your R2V for WindowsTM Software, return the software, manuals and any partial or
whole copies within thirty days of purchase to the party from whom you received it for a
refund, subject to our restocking fee.
Use of the Software
1. Able Software Corp. ("Able Software"), grants the original purchaser ("Licensee") the
limited rights to possess and use the Able Software Corp. Software and User Manual
("Software") for its intended purposes. Licensee agrees that at any one time, the Software
will be installed on a single computer only. If the software is installed on a networked
system, or on a computer connected to a file server or other system that physically allows
shared access to the Software, Licensee agrees to provide technical or procedural
methods to prevent use of the Software by more than one user.
2. One machine-readable copy of the Software may be made for BACK-UP PURPOSES
ONLY, and the copy shall display all proprietary notices, and be labeled externally to
show that the back-up copy is the property of Able Software, and that use is subject to
this License. Documentation may not be copied in whole or part.
3. Use of the Software by any department, agency or other entity of the U.S. Federal
Government is limited by the terms of the below "Rider for Governmental Entity Users".
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4. Licensee may transfer its rights under this license, PROVIDED that the party to whom
such rights are transferred agrees to the terms and conditions of this License, and written
notice is provided to Able Software. Upon such transfer, Licensee must transfer or
destroy all copies of the Software.
5. Except as expressly provided in this License, Licensee may not modify, reverse
engineer, decompile, disassemble, distribute, sub-license, sell, rent, lease, give or in any
other way transfer, by any means or in any medium, including telecommunications, the
Software . Licensee will use its best efforts and take all reasonable steps to protect the
Software from unauthorized use, copying or dissemination, and will maintain all
proprietary notices intact.
LIMITED WARRANTY. Able Software warrants the Software media to be free of
defects in workmanship for a period of ninety days from purchase. During this period
Able Software will replace at no cost any such media returned to Able Software, postage
prepaid. This service is Able Software's sole liability under this warranty.
DISCLAIMER. LICENSE FEES FOR THE SOFTWARE DO NOT INCLUDE ANY
CONSIDERATION FOR ASSUMPTION OF RISK BY ABLE SOFTWARE, AND
ABLE SOFTWARE DISCLAIMS ANY AND ALL LIABILITY FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR OPERATION
OR INABILITY TO USE THE SOFTWARE , EVEN IF ANY OF THESE PARTIES
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
FURTHERMORE, LICENSEE INDEMNIFIES AND AGREES TO HOLD ABLE
SOFTWARE HARMLESS FROM SUCH CLAIMS. THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY THE
LICENSEE. THE WARRANTIES EXPRESSED IN THIS LICENSE ARE THE ONLY
WARRANTIES MADE BY ABLE SOFTWARE AND ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO
IMPLIED WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A
PARTICULAR PURPOSE.
THIS WARRANTY GIVES YOU SPECIFIED LEGAL RIGHTS, AND YOU MAY
ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
JURISDICTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF WARRANTIES, SO THE ABOVE LIMITATIONS OR
EXCLUSIONS MAY NOT APPLY TO YOU.
Term.
This License is effective as of the time Licensee receives the Software, and shall continue
in effect until Licensee ceases all use of the Software and returns or destroys all copies
thereof, or until automatically terminated upon the failure of Licensee to comply with any
of the terms of this License.
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General. This License is the complete and exclusive statement of the parties' agreement.
Should any provision of this License be held to be invalid by any court of competent
jurisdiction, that provision will be enforced to the maximum extent permissible, and the
remainder of the License shall nonetheless remain in full force and effect. This License
shall be controlled by the laws of State of Massachusetts, and the United States of
America.
Rider For U.S. Governmental Entity Users
This is a Rider to the R2V for WindowsTM SOFTWARE LICENSE AGREEMENT,
("License"), and shall take precedence over the License where a conflict occurs.
1. The Software was: developed at private expense; no portion was developed with
government funds; is a trade secret of Able Software and its licenser for all purposes
of the Freedom of Information Act; is "commercial computer software" subject to
limited utilization as provided in any contract between the vendor and the government
entity; and in all respects is proprietary data belonging solely to Able Software and its
licenser.
2. Government personnel using the Software, are hereby on notice that use of the
Software is subject to restrictions that are the same or similar to those specified
above.
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INDEX
Adjust vector orientation, 140
Aerial Photo processing, 131
affine transformation, 32
angle, measure, 119
Angle, rotation, 119
Animate 3D display, 40
Apply Notes to Lines, 150
Arrange Icons, 152
Arrow Cursor, 17
Arrow keys for image scrolling, 55
Assign Line ID, 54
Auto Trace, 22
Auto Tracing, 53, 55, 56
Auto Vectorize, 134, 136
automatic vector extraction, 136
Average Filter, 113, 125

1
1-bit Bi-Level to 8-bit Gray-Scale
Image, 133
1-bit monochrome, 132
2
24-bit RGB ->Gray Scale, 132
24-bit RGB ->Palette, 132
24-bit true color, 132
3
3D display, 25
3D display, animate, 40
3D display, apex angle, 40
3D display, azimuth angle, 40
3D export, 43
3D grid, 41
3D grid file
open, 25
3D grid file, cell size, 41
3D grid file, create, 25, 41
3D Image draping, 42
3D model export, VRML, 43
3D settings, 40

B
backup, project file, 30
Batch Job, 134, 138
batch script, 134, 139
batch script, create, 139
batch script, use, 139
Batch Vectorize, 134, 138
bi-level, 26
bi-linear, 35
bi-linear transform, 121
Birds Eye, 98
black-white, 136
Boundary Line, 136
B-Spline smooth line, 59
B-Spline smoothing, 53
B-Spline, smooth, 141

8
8-bit Gray-Scale Image to 1-bit BiLevel, 133
8-bit palette, 132
A
About, 154, 156
Add a node, 53
Add block, 84
add new control points, 74
add new line, 53
Add new line, 55
add new points, 69, 70
Add Node, 60
Add Text Block, 84
adjust the image threshold, 136

C
C key to close, 56, 57
Cascade, 152, 153
cell size, 3D grid, 41
Center Line, 136
change image color, 108
change monochrome display color, 108
circles, 58
Classification, 128
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classified color image, 137
classify, 128
Clear ROI, 115
Close, 30
Close Line, 53, 62
Closed Polygons, 109
clustering, 128
Color
layer, 108
color combination, 131
color image, 137
color image fusion, 131
color image, 24-bit, 8-bit, 137
color lines, 129
Color separation, 132
color, layer, 50
Color, line ends, 101
Color, line nodes, 101
Color, lines, 109
Color, points, 110
colorize grayscale image, 129
Context Help, 156
Contrast, 95
Contrast Adjustment Dialog Box, 105
control point, 146
Control Point Dialog Box, 77
Control Point Editor, 48, 74
Control Point Statistics, 78
control point, check, 76
control point, check residual error, 76
control point, pick point, 76
control point, state plane, 81
control points, 32, 34, 121, 135
control points, UTM, 80
Convert 8-bit Palette to 1-bit bilevel, 132
convert IDs, 151
Convert to Text Notes, 149
coordinate system, paper space, 105
Copy, 49
Copy Line, 53, 62
Create Polygon Layer, 146
Crop image by ROI, 112, 115
Crop Region, 112, 120, 138
cross cursor, 61
Cross Cursor, 17
current layer, 50

D
Dash lines, 143
decimal IDs, 150
Default Layer, 49
Delaunay Triangulation, 35, 82, 103
delete cursor, 61, 63
delete a point, 69, 70
Delete All Lines, 53, 63
delete all points within a selected region,
69
Delete all text blocks, 88
Delete all text lines, 84
Delete control point, 75
Delete Cursor, 17
Delete Line, 53, 63
Delete Lines By ID, 144
Delete Lines By Length, 143
Delete Lines By Type, 144
Delete Node, 53, 61
delete nodes in a region, 61
Delete Text Block, 85
Delete text blocks, 86
Delete Text Lines, 83
DEM format, 41
Deskew, 120
despeckle, 125
Despeckle, 112
De-speckle, 125
Detect Intersection Symbols, 144
Detect text blocks, 148, 150
Directories, 27, 32
Dotted lines, 143
Down-sampling, 121
DPI, dots per inch, 105
draw circles, 58
Draw image pixel values, 116
draw line, image editing, 117
draw rectangles, 57, 58
Drives, 27, 32
Duplicate Nodes, 141
DXF, 3D surface, 43
E
Edge Detection, 127
Edge Propagation, 127
Edit Attribute File, 92
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Edit image pixels, 116, 117
Edit menu, 48
Edit OCR Signatures, 88
ellipses, 58
Ends, color, 101
enhance quality of old map, 133
Exit, 25, 47
exit line editor, 68
export 3d model, 43
export 3D XYZ, 43
Export Vector, 25, 35, 63, 72

Group text blocks, 85
H
hardware key, 11
Help index, 155
Help Index, 154
Help menu, 154
Highlight Line, 54, 66
Horizontal Flip, 112, 119
hot keys, 15
I

F

ID labeling, decimal, 150
IDs, change, 151
IGES, 33, 35, 66, 71
Image background removal, 126
image color
change, 108
image color bands, 131
image contrast, 95
Image Contrast, 105
image despeckle, 125
Image drape, 42
Image draping, 25
Image Draping, 40, 42
Image Edge Propagation, 113
Image Editor, 93
image fusion, 129, 131
Image Information, 112, 114
Image menu, 112
image mosaic, 123
image noise removal, 125
image palette, 95
Image Palette, 95, 107
Image panning using Arrow keys, 55
Image Pixel Tool, 93
image pixel value, 116
image processing, 21
image registration, 121, 129
Image ROI, 136
Image Rotate, 120
image rotation, measure angle, 119
Image Segmentation, 131
Image Smooth, 125, 126
Image Source, 136
Image Threshold, 113, 128, 133

File
GeoTIFF, 26
file format, png, 26
File menu, 24
File Name, 27, 31
File Open dialog box, 27
File Save As dialog box, 31
Fill area, pixel tool, 118
fill polygon, 50
Fill Polygon, 109
flip vector data, 140
Font, line IDs, 110
Font, point IDs, 111
Font, text notes, 111
Form Polygon, 67
G
Geo-Coded Coordinates, 104
Geo-coded vector, import, 34
geo-coordinate conversion, 78
Geodetic datum, 79
geo-reference, 32
geo-reference the image, 24
geo-referencing, 122
GeoTIFF, 26
GeoTIFF file, 26, 31
GeoTIFF format, 31
GeoTIFF save, 31
Gradient Magnitude, 113, 127
gray scale, 26, 132
gray-scale image, 136
grid file, 25
Grid file, 41
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Image Windows, 15
Image World File (TFW), 24, 32
Image, check angle, 119
image, merge, 124
image, reload, 28
Image, resolution, 105
Image, scan, 46
image, warp, 121
import image, 28
Import Raw Image, 28
Import Vector, 24, 28, 33
Import, geo-coded vector file, 34
Installation, 11
integer IDs, 150
interactive tracing, 22, 56
Intersection symbol markers, overlay,
95, 100
Intersection symbols
shrink, correct, 145
Intersection Symbols, detect, 144
Intersection symbols, edit, 64

layer, current, 50, 52
layer, current and locked, 67
Layer, default, 49
Layer, define, update or set status, 33
layer, lines, 67
layer, lock/unlock, 50
Layer, move data between, 33
layer, new, 49
layer, off, 51
layer, on, 50
Length, Distance, 16
License Agreement, 158
Line Color, 109
Line Color, ends, 109
Line Color, nodes, 109
Line editing functions, 48
line editing tool, 53
line editor, circles and ellipses, 58
line editor, move line, 62
line editor, rectangle, 57, 58
Line ID Display, 101, 102
Line ID, rescale, 151
Line labeling, 150
Line labeling for 3D grid, 41
Line Labeling, color, 109
line type, 50
line, move, 62
Line, split, 147
lines, smooth, 141
List Files of Type, 27
Load Control Points, 25, 39
Load layer, 51
Load Layers, 24
Load notes, 45
Load OCR Signatures, 44
Load text blocks, 44

J
Join Line, 61
Join Lines, 53
K
Keyboard, 18
L
label a point, 69
Label Contours, 54, 66
Label points, 150
Label polygons, 147
latitude/longitude, 78
latitude/longitude, UTM, 80
Layer
color, 108
text notes, 91
Layer define, 48, 49
Layer file, load, 33
Layer file, save, 33
Layer manipulate, 48, 52
layer status, 53
Layer, add, 49
layer, color, 50

M
MapGuide SDL, 92
MapGuide, SDL, 38
Measure Distance, 16
Median Filter, 112, 126
Menu Bar, 15
Merge image, fuse, 124
Merge image, paste, 124
Merge, images, 124
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Modify control point, 75
mosaic, 123
Mouse, 16
Mouse Pointer Tools, 17
move cursor, 60
move a point, 69, 70
Move control point, 75
Move Cursor, 17
move data between layers, 52
move line, 62
Move Node, 53, 60
multi-line tracing, 23
multiple line tracing, 53, 57

Overlay/Line Ends, 94, 99, 101
Overlay/Line Nodes, 94, 99, 100
Overlay/Lines, 94, 99, 100
Overlay/Text Blocks, 103
Overlay/Text Notes, 103
Overlay/Triangulation, 103
P
palette color, 26
palette color image, 132
palette image, 132
Palette to RGB, 132
Paper space coordinates, 105
Parcel map, fill color, 118
Parcel map, vectorization, 118
PBK, project backup file, 30
pick point, control point, 76
Pixel Tool, 112, 116
Pixel Tool, draw line, 117
Pixel tool, fill color, 118
PNG, image file, 26
Point ID, 147, 150
Point ID Display, 102
Point, add, 70
point, color, 110
Point, delete, 70
Point, move, 70
Point, show ID, 71
polygon edit, 67
polygon fill, hatch, 50
polygon generation, 147
Polygon, fill, 109
polygon, hatch pattern, 50
Polygon, snap, 148
Polygons, 144
polygons, create manually, 67
popup menu, 146
Popup Menu, 16
Print, 25
Print Preview, 25
Print Screen, 46
Print Setup, 25
Print Window, 46
Project, 24
project backup, *.pbk, 30
Project file, 26, 30

N
NAD1927, 81
NAD1983, 81
NAD27, State Plane, 78
NAD83, State Plane, 78
Negate, 112, 125
Network, 27, 32
New, 24, 28
New control point, 74
new layer, 49
New Window, 152, 153
node, 53
nodes thinning, 141
Nodes, color, 101
Nodes, delete in group, 61
O
OCR, 149
OCR signature file, 87
OCR signatures, 44, 86
OCR Signatures, 45, 88
OCR Training, 45
Open GEOTIFF file, 26
Open Image, 24, 26
Open project, 26
optimal threshold, 133
outlines, overlap, 147
Overlay, intersection symbols, 104
Overlay/Control Point IDs, 95, 100
Overlay/Control Points, 95, 100, 102
Overlay/Image, 99, 100
Overlay/Image ROI, 100
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Save World File, 24, 32
Scan image, 46
Scanner, scan, 46
Scanner, select, 46
Scanner, TWAIN, 46
scanning resolution, 114
SDA Format, 92
SDL Attribute, 92
SDL, MapGuide, 38
Segmentation, 113, 131
Select a rectangle, 137
Select Control Points, 135, 146
selection rectangle, 63
Selection Rectangle, 16
Set End Color, 109
Set Line Color by ID, 109
Set Line Layer, 67
Set Node Color, 109
Set Point Color, 110
Set Smoothing, 56, 57, 59
Shortcut keys, 18, 54
show point ID, 71
Shrink intersection symbols, 145
Smooth line, 58
Smooth lines, 141
Smooth Lines, 59, 140
Smooth, B-Spline, 59, 141
Smoothing, 56, 57
Snap Ends, 142
Snap Lines, 134, 142
Snap Polygons, 148
Snap to end, 55
Snap to node, 54, 55
Snap to Node, Line edit, 64
Snap To Node, Move Line, 64
Sobel filter, 113
Sobel Filter, 127
Software License Agreement, 158
Split line, 147
Split Line, 53, 61
Split line intersection, 146
State Plane, 78
State Plane, latitude/longitude
conversion, 81
Status Bar, 94, 97

R
R2V for Windows, 13
R2V tutorial, 19
r2v-l mailing list, 14
range of gray-scale levels, 137
Raster image editing, 116, 117
Raster to vecotr conversion, 134
Raster to vector conversion, 136
rectangles, add, 57, 58
reference ellipsoids, 79
Region of Interest (ROI), 114
Region of Interest, ROI, 112
register the image to a projection system,
32
registration, image, 121
reload image, 28
Remove background, 126
Remove Block, 84, 85
Remove Duplicate Nodes, 141
Remove intersection symbol markers,
146
Resample, 112, 121
residual error, control point, 76
Resize workspace, 28, 104
resolution, 114
resolution unit, 114
ROI, circle, 115
ROI, crop image, 112, 115
ROI, polygon, 115
ROI, rectangle, 115
ROI, remove, 115
Roof detection, 131
Rotate, 120
rotation, angle, 119
S
satellite image, 128
Save As dialog box, 30
Save Control Points, 25, 39
Save Image As, 24, 31
Save Layer, 51
Save Layers, 24
Save notes, 45
Save OCR signatures, 45
Save Project, 30
Save text blocks, 44
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User Interface, 15
USGS DEM, 41
UTM, 78
UTM, Latitude/longitude conversion, 79

T
TAB file, 39
Technical Support, 14
Test OCR, 87
text block, 88
Text blocks, 44, 84
Text Notes Editor, 89
Text notes, Add, 89
Text notes, delete, 90
Text notes, modify, 90
Text notes, move, 91
Text notes, rotate, 91
TFW parameters, 36
Tile, 152, 153
tool bars, 18
Toolbar, 96
tracing
multiple lines, 23, 53
tracing interactively, 56
tracing lines as a group, 57
tracing, interactive, 22
Train OCR, 86
Transpose, 112, 119
triangulation, 121
true color, 26
tutorial, 19
image processing functions, 21
TWAIN, scanner, 46

V
vector
flip and transpose, 140
Vector
orientation, 140
Vector data registration, 146
Vector Generalize, 140
Vector Information, 140
vector labeling, 150
Vector menu, 134
Vectorize a region, 136
Vertical Flip, 112, 119
View menu, 94
Virtual Reality Modeling Language, 43
VRML export, 43
W
warp, image, 121, 129
Warp, Image, 103
Window 1, 2,, 152
Window Arrange Icons, 153
Window menu, 152
Workspace, new, 28
Workspace, resize, 28
world coordinate system, 32
world file, 34
WRL, VRML format, 43

U
Undelete Lines, 84
Undelete text lines, 84
Undo, 67, 92
Undo fill color, 118
Ungroup text blocks, 86
Upgrades, 14
Up-sampling, 121
Use Existing Threshold, 136, 137
Use Layer Color, 108

X
XYZ, 43
Z
Zoom In, 94, 98
Zoom Out, 98
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